# Table of Contents

1. Introduction .......................................................................................................................... 1
  1.1. What is pure::variants? ................................................................................................. 1
  1.2. Link to PDF and Other Related Documents ............................................................ 1

2. Software and License Installation ...................................................................................... 3
  2.1. Software Requirements ............................................................................................... 3
  2.2. Software Installation
    2.2.1. How to install the software .................................................................................... 3
    2.2.2. Updating the pure::variants ................................................................................ 4
  2.3. Obtaining and Installing a License ................................................................................ 7

3. Introduction to Product Line Engineering with Feature Models ....................................... 9
  3.1. Introduction .................................................................................................................... 9
  3.2. Software Product Lines ............................................................................................... 9
  3.3. Modelling the Problem Space with Feature Models .................................................. 10
  3.4. Modelling the Solution Space ...................................................................................... 12
  3.5. Designing a variable architecture .................................................................................. 13
  3.6. Deriving product variants .............................................................................................. 15

4. Getting Started with pure::variants .................................................................................. 17
  4.1. Variant Management Perspective .............................................................................. 17
  4.2. Tooltips ......................................................................................................................... 17
  4.3. Using Feature Models .................................................................................................. 18
  4.4. Using Configuration Spaces ......................................................................................... 19
  4.5. Transforming Configuration Results ........................................................................... 20
  4.6. Viewing and Exporting Configuration Results ........................................................... 21
  4.7. Exploring Documentation and Examples ...................................................................... 22

5. Concepts ................................................................................................................................ 23
  5.1. Introduction .................................................................................................................... 23
  5.2. Common Concepts in pure::variants Models .............................................................. 23
    5.2.1. Model Constraints ................................................................................................. 24
    5.2.2. Element Restrictions ............................................................................................ 24
    5.2.3. Element Relations ............................................................................................... 24
    5.2.4. Element Attributes .............................................................................................. 24
  5.3. Feature Models ............................................................................................................. 27
    5.3.1. Feature Attributes ............................................................................................... 28
  5.4. Family Models .............................................................................................................. 28
    5.4.1. Structure of the Family Model .............................................................................. 29
    5.4.2. Sample Family Model ......................................................................................... 30
    5.4.3. Restrictions in Family Models .............................................................................. 30
    5.4.4. Relations in Family Models .................................................................................. 31
  5.5. Variant Description Models ........................................................................................... 32
  5.6. Hierarchical Variant Composition .............................................................................. 32
  5.7. Inheritance of Variant Descriptions ............................................................................. 32
    5.7.1. Inheritance Rules ................................................................................................. 33
  5.8. Variant Description Evaluation ..................................................................................... 33
    5.8.1. Evaluation Algorithm ........................................................................................... 33
  5.9. Variant Transformation ................................................................................................ 34
    5.9.1. The Transformation Process ................................................................................ 34
    5.9.2. Variant Result Models ......................................................................................... 35
  5.10. Variant Update ............................................................................................................. 36
    5.10.1. File based Update ............................................................................................... 37

6. Tasks ....................................................................................................................................... 39
  6.1. Evaluating Variant Descriptions .................................................................................. 39
    6.1.1. Configuring the Evaluation ................................................................................... 39
    6.1.2. Default Element Selection State .......................................................................... 41
    6.1.3. Automatic Selection Problem Resolving .............................................................. 41
    6.1.4. Configuring the Auto Resolver .............................................................................. 42
9.8.1. How to read this reference ................................................................. 168
9.8.2. Comments ....................................................................................... 168
9.8.3. Boolean Values ................................................................................ 169
9.8.4. Numbers ......................................................................................... 169
9.8.5. Arithmetics ...................................................................................... 169
9.8.6. Strings .............................................................................................. 169
9.8.7. Collections ...................................................................................... 170
9.8.8. Value Comparison .......................................................................... 170
9.8.9. SELF and CONTEXT ........................................................................ 171
9.8.10. Name and ID References ............................................................... 171
9.8.11. Element Existence Check ............................................................... 173
9.8.13. Relations ......................................................................................... 174
9.8.14. Logical Combinations ................................................................. 174
9.8.15. Conditionals .................................................................................. 175
9.8.16. Variable Declarations ................................................................. 175
9.8.17. Function Calls .............................................................................. 175
9.8.18. Iterators ......................................................................................... 176
9.8.19. Accumulators .............................................................................. 176
9.8.20. Function Definitions ................................................................. 176
9.8.21. Function Library ........................................................................... 176
9.8.22. User-Defined pvSCL Functions ..................................................... 186
9.9. XSLT Extension Functions ................................................................. 186
9.10. Predefined Variables ........................................................................ 191
9.11. Regular Expressions .......................................................................... 191
  9.11.1. Characters ..................................................................................... 192
  9.11.2. Character Sequences ................................................................... 193
  9.11.3. Repetition ..................................................................................... 194
  9.11.4. Alternation ................................................................................... 194
  9.11.5. Grouping .................................................................................... 194
  9.11.6. Boundaries .................................................................................. 194
  9.11.7. Back References ......................................................................... 194
9.12. Keyboard Shortcuts .......................................................................... 194
10. Appendices ......................................................................................... 197
  10.1. Software Configuration .................................................................. 197
  10.2. User Interface Advanced Concepts ............................................... 197
     10.2.1. Console View ........................................................................ 197
  10.3. Glossary ......................................................................................... 197
Index ....................................................................................................... 201
List of Figures

1.1. Overview of family-based software development with pure::variants ........................................ 1
2.1. Update Site Selection ............................................................................................................. 4
2.2. Pure::variants Plugin Selection .............................................................................................. 5
2.3. Licence Agreement ................................................................................................................. 6
2.4. License Information Page ....................................................................................................... 7
3.1. Overview of SPELE activities ................................................................................................. 10
3.2. Structure and notation of feature models (using pure::variants Directed Graph Export) .......... 11
3.3. Feature Model for meteorological Product Line ...................................................................... 11
3.4. Enhanced Feature Model for meteorological Product Line ..................................................... 12
3.5. pure::variants screen shot - solution space fragment shown at right .................................... 14
4.1. Initial layout of the Variant Management Perspective ........................................................... 17
4.2. Switching Tooltips on/off ...................................................................................................... 18
4.3. A simple Feature Model of a car .............................................................................................. 18
4.4. VDM with a problematic selection .......................................................................................... 19
4.5. Transformation configuration in Configuration Space Properties .......................................... 20
4.6. Transformation button in Eclipse toolbar ................................................................................ 21
4.7. VDM export wizard ................................................................................................................ 21
5.1. pure::variants transformation process ..................................................................................... 23
5.2. (simplified) element meta model .............................................................................................. 24
5.3. (Simplified) element attribute meta-model .............................................................................. 25
5.4. Basic structure of Feature Models ........................................................................................... 28
5.5. Basic structure of Family Models ............................................................................................. 29
5.6. Sample Family Model ............................................................................................................ 30
5.7. Model Evaluation Algorithm (Pseudo Code) ............................................................................ 33
5.8. XML Transformer ................................................................................................................... 35
5.9. General Update functionality .................................................................................................. 37
5.10. Folder Structure ..................................................................................................................... 37
6.1. VDM Editor with Outline, Result, Problems, and Attributes View ........................................ 39
6.2. Model Evaluation Preferences Page ....................................................................................... 40
6.3. Automatically Resolved Feature Selections ............................................................................ 41
6.4. Auto Resolver Preferences Page ............................................................................................. 42
6.5. Unique Names in a Variant Hierarchy ...................................................................................... 44
6.6. Example Variant Hierarchy .................................................................................................... 46
6.7. Load Selection Dialog ............................................................................................................ 47
6.8. Rename Selection Dialog ...................................................................................................... 48
6.9. Rename Dialog ....................................................................................................................... 48
6.10. Multiple Transform Button ................................................................................................... 49
6.11. Configuration Space properties: Model Selection .................................................................... 49
6.12. Configuration Space properties: Transformation input/output paths .................................... 50
6.13. Configuration Space properties: Transformation Configuration ........................................... 51
6.15. Transformation module parameters ...................................................................................... 53
6.16. The Standard Transformation Type Model ............................................................................ 54
6.17. Multiple attribute definitions for Value calculation ................................................................. 55
6.18. Sample Project using Regular Expressions ............................................................................ 56
6.19. Variant project describing the manual .................................................................................... 60
6.20. The manual for users and developers ..................................................................................... 62
6.21. Model Validation Preferences Page ....................................................................................... 65
6.22. New Check Configuration Dialog ......................................................................................... 66
6.23. Automatic Model Validation Preferences Page ....................................................................... 67
6.24. Model Validation in Progress ................................................................................................ 68
6.25. Refactoring context menu for a feature .................................................................................. 69
6.26. Model Compare Editor .......................................................................................................... 72
6.27. The Variant Search Dialog .................................................................................................... 73
6.28. Quick Overview in a Feature Model ....................................................................................... 75
7.35. Impact Calculation Result ................................................................. 137
7.36. Impact View Context Menu ......................................................... 138
7.37. The Variant Projects View ............................................................. 139
7.38. Feature Model Properties Page ................................................. 140
7.39. General Model Properties Page .................................................... 141
7.40. Variant Description Model Inheritance Page .............................. 142
9.1. Prolog Code Library Model Property .............................................. 168
9.2. pvSCL Code Library Model Property Page .................................... 186
10.1. The configuration dialog of pure::variants .................................. 197
List of Tables

5.1. Mapping between input and Variant Result Model types .................................................. 35
6.1. Configuration Space Settings .................................................................................................. 63
6.2. Refactoring Operations ........................................................................................................... 69
6.3. Table of CSS classes ............................................................................................................... 90
6.4. ............................................................................................................................................... 94
9.1. Supported Attribute Types ...................................................................................................... 145
9.2. Supported relations between elements (I) ................................................................................ 146
9.3. Supported Relations between Elements (II) ........................................................................... 147
9.4. Element variation types and its icons ...................................................................................... 147
9.5. Types of element selections .................................................................................................... 148
9.6. Predefined source element types ............................................................................................. 148
9.7. Registered XSLT Extensions .................................................................................................. 151
9.8. Predefined part types ............................................................................................................. 157
9.9. pvProlog Syntax (EBNF notation) ......................................................................................... 158
9.10. Element references ............................................................................................................... 159
9.11. Examples ............................................................................................................................... 160
9.12. Logical operators in pvProlog ............................................................................................... 160
9.13. Logical functions in pvProlog ............................................................................................... 161
9.14. Functions for value calculations, restrictions, and constraints in pvProlog ......................... 161
9.15. Additional functions available for variant evaluation .......................................................... 164
9.16. Meta-Model attributes in pvProlog ....................................................................................... 166
9.17. Extension functions providing model information .............................................................. 187
9.18. Extension functions providing transformation information ................................................. 188
9.19. Extension elements for logging and user messages .............................................................. 189
9.20. Extension functions providing file operations ....................................................................... 190
9.21. Extension functions providing string operations ............................................................... 191
9.22. Supported Variables ............................................................................................................. 191
9.23. Common Keyboard Shortcuts ............................................................................................... 195
9.24. Model Editor Keyboard Shortcuts ....................................................................................... 195
9.25. Graph Editor Keyboard Shortcuts ....................................................................................... 195
List of Examples

9.1. A sample conditional document for use with the ps:condxml transformation ........................................ 151
9.2. Example use of pv:value-of .................................................................................................................. 152
9.3. A sample conditional document for use with the ps:condtext transformation ....................................... 153
9.4. A sample conditional document for use with the ps:pvsc1xml transformation ........................................ 153
9.5. Example use of pv:eval .......................................................................................................................... 154
9.6. A sample conditional document for use with the ps:pvsc1text transformation .......................................... 155
9.7. Generated code for a ps:flagfile for flag "DEFAULT" with value "1" ...................................................... 155
9.8. Generated code for a ps:makefile for variable "CXX_OPTFLAGS" with value ".-O6" ............................. 156
9.9. Generated code for a ps:classalias for alias "io::net::PCConn" with aliased class "NoConn" ............. 156
Chapter 1. Introduction

1.1. What is pure::variants?

pure::variants provides a set of integrated tools to support each phase of the software product-line development process. pure::variants has also been designed as an open framework that integrates with other tools and types of data such as requirements management systems, object-oriented modeling tools, configuration management systems, bug tracking systems, code generators, compilers, UML or SDL descriptions, documentation, source code, etc.

Figure 1.1, “Overview of family-based software development with pure::variants” shows the four cornerstone activities of family-based software development and the models used in pure::variants as the basis for these activities.

When building the infrastructure for your Product Line, the problem domain is represented using hierarchical Feature Models. The solution domain, i.e. the concrete design and implementation of the software family, is implemented as Family Models.

The two models used for Application Engineering, i.e. the creation of product variants, are complementary to the models described above. The Variant Description Model (VDM), containing the selected feature set and associated values, represents a single problem from the problem domain. The Variant Result Model describes a single concrete solution drawn from the solution family.

Figure 1.1. Overview of family-based software development with pure::variants

pure::variants manages the knowledge captured in these models and provides tool support for co-operation between the different roles within a family-based software development process:

- The domain analyst uses a Feature Model editor to build and maintain the problem domain model containing the commonalities and variabilities in the given domain.

- The domain designer uses a Family Model editor to describe the variable family architecture and to connect it via appropriate rules to the Feature Models.

- The application analyst uses a variant description model to explore the problem domain and to express the problems to be solved in terms of selected features and additional configuration information. This information is used to derive a Variant Result Model from the Family Model(s).

- The application developer generates a member of the solution family from the Variant Result Model by using the transformation engine.

1.2. Link to PDF and Other Related Documents

The Workbench User Guide (Help->Help Contents) is a good starting point for familiarizing yourself with the Eclipse user interface.
The pure::variants XML transformation system is described in detail in the XML Transformation System Manual (see Eclipse online help for a HTML version).

Any features concerning the pure::variants Server are described in the separate documents "pure::variants Server Support Plug-In Manual" and "pure::variants Server Administration Plug-In Manual". The server is available in the products "Professional" and "Enterprise".

The pure::variants Extensibility Guide is a reference document for information about extending and customizing pure::variants, e.g. with customer-specific user interface elements or by integrating pure::variants with other tools.

This document is available in online help as well as in printable PDF format here.

pure::variants uses open source libraries. The list of used libraries is available here.
Chapter 2. Software and License Installation

2.1. Software Requirements

The following software has to be present on the user's machine in order to support the pure::variants Eclipse plug-in:

Operating System:
- Windows 2003/2008/2012 Server, Windows 7, 8, 10
- Linux Ubuntu 10.04 LTS 64bit (other on request)
- Mac OS X 10.5 and newer

Eclipse: On all platforms pure::variants can be installed into existing Eclipse installations. Officially supported Eclipse releases are Eclipse from 3.6.0 to 4.5.x. Eclipse releases older than Eclipse 3.6.0 are not compatible with this release of pure::variants. Eclipse is available from [http://www.eclipse.org/](http://www.eclipse.org/).

Java: Eclipse requires a Java Virtual Machine (JVM) to be installed. Minimum version is Java 1.6. See [http://www.java.com/](http://www.java.com/) for a suitable JVM.

2.2. Software Installation

2.2.1. How to install the software

pure::variants software is distributed and installed in several ways:

- **Stand-Alone Installation with an Installer [Windows only]** Installation via an Windows installer program. Download the appropriate Windows installer package from the internet. After unpacking the ZIP file start the Setup*.exe. The installer will create a stand-alone installation of pure::variants, which can be easily uninstalled without affecting any existing pure::variants or Eclipse installation. A Java Virtual Machine has be installed separately before using pure::variants. Installation does not require administrative privileges, just writing privileges to the intended installation folder.

  Installation into an existing Eclipse installation is not supported by the installer. The location of the download site depends on the pure::variants product variant. Visit the pure-systems web site ([http://www.pure-systems.com](http://www.pure-systems.com)) or read your registration e-mail to find out which site is relevant for the version of the software you are using. Open the page in your browser to get additional information how to install the software.

- **Installing from an Update Site** Installation via the Eclipse update mechanism is a convenient way of installing and updating pure::variants from an Internet site. See task "Updating features with the update manager" resp. "Updating and installing software" in the Eclipse Workbench User Guide for detailed information on the Eclipse update mechanism (menu Help -> Help Contents and then Workbench User Guide->Tasks).

  The location of the site depends on the pure::variants product variant. Visit the pure-systems web site ([http://www.pure-systems.com/pv](http://www.pure-systems.com/pv)) or read your registration e-mail to find out which site is relevant for the version of the software you are using. Open the page in your browser to get information how to use update sites with Eclipse 3.5.

- **Archived Update Site** pure::variants uses also the format of archived update sites, distributed as ZIP files, for offline installation into an existing Eclipse installation.

  Archived update sites are available for download from the pure::variants internet update site. The location of the site depends on the pure::variants product variant. Visit the pure-systems web site ([http://www.pure-systems.com/pv](http://www.pure-systems.com/pv)) or read your registration e-mail to find out which site is relevant for the version of the software you are using. Open the page in your browser to get additional information how to use update sites with Eclipse 3.5. pure::variants archived update site file names start with `updatesite` followed by an identification of the contents of the update site. The installation process is similar to the internet update site installation.
2.2.2. Updating the pure::variants

The quickest way to get an update for pure::variants is to run the software updater inside pure::variants:

- Start pure::variants (or the Eclipse in which pure::variants has been installed in).
- Select "Help"->"Install New Software...".
- Select "pure::variants update site" from the available Software Sites.

If location "pure::variants update site" is not present, enter your location in the edit field, or press "Add" if you have an offline update site at hand.

The location of the site depends on the pure::variants product variant. Visit the pure-systems web site (http://www.pure-systems.com/pv) or read your registration e-mail to find out which site is relevant for the version of the software you are using.

Figure 2.1. Update Site Selection

- Unfold the pure::variants update site and select all features to be updated. Select "Next".
Figure 2.2. Pure::variants Plugin Selection

- Accept license, hit "Next" and then "Finish".
In the dialog select "Install all".

Restart pure::variants when asked for.

If the direct remote update is not possible (often due to firewall/proxies preventing eclipse accessing external web sites), please go to the web site using an internet browser:

- For pure::variants Evaluation use www.pure-systems.com/pv-update
- For pure::variants Enterprise/Professional use www.pure-systems.com/pvde-update

and download the "Complete Updatesite" zip package:

- Start pure::variants (or the Eclipse in which pure::variants has been installed in).
- Select "Help"->"Software Updates"->"Find and Install...".
- Select "Search for new features to install" and "Next".
- Click on button "Archived Update Site" or "Local Update Site".
- Use "Browse" to select the downloaded zip archive.
- Press "Ok", the new pure::variants update site from zip should be selected.
- All other check boxes should be deselected to speed up the process). Press "Finish".
• Unfold all under pure::variants update site and select all features to be updated. If unsure, select all but the Connector for oAW (if visible). The Connector for oAW requires an openArchitectureWare installation which is by default not supplied. Select "Next".

• Accept license, hit "Next" and then "Finish".

• In the dialog select "Install all".

• Restart pure::variants when asked for.

2.3. Obtaining and Installing a License

A valid license is required in order to use pure::variants. If pure::variants is started and no license is present, then the user is prompted to supply a license. By selecting the Request License button a software registration form is opened in the user's default web browser. After submitting the form, a license file is generated and sent to the e-mail address specified by the user. Select the Yes button and use the file dialog to specify the license file to install. The specified license will be stored in the current workspace. If the user has different workspaces, then the license file has to be installed in each of them.

To replace an expired license start pure::variants and open menu Window->Preferences. Navigate to page Variant Management->pure::variants License (see Figure 2.4, "License Information Page"). This page shows the currently installed license and allows to install new licenses. Click on button Install License and navigate to the license file. Select it and click on button Open. Now the page shows the new license information.

Figure 2.4. License Information Page
Chapter 3. Introduction to Product Line Engineering with Feature Models

3.1. Introduction

Although the term "(Software) Product line Engineering" is becoming more widely known, there is still uncertainty among developers about how it would apply in their own development context. The purpose of this chapter is to explain the design and automated derivation of the product variants of a Software Product Line using an easy to understand, practical example.

One increasing trend in software development is the need to develop multiple, similar software products instead of just a single individual product. There are several reasons for this. Products that are being developed for the international market must be adapted for different legal or cultural environments, as well as for different languages, and so must provide adapted user interfaces. Because of cost and time constraints it is not possible for software developers to develop a new product from scratch for each new customer, and so software reuse must be increased. These types of problems typically occur in portal or embedded applications, e.g. vehicle control applications. Software Product Line Engineering (SPLE) offers a solution to these not quite new, but increasingly challenging, problems. The basis of SPLE is the explicit modelling of what is common and what differs between product variants. Feature Models are frequently used for this. SPLE also includes the design and management of a variable software architecture and its constituent (software) components.

This chapter describes how this is done in practice, using the example of a Product Line of meteorological data systems. Using this example we will show how a Product Line is designed, and how product variants can be derived automatically using pure::variants.

3.2. Software Product Lines

However, before we introduce the example, we'll take a small detour into the basics of SPLE. The main difference from "normal", one-of-a-kind software development, is a logical separation between the development of core, reusable software assets (the platform), and actual applications. During application development, platform software is selected and configured to meet the specific needs of the application.

The Product Line's commonalities and variabilities are described in the Problem Space. This reflects the desired range of applications ("product variants") in the Product Line (the "domain") and their inter-dependencies. So, when producing a product variant, the application developer uses the problem space definition to describe the desired combination of problem variabilities to implement the product variant.

An associated Solution Space describes the constituent assets of the Product Line (often referred to as the "platform") and its relation to the problem space, i.e. rules for how elements of the platform are selected when certain values in the problem space are selected as part of a product variant. The four-part division resulting from the combination of the problem space and solution space with domain and application engineering is shown in Figure 3.1, "Overview of SPLE activities". Several different options are available for modelling the information in these four quadrants. The problem space can be described e.g. with Feature Models, or with a Domain Specific Language (DSL). There are also a number of different options for modelling the solution space, for example component libraries, DSL compilers, generative programs and also configuration files.
In the rest of this chapter we will consider each of these quadrants in turn, beginning with Domain Engineering activities. We’ll first look at modelling the problem space - what is common to, and what differs between, the different product variants. Then we’ll consider one possible approach for realising product variants in the solution space using C++ as an example. Finally we’ll look at how Application Engineering is performed by using the problem and solution space models to create a product variant. In reality, this linear flow is rarely found in practice. Product Lines usually evolve continuously, even after the first product variants have been defined and delivered to customers.

Our example Product Line will contain different products for entry and display of meteorological data on a PC. An initial brainstorming session has led to a set of possible differences (variation points) between possible products: meteorological data can come from different sensors attached to the PC, fetched from appropriate Internet services or generated directly by the product for demonstration and test purposes. Data can be output directly from the application, distributed as HTML or XML through an integrated Web server or regularly written to file on a fixed disk. The measurements to make can also vary: temperature, air pressure, wind velocity and humidity could all be of interest. Finally the units of measure could also vary (degrees Celsius vs. Fahrenheit, hPa vs. mmHg, m/s vs. Beaufort).

### 3.3. Modelling the Problem Space with Feature Models

We will now convert the informal, natural-language specification of variability noted above into a formal model, in order to be able to process it. Specifically, we will use a Feature Model. Feature models are simple, hierarchical models that capture the commonality and variability of a Product Line. Each relevant characteristic of the problem space becomes a feature in the model. Features are an abstract concept for describing commonalities and variabilities. What this means precisely needs to be decided for each Product Line. A feature in this sense is a characteristic of a system relevant for some Stakeholder. Depending on the interest of the Stakeholders a feature can be for the example a requirement, a technical function or function group or a non-functional (quality) characteristic.

Feature models have a tree structure, with features forming nodes of the tree. Feature variability is represented by the arcs and groupings of features. There are four different types of feature groups: “mandatory”, “optional”, “alternative” and “or”.

When specifying which features are to be included in a variant the following rules apply: If a parent feature is contained in a variant, all its mandatory child features must be also contained (“n from n”), any number of optional features can be included (“m from n, 0 ≤ m ≤ n”), exactly one feature must be selected from a group of alternative features (“1 from n”), at least one feature must be selected from a group of or features (“m from n, m>1”).
There is no single standard for the graphical notation of feature models. We use a simplified notation created by pure::variants Direct Graph Export (see the section called “Directed Graph Export”). Alternatives and groups of or features are represented with traverses between the matching features. In this representation both colour and box connector are used independently to indicate the type of group. Our notation is shown in Figure 3.2, “Structure and notation of feature models (using pure::variants Directed Graph Export)”. Using this notation, our example feature model, with some modifications, is shown in Figure 3.3, “Feature Model for meteorological Product Line”: Each Feature Model has a root feature. Beneath this are three mandatory features – “Measurements”, “Data Source” and “Output Format”. Mandatory features will always be included in a product variant if their parent feature is included in the product variant. Mandatory features are not variable in the true sense, but serve to structure or document their parent feature in some way. Our example also has alternative features, e.g. ”External Sensors”, "Demo" and "Internet" for data sources. All product variants must contain one and only one of these alternatives.

At this stage we can already see one advantage that feature modelling has over a natural-language representation - it removes ambiguities - e.g. whether an individual variant is able to process data from more than one source. When taking measurements any combination of measurements is meaningful and at least one measurement source is necessary for a sensible weather station, to model this we use a group of Or. Usually simple optional features are used, such as the example of the freezing point alarm. Further improvements can also be made by refining the model hierarchy. So the strict choice between Web Server output formats - HTML or XML – can be made explicit.

Feature models also support transverse relationships, such as requires (ps:requires) and mutually exclusive (ps:conflicts), in order to model additional dependencies between features other than those already described. So, in the example model, a selection of the “Freeze Point” alarm feature is only meaningful in connection with the temperature measurement capability. This can be modelled by an “Freeze Point” requires "Temperature" relationship (not shown in the figure). However, such relations should be used sparingly. The more transverse relations there are, the harder it is for a human user to visualize connections in the model.

When creating a feature model it can be difficult to decide exactly how problem space variabilities are to be represented in the model. In this case it is best to discuss this further with the customer. It is usually better to base these discussions around the feature model, since such models are easier for the customer to understand than textual documents and / or UML models. Formalising customer requirements in this way offers significant advantages later in Product Line development, since many architectural and implementation decisions can be made on the basis of the variabilities captured in the feature model.

In the example, the use of the output format XML and HTML can be clarified. The model explicitly defines that the choice of output format is only relevant for Web Server, a format selection is not possible for File or Text output.
However, in the context of a discussion of the feature model it could be decided that HTML is also desirable for the on-screen (Window) representation and could also be applicable for file storage.

This results in the modified feature model shown in Figure 3.4, “Enhanced Feature Model for meteorological Product Line”.

![Figure 3.4. Enhanced Feature Model for meteorological Product Line](image)

We have added “Plaintext” to the existing features; this was implicitly assumed for output to the screen or to a file. We have modelled the mutual exclusion of XML and screen display (“Text”) using a (transverse) relationship between these features (not shown).

The previous discussion describes the basic feature model approach commonly found in the literature. However, pure::variants extends this basic approach. To complement the so-called hard relations between features (ps:requires and ps:conflicts) the weakened forms ps:recommends and ps:discourages have been added to many feature model dialects. pure::variants also supports the association of named attributes with features. This allows numeric values or enumerated values to be conveniently associated with features e.g. the wind force required to activate the storm alarm could be represented as a "Threshold" attribute of the feature "Storm Alert".

An important and difficult issue in the creation of feature models is deciding which problem space features to represent. In the example model it is not possible to make a choice from the available hardware sensor types (e.g. use of a PR1003 or a PR2005 sensor for pressure). So, when specifying a variant, the user does not have direct influence on the selection of sensor types. These are determined when modelling the solution space. If the choice of different sensor types for measuring pressure is a major criterion for the customer / users, then appropriate options would have to be included in the feature model.

This means that the features in the problem space are not a 1:1-illustration of the possibilities in the solution space, but only represent the (variable) characteristics relevant for the users of the Product Line. Feature models are a user-oriented (or marketing-oriented) representation of the problem space, not the solution space.

After creating the problem space model we can use it to perform some initial analysis. For example, we can now calculate the upper limit on the number of possible variants in our example Product Line. In this case we have 1,512 variants (the model in Figure 2 only has 612 variants). For such a small number of variants the listing of all possible variants can be meaningful. However, the number of variants is usually too high to make practical use of such an enumeration.

### 3.4. Modelling the Solution Space

In order to implement the solution space using a suitable variable architecture, we must take account of other factors beyond the variability model of the problem space. These include common characteristics of all variants of the problem space that are not modelled in the feature model, as well as other constraints that limit the solution space.

These typically include the programming languages that can be used, the development environment and the application deployment environment(s). Different factors affect the choice of mechanisms to be used for converting from variation points in the solution space. These include the available development tools, the required performance and the available (computing) resources, as well as time and money. For example, use of configuration files can reduce development time for a project, if users can administer their own configurations. In other cases, using preprocessor directives (#ifdef) for conditional compilation can be appropriate, e.g. if smaller program sizes are required.

There are many possibilities for implementation of the solution space. Very simple variant-specific model transformations can be made with model-driven software development (MDSD) tools by including information from
feature models in the Model-Transformation process, e.g. by using the pure::variants Connector for Ecore/openArchitectureWare or the pure::variants Connector for Enterprise Architect. Product Lines can also be implemented naturally using "classical" means such as procedural or object-oriented languages.

### 3.5. Designing a variable architecture

A Product Line architecture will only rarely result directly from the structure of the problem space model. The solution space which can be implemented should support the variability of the problem space, but there won't necessarily be a 1:1 correspondence of the feature models with the architecture. The mapping of variabilities can take place in various ways.

In the example Product Line we will use a simple object-oriented design concept implemented in C++. A majority of the variability is then resolved at compile-time or link-time; runtime variability is only used if it is absolutely necessary. Such solutions are frequently used in practice, particularly in embedded systems.

The choice of which tools to use for automating the configuration and/or production of a variant plays a substantial role in the design and implementation of the solution space. The range of variability, the complexity of relations between problem space features and solution constituents, the number and frequency of variant production, the size and experience of the development team and many further factors play a role. In simple cases the variant can be produced by hand, but quickly automation in the various forms like small configuration scripts, model transformers, code generators or variant management systems such as pure::variants will speed production.

For modelling and mapping of the solution space variability pure::variants and its integrated model transformation in most case is an ideal. This uses a Family Model to model the solution space, to associate solution space elements with problem space features, and to support the automatic selection of solution space elements when constructing a product variant.

Family models have a hierarchical structure, consisting of logical items of the solution architecture, e.g. components, classes and objects. These logical items can be augmented with information about “real” solution elements such as source code files, in order to enable automatic production of a solution from a valid feature model configuration (more on this later). For each family model element a rule is created to link it to the solution space. For example, the Languages implementation component is only included if the Languages feature has been selected from the problem space. To achieve this, a hasFeature('Languages') rule is attached to the "Languages" component. Any item below "Languages" in the Family model can only be included in the solution if the corresponding Languages feature is selected.

A pure::variants screen shot showing part of the solution space is shown in Figure 3.5, “pure::variants screen shot - solution space fragment shown at right”.

---

13
Figure 3.5. pure::variants screen shot - solution space fragment shown at right

In our example, an architectural variation point arises, among other possibilities, in the area of data output. Each output format can be implemented with an object of a format-specific output class. Thus in the case of English output, an object of type EnglishOutput is instantiated, and with German output, a GermanOutput object. There would also be the possibility here of instantiating an appropriate object at runtime using a Strategy pattern. However, since the feature model designates only the use of alternative output formats, the variability can be resolved at compile-time and a suitable object can be instantiated using code generation for example.

In our example solution space a lookup in a text database is used to support multiple natural languages. The choice of which database to use is made at compile-time depending on the desired language. No difference in solution architectures can be detected between two variants that differ only in the target language. Here the variation point is embedded in the data level of the implementation. In many cases managing variable solutions only at the architectural level is insufficient. As has already been mentioned above, we must also support variation points at the implementation level, i.e. in our case at the C++ source code level. This is necessary to support automated product derivation. The constituents of a solution on the implementation level, like source code files or configuration files which can be generated, can also be entered in the family model and associated with selection rules.

So the existence of the Languages component in a product variant is denoted using a #define preprocessor directive in a configuration Header file. In addition, an appropriate abstract variation point variable "Languages" must first be created of the type ps:variable in the family model. The value of this variable is determined by a Value attribute. In our case this value is always 1 if the variable is contained in the product variant. An item of type ps:flagfile can now be assigned to this abstract variable. This item also possesses attributes (file, flag), which are used during the transformation of the model into "real" code. The meaning of the attributes is determined by the transformation selected in the generation step. Here we use the standard pure::variants transformation for C / C++ programs, which produces a C-preprocessor #define- Flags in the file defined by file from these specifications.

Separating the logical variation point from the solution makes it very simple to manage changes to the solution space. For example, if the same variation point requires an entry in a Makefile, this could be achieved with the definition of a further source element, of the type ps:makefile, below the variation point "Languages".
3.6. Deriving product variants

The family model captures both the structure of the solution space with its variation points and the connection of solution and problem space. Not only is the separation of these two spaces important, but also the direction of the connection, since problem space models in most cases are much more stable than solution spaces; the linkage of the solution space to the problem space is more meaningful than the selection of solution items by rules in the problem space. This also increases the potential for reuse, since problem space models can simply be combined with other (new, better, faster) solutions. In pure::variants the linkage between models is determined by creating a configuration space with the relevant feature and family models as members.

Now we have all the information needed to create an individual product variant. The first step is to determine a valid selection of characteristics from the feature model. In the case of pure::variants, the user is guided towards a valid and complete feature selection. Once a valid selection is found, the specified feature list as well as the family model serve as input for the production of a variant model. Then, as is described above, the rules of the individual model items are checked. Only items that have their rules satisfied are included in the finished solution.

Since all these activities are done on pure::variants model level only, no "real" product has been created at this point. The last step is to execute the transformation, which interprets the models and creates an actual product variant. In pure::variants this transformation is highly configurable. In this example, source code would be copied from a file repository to a variant specific location, the configuration header file and some makefile settings would be generated. Also the generation of product variant specific UML models is a possible transformation. See following parts of the documentation for more information on the transformation process.
Chapter 4. Getting Started with pure::variants

4.1. Variant Management Perspective

The easiest way to access the variant management functionality is to use the Variant Management perspective provided by pure::variants. If not open by default, Use Window->Open Perspective->Other and choose Variant Management to open this perspective in its default layout. The Variant Management perspective should now open as shown below.

Figure 4.1. Initial layout of the Variant Management Perspective

Now select the Variant Projects view in the upper left side of the Eclipse window. Create an initial standard project using the context menu of this view and choose New->Variant Project or use the File->New->Project wizard from the main menu. The view will now show a new project with the given name.

Once the standard project has been created, three editor windows will be opened automatically: one for the Feature model, one for the Family Model and one for the VDM.

4.2. Tooltips

By default "pure::variants" shows tooltips when hovering over features, family elements or models in the project view. You can turn off the tooltips, by clicking the "Toggle pure::variants Tooltips" button in the toolbar.
4.3. Using Feature Models

When a new Variant project of project type Standard is created a new Feature Model is also created with a root feature of the same name as the project's name followed by Features. This name can be changed using the Properties dialog of the feature. To create child features, use the New entry of the context menu of the intended parent feature. A New Feature wizard allows a unique name, a visible name, and the type of the feature and other properties to be specified. All properties of a feature can be changed later using the Properties dialog.

The figure below shows a small example Feature Model for a car.

The figure below shows a small example Feature Model for a car.

The Outline view (lower left corner) shows configurable views of the selected Feature Model and allows fast navigation to features by double-clicking the displayed entry.

The Properties view in the lower middle of the Eclipse window shows properties of the currently selected feature.

The Table tab of the Feature Model Editor (shown in the lower left part) provides a table view of the model. It lists all features in a table, where editing capabilities are similar to the tree (same context menu, cell editors concept...). It allows free selection of columns and their order.
The Details tab of the Feature Model Editor provides a different view on the current feature. This view uses a layout and fields inspired by the Volere requirements specification template to record more detailed aspects of a feature.

The Graph tab provides a graphical representation of the Feature model. It also supports most of the actions available in the feature model Tree view.

The Constraints tab contains a table with all constraints defined in the model supporting full editing capabilities for the constraints.

### 4.4. Using Configuration Spaces

In order to create VDMs it is first necessary to create Configuration Spaces. These are used to combine models for configuration purposes. The New->Configuration Space menu item starts the New Configuration Space wizard. Only the names of the Configuration Space and at least one Feature Model have to be specified. The initially created Standard project Configuration Space is already configured in this way.

A VDM has to be created inside the Configuration Space for each configuration. This is done using the context menu of the Configuration Space.

The VDM Editor is used to select the desired features for the variant. This editor is also used to perform configuration validation. The Evaluate Model button on the toolbar, and the Variant->Evaluate menu item, are used to perform an immediate validation of the feature selection. The Variant->Auto Evaluate menu item enables or disables automatic validation after each selection change. The Variant->Auto Resolve menu item enables or disables automatic analysis and resolution of selection problems.

The problems view (lower right part) shows problems with the current configuration. Double clicking on a problem will open the related element(s) in the VDM Editor. When used for the first time, Variant Management problems may be filtered out. To resolve this, simply click on the filter icon and select Variant Management Problems as problem item to show. For some problems the Quick fix item in the context menu of the problem may offer options for solving the problem.

The figure below shows an example of a problem selection.

**Figure 4.4. VDM with a problematic selection**
The Outline view shows a configurable list of features from all Feature Models in the Configuration Space.

### 4.5. Transforming Configuration Results

The last step in the automatic production of configured product variants is the transformation of the configuration results into the desired artifacts.

A modular, XML-based transformation engine is used to control this process (see Section 5.9, “Variant Transformation”). The transformation process has access to all models and additional parameters such as the input and output paths that have been specified in the Configuration Space properties dialog. The transformation file could be a single XSLT file, which is in turn executed with the configuration result as input, or a complete transformation module configuration.

The transformation configuration for a Configuration Space is specified in its properties dialog. The Transformation Configuration Page (Figure 4.5, “Transformation configuration in Configuration Space Properties”) of this dialog allows the creation and modification of transformation configurations. A default configuration for the standard transformation is created when the Configuration Space is created. See Section 6.3.1, “Setting up a Transformation” for more information.

**Figure 4.5. Transformation configuration in Configuration Space Properties**

The toolbar transformation button is used to initiate a transformation (see Figure 4.6, “Transformation button in Eclipse toolbar”). If the current feature selection is invalid a dialog is opened asking the user whether to transform anyway.

**Note**

Transforming invalid configurations may yield incorrect product variants.

For more information on the XML transformation engine, see the document *pure::variants XML Transformation System Documentation*.

The distributed examples include some sample transformations.
4.6. Viewing and Exporting Configuration Results

Results of a configuration can be accessed in a number of ways. The Result view (Window->Show View->Other->Variant Management->Result) allows graphical review of the variant result models that have been derived from the corresponding models in the Configuration Space.

The context menu of the Variant Projects view provides an Export operation. As shown in the figure below, configuration results (features and components) can be exported as XML and CSV formats. The XML data format is the same as for importing models but contains only the configured elements. The Export dialog asks the user for a path and name and the export data formats for the generated files, and the model types to export.

Figure 4.7. VDM export wizard
4.7. Exploring Documentation and Examples

"pure::variants" gives an access to online help and examples of pure::variants usage. Online documentation is accessed using "Help"->"Help Contents".

Examples can be installed as projects in the user's workspace by using "File"->"New"->"Example". The available example projects are listed in the dialog below the items "Variant Management" and "Variant Management SDK". Each example project typically comes with a Readme.txt file that explains the concept and use of the example.

Additionally tutorials can be installed in the same way as the examples. The available tutorials are listed in the dialog below the items "Variant Management Tutorials". It contains the documentation itself in the pure::variants project and optional project contents.
Chapter 5. Concepts

5.1. Introduction

The pure::variants Eclipse plug-in extends the Eclipse IDE to support the development and deployment of software product lines. Using pure::variants, a software product line is developed as a set of integrated Feature Models describing the problem domain, Family Models describing the problem solution and Variant Description Models (VDMs) specifying individual products from the product line.

Feature Models describe the products of a product line in terms of the features that are common to those products and the features that vary between those products. Each feature in a Feature Model represents a property of a product that will be visible to the user of that product. These models also specify relationships between features, for example, choices between alternative features. Feature Models are described in more detail in Section 5.3, “Feature Models”.

Family Models describe how the products in the product line will be assembled or generated from pre-specified components. Each component in a Family Model represents one or more functional elements of the products in the product line, for example software (in the form of classes, objects, functions or variables) or documentation. Family models are described in more detail in Section 5.4, “Family Models”.

Variant Description Models describe the set of features of a single product in the product line. Taking a Feature Model and making choices where there is variability in the Feature Model creates these models. VDMs are described in more detail in Section 5.5, “Variant Description Models”.

In contrast to other approaches, pure::variants captures the Feature Model (problem domain) and the Family Model (problem solution) separately and independently. This separation of concerns makes it simpler to address the common problem of reusing a Feature Model or a Family Model in other projects.

Figure 5.1, “pure::variants transformation process” gives an overview of the basic process of creating variants with pure::variants.

The product line is built by creating Feature and Family Models. Once these models have been created, individual products may be built by creating VDMs. Responsibility for creation of product line models and creation of product models is usually divided between different groups of users.

5.2. Common Concepts in pure::variants Models

This section describes the common, generic structure on which all models are based.

All models store elements (features in Feature Models, components, parts and source elements in Family Models) in a hierarchical tree structure. Elements (Figure 5.2, “(simplified) element meta model”) have an associated type
and may have any number of associated attributes. An element may also have any number of associated relations. Additionally restrictions and constraints can be assigned to an element.

**Figure 5.2. (simplified) element meta model**

5.2.1. Model Constraints

Model constraints are used to check the integrity of the configuration (Variant Result Model) during a model evaluation. They can be assigned to model elements for clarity only, i.e. they have no effect on the assigned elements. All defined constraints have to be fulfilled for a resulting configuration to be valid. Detailed information about using constraints is given in Section 5.8, “Variant Description Evaluation”.

5.2.2. Element Restrictions

Element restrictions are used to decide if an element is part of the resulting configuration. During model evaluation, an element cannot become part of a resulting configuration unless one of the restrictions defined on the element evaluates to true. Restrictions can not only be defined for elements but also for element attributes, attribute values, and relations. Detailed information about using restrictions is given in Section 5.8, “Variant Description Evaluation”.

5.2.3. Element Relations

pure::variants allows arbitrary 1:n relations between model elements to be expressed. The graphical user interface provides access to the most commonly used relations. The extension interface allows additional relations to be accessed.

Examples of the currently supported relations are requires, required_for, conflicts, recommends, discourages, cond_requires, and influences. Use the Relations page in the property dialog of a feature to specify feature relations. Table 9.2, “Supported relations between elements (I)” documents the supported relations and their meanings.

5.2.4. Element Attributes

pure::variants uses attributes to specify additional information associated with an element. An attribute is a typed and named model element that can represent any kind of information (according to the values allowed by the type). An element may have any number of associated attributes. The attributes of a selected model element are evaluated and their values calculated during the model evaluation process. A simplified version of the element attribute meta-model is shown below.
Element attributes may be *fixed* (indicated with the checked \( \square \) column in the GUI) or *non-fixed*. The difference between a fixed and a non-fixed attribute is the location of the attribute value. The values of fixed attributes are stored together with the model element and are considered to be part of the model. A non-fixed element attribute value is stored in a VDM, so the value may be different in other VDMs.

A non-fixed attribute must not, but can have values that are used by default when the element is selected and no value has been specified in the VDM.

Guarding restrictions control the availability of attributes to the model evaluation process. If the restrictions associated with an attribute evaluate to *false*, the attribute is considered to be unavailable and may not be accessed during model evaluation.

A fixed attribute may have multiple value definitions assigned to it. A value definition may also have a restriction. In the evaluation process the value of the attribute is that of the first value definition that has a valid restriction (or no restriction) and successfully evaluates to *true*.

Instead of selecting one value from a list of possible values, it is also possible to provide attributes which have a configurable collection of values. Each value in the collection is available in a variant if the corresponding restriction holds true. Two types of collections are available for use: Lists and Sets. List attributes mean to maintain an order of the values and allow multiple equal entries. Set attributes instead require each value to be unique. An order is not ensured. To use this feature, either square brackets ("["] for lists or curly brackets ("{" ) for sets have to be added after the data type, e.g. *ps:string[]*, *ps:boolean[]*, or *ps:integer[]*.

### Attribute Value Types

The list of value types supported in pure::variants is defined in the pure::variants meta-model. Currently all types except *ps:integer* and *ps:float* are treated as string types internally. However, the transformation phase and some plug-ins may use the type information for an attribute value to provide special formatting etc..
The list of types provided by pure::variants is given in the reference section in Table 9.1, “Supported Attribute Types”. Users may define their own types by entering the desired type name instead of choosing one of the predefined types.

By adding square brackets ("["] or curly brackets ("{")) to the name of a value type a list or set type can be specified, e.g. ps:string[], ps:boolean[], or ps:integer[]. A list or set type can hold a list of values of the same data type. In contrast to normal types each of the given values is available in a variant if its restriction holds true or it doesn’t have a restriction.

### Attribute Values

Attribute values can be constant or calculated. Calculations are performed by providing a calculation expression instead of the constant value. The result of evaluating the calculation expression is the value of the attribute in a variant. pure::variants uses either the built-in expression language pvSCL or pvProlog to express calculations.

Attributes with type ps:integer must have decimal or hexadecimal values of the following format.

\[ ('0x' [0-9a-fA-F]+) | ([+-]? [0-9]+) \]

Attributes with type ps:float must have values of the following format.

\[ [+-]? [0-9]+ ('.' [0-9]+)? ([eE] [+-]? [0-9]+)? \]

### Attribute Value Calculations with pvSCL

When using pvSCL for value calculation, the following examples are a good starting point. For a detailed description of the pvSCL syntax, refer to Section 9.8, “Expression Language pvSCL”.

Attribute calculation in pvSCL requires the returned value to be of the defined attribute type. Thus, to assign the value 1 to an attribute of type ps:integer use the following calculation expression:

```
1
```

To assign an attribute the value of another attribute OtherAttribute of an element OtherElement, use the following expression:

```
OtherElement->OtherAttribute
```

To return the half of the product of the value of two attributes, use:

```
(OtherElement->OtherAttribute*AnotherElement->AnotherAttribute)/2
```

Only the value of attributes of type ps:float and ps:integer should be used in arithmetic expressions.

Use the following expression to return a string based on another attribute.

```
'Text ' + OtherElement->OtherAttribute + ' more Text'
```

### Attribute Value Calculations with pvProlog

When using pvProlog for value calculation, basic knowledge of the Prolog syntax and semantics are helpful. See Section 9.7, “Expression Language pvProlog” for a detailed description of the language. However, for many use cases the following examples are a good starting point.

Attribute calculation in pvProlog requires the value to be bound to a variable called Value. Thus, to assign the value 1 to an attribute use the following calculation expression:
To assign an attribute the value of another attribute `OtherAttribute` of an element `OtherElement`, use the following expression:

```plaintext
getAttribute('OtherElement','OtherAttribute',OtherAttributeValue),
Value = OtherAttributeValue
```

`getAttribute` assigns the value to `OtherAttributeValue`, which is then assigned to the result variable `Value`. This expression can be written more compact as follows.

```plaintext
getAttribute('OtherElement','OtherAttribute',Value)
```

The result of an arithmetic expressions is assigned to the result variable using the keyword "is" instead of operator "=". To return the half of the product of the value of two attributes, use the following expression:

```plaintext
getAttribute('OtherElement','OtherAttribute',OAV),
getAttribute('AnotherElement','AnotherAttribute',AAV),
Value is (OAV*AAV)/2
```

On the right side of keyword "is", arithmetic expressions can be used similar to most other programming languages. Only the value of attributes of type `ps:float` and `ps:integer` should be used in arithmetic expressions.

**Tip**

Attribute values of type `ps:boolean` are represented as string constants 'true' and 'false'. They can not be used in direct comparisons with `pvProlog false` and `true`. Please make a string comparison instead, e.g. `BooleanAttrValue = 'true'.

### 5.3. Feature Models

Feature Models are used to express commonalities and variabilities efficiently. A Feature Model captures *features* and their *relations*. A *feature* is a property of the problem domain that is *relevant* with respect to commonalities of, and variation between, problems from this domain. The term *relevant* indicates that there is a stakeholder who is interested in an explicit representation of the given feature (property). What is relevant thus depends on the stakeholders. Different stakeholders may describe the same problem domain using different features.

Feature relations can be used to define valid selections of combinations of features for a domain. The main representation of these relations is a *feature tree*. In this tree the nodes are features and the connections between features indicate whether they are *optional*, *alternative* or *mandatory*. Table 9.4, “Element variation types and its icons” gives an explanation on these terms and shows how they are represented in feature diagrams.

Additional constraints can be expressed as restrictions, element relations, and/or model constraints. Possible restrictions could allow the inclusion of a feature only if two of three other features are selected as well, or disallow the inclusion of a feature if one of a specific set of features is selected.

**Figure 5.4, “Basic structure of Feature Models”** shows the principle structure of a pure::variants Feature Model as UML class diagram. A problem domain (ProblemDomainModel) consists of any number of Feature Models (FeatureModel). A Feature Model has at least one feature.
5.3.1. Feature Attributes

Some features of a domain cannot be easily or efficiently expressed by requiring a fixed description of the feature and allowing only inclusion or exclusion of the feature. Although for many features this is perfectly suitable, Feature attributes (i.e. element attributes in Feature Models) provide a way of associating arbitrary information with a feature. This significantly increases the expressive power of Feature Models.

However, it should be noted that this expressive power could come at a price in some cases. The main drawback is that for checking feature attribute values, the simple *requires*, *conflicts*, *recommends* and *discouraged* statements are insufficient. If value checks are necessary, for example to determine whether a value within a given range conflicts with another feature, *pvProlog* or *pvSCL* level restrictions will be required.

5.4. Family Models

The Family Model describes the solution family in terms of software architectural elements. Figure 5.5, “Basic structure of Family Models” shows the basic structure of Family Models as a UML class diagram. Both models are derived from the SolutionComponentModel class. The main difference between the two models is that Family Models contain variable elements guarded by restriction expressions. Since Concrete Component Models are derived from Family Models and represent configured variants with resolved variabilities there are no restrictions used in Concrete Component Models. Please note, that older designations of Family Models are Family Component Model or even just Component Model. Following just Family Model will be used to designate those models with restrictions and thus unresolved variability.
5.4.1. Structure of the Family Model

The components of a family are organized into a hierarchy that can be of any depth. A component (with its parts and source elements) is only included in a result configuration when its parent is included and any restrictions associated with it are fulfilled. For top-level components only their restrictions are relevant.

Components:

A component is a named entity. Each component is hierarchically decomposed into further components or into part elements that in turn are built from source elements.

Parts:

Parts are named and typed entities. Each part belongs to exactly one component and consists of any number of source elements.

A part can be an element of a programming language, such as a class or an object, but it can also be any other key element of the internal or external structure of a component, for example an interface description. pure::variants provides a number of predefined part types, such as ps:class, ps:object, ps:flag, ps:classalias, and ps:variable. The Family Model is open for extension, and so new part types may be introduced, depending on the needs of the users.

Source Elements:

Since parts are logical elements, they need a corresponding physical representation or representations. Source elements realise this physical representation. A source element is an unnamed but typed element. The type of a source element is used to determine how the source code for the specified element is generated. Different types of source elements are supported, such as ps:file that simply copies a file from one place to a specified destination. Some source elements are more sophisticated, for example, ps:aliasfile, which allows different classes with different (aliases) to be used at the same place in the class hierarchy.

The actual interpretation of source elements is the responsibility of the pure::variants transformation engine. To allow the introduction of custom source elements and generator rules, pure::variants is able to host plug-ins for different transformation modules that interpret the generated Variant Result Model and produce a physical system representation from it.

The semantics of source element definitions are project, programming language, and/or transformation-specific.
5.4.2. Sample Family Model

An example Family Model is shown below:

**Figure 5.6. Sample Family Model**

This model exhibits a hierarchical component structure. System is the top-level component, Memory its only sub component. Inside this component are two parts, a class, and a flag. The class is realized by two source elements. Selecting an element of the family model will show its properties in the Properties view.

**Using Restrictions in Family Models:**

A key capability that makes the Family Modelling language more powerful than other component description languages is its support of flexible rules for the inclusion of components, parts, and source elements. This is achieved by placing restrictions on each of these elements.

Each element may have any number of restrictions. An element is included if its parent is included and either there are no restrictions on it or at least one of its restrictions evaluates to true.

For example, assigning the restriction not(hasFeature('Heap')) to the class VoidEconomist in Figure 5.6, “Sample Family Model” will cause the class and its child elements to be included when the feature Heap is not in the feature set of the variant. See Section 5.4.3, “Restrictions in Family Models” for more information.

5.4.3. Restrictions in Family Models

By default every element (component, part or source element) is included in a variant if its parent element is included, or if it has no parent element. Restrictions specify conditions under which a configuration element may be excluded from a configuration.

It is possible to put restrictions on any element, and on element properties and relations. An arbitrary number of restrictions are allowed. Restrictions are evaluated in the order in which they are listed. If a restriction rule evaluates to true, the restricted element will be included.
A restriction rule may contain arbitrary (Prolog) statements. The most useful rule is `hasFeature(<feature name/id>)` which evaluates to `true` if the feature selection contains the named feature.

### Examples of Restriction Rules

#### Including an element only if a specific feature is present

```prolog
hasFeature('Bar')
```

The element/attribute may be included only if the current feature selection contains the feature with identifier `Bar`.

#### Or-ing two restriction rules

Rule 1

```prolog
not(hasFeature('BarFoos'))
```

Rule 2

```prolog
hasFeature('FoosBar')
```

This is a logical or of two statements. The element will be included if either feature `BarFoos` is not in the feature selection or `FoosBar` is in it.

It is also possible to merge both rules into one by using the `or` keyword.

Rule 1 or Rule 2

```prolog
not(hasFeature('BarFoos')) or hasFeature('FoosBar')
```

### 5.4.4. Relations in Family Models

As for features, each element (component, part, and source element) may have relations to other elements. The supported relations are described in Section 9.2, “Element Relation Types”.

When a configuration is checked, the configuration may be regarded as invalid if any relations are not satisfied.

#### Example using `ps:exclusiveProvider`/`ps:requestsProvider` relations

In the example below, the `Cosine` class element is given an additional `ps:requestsProvider` relation to require that a cosine implementation must be present for a configuration to be valid. `ps:exclusiveProvider` relation statements are used in two different cosine implementations. Either of which could be used in some feature configurations (feature `FixedTime` and feature `Equidistant`). But it cannot be both implementations in the resulting system.

```prolog
ps:class("Cosine")
  Restriction: hasFeature('Cosine')
  Relation: ps:requestsProvider = 'Cosine'

ps:file(dir = src, file = cosine_1.cc, type = impl):
  Restriction: hasFeature('FixedTime')
  Relation: ps:exclusiveProvider = 'Cosine'

ps:file(dir = src, file = cosine_2.cc, type = impl):
  Restriction: hasFeature('FixedTime')
  Relation: ps:exclusiveProvider = 'Cosine'
  and hasFeature('Equidistant')
```

#### Example for `ps:defaultProvider`/`ps:expansionProvider` relation

In the example given above an error message would be generated if the restrictions for both elements were valid, as it would not be known which element to include. Below, this example is extended by using the `ps:defaultProvider`/`ps:expansionProvider` relations to define a priority for deciding which of the two conflicting elements should be
included. These additional relation statements are used to mark the two cosine implementations as an expansion point. The source element entry for `cosine_1.cc` specifies that this element should only be included if no more-specific element can be included (ps:defaultProvider). In this example, `cosine_2.cc` will be included when feature FixedTime and feature Equidistant are both selected, otherwise the default implementation, `cosine_1.cc` is included. If the Auto Resolver for selection problems is activated then the appropriate implementation will be included automatically, otherwise an error message will highlight the problem.

```plaintext
ps:file(dir = src, file = cosine_1.cc, type = impl):
  Restriction: hasFeature('FixedTime')
  Relation:    ps:exclusiveProvider = 'Cosine'
  Relation:    ps:defaultProvider = 'Cosine'
  Relation:    ps:expansionProvider = 'Cosine'

ps:file(dir = src, file = cosine_2.cc, type = impl):
  Restriction: hasFeature('FixedTime')
  Restriction: hasFeature('Equidistant')
  Relation:    ps:exclusiveProvider = 'Cosine'
  Relation:    ps:expansionProvider = 'Cosine'
```

### 5.5. Variant Description Models

**Variant Description Models** (VDM) describe the set of features of a single product in the product line. How to make a feature selection is described in Section 7.3.4, “Variant Description Model Editor”. The validity of a feature selection is determined by the pure::variants model validation described in Section 5.8, “Variant Description Evaluation”.

### 5.6. Hierarchical Variant Composition

See Section 6.2.1, “Hierarchical Variant Composition” for detailed information on how to create hierarchical variants.

### 5.7. Inheritance of Variant Descriptions

To share common feature selections/exclusions between several variants pure::variants supports VDM inheritance. This allows users to define the models for each VDM from which selections are to be inherited. Changes in the inherited model selection will be propagated automatically to all inheriting models. Inheritance is possible across Configuration Spaces and projects.

This kind of inheritance allows for example combination of partial configurations, restricting choices available to users only to the points where the inherited model left decisions explicitly open, or use of variant configurations in other contexts.

The list of models from which to inherit selections is defined on the properties page of the VDM (see Section 7.5.3, “Inheritance Page”). Models from the following locations can be inherited:

- from the same Configuration Space
- from another Configuration Space or folder of the same project
- from another Configuration Space or folder of a referenced project

Both single and multiple inheritance is supported. Single inheritance means that a VDM inherits directly from exactly one VDM. Multiple inheritance means directly inheriting from more than one VDM. It is not supported to directly or indirectly inherit a VDM from itself. But it is allowed to indirectly inherit a VDM more than once (diamond inheritance).

The following selections are inherited from a base VDM:

- selections explicitly made by the user
Inheritance Rules

- exclusions explicitly made by the use
- selections the base VDM has inherited from other VDMs

Additionally attribute values defined in a inherited VDM are inherited if the corresponding selection is inherited. The applicable rules for the inheritance are listed in Section 5.7.1, “Inheritance Rules”.

Inherited selections can not be changed directly. To change an inherited selection, the original selection in the inherited VDM has to be changed. Particularly if a selection is inherited that has a non-fixed attribute and no value is given in the inherited VDM, it is not possible to set a value for this attribute in the inheriting VDM. The value can only be set in the inherited VDM.

If both the inherited and the inheriting VDM are open, changes on the inherited VDM are immediately propagated to the inheriting VDM. This propagation follows the rules described in Section 5.7.1, “Inheritance Rules”.

If the list of inherited VDMs for a VDM is changed, all inheriting VDMs have to be closed before.

5.7.1. Inheritance Rules

The following rules apply to the VDM inheritance:

1. If a model element is user selected in one inherited VDM it must not be user excluded in another. Otherwise it is an error and the conflicting selection is ignored.

2. There must be no conflicting values for the same attribute in different VDMs of the inheritance hierarchy, unless the corresponding selection is not inherited. Otherwise it is an error and the conflicting attribute value is ignored.

3. An inherited VDM has to exist in the current or in any of the referenced projects. Otherwise it is an error and the not existing VDM is ignored.

4. A VDM must not inherit itself, neither direct nor indirect. Otherwise it is an error.

5.8. Variant Description Evaluation

In the context of pure::variants, Model Evaluation is the activity of verifying that a VDM complies with the Feature and Family Models it is related to. Understanding this evaluation process is the key to a successful use of restrictions and relations.

5.8.1. Evaluation Algorithm

An outline of the evaluation algorithm is given in pseudo code below Figure 5.7, “Model Evaluation Algorithm (Pseudo Code)”.

```java
modelEvaluation()
{
    foreach(current in modelRanks())
    {
        checkAndStoreFeatSelection( getFeatModelsByRank(current));
        selectAndStoreFromFamModels( getFamModelsByRank(current), class('ps:component'));
        selectAndStoreFromFamilyModels( getFamModelsByRank(current), class('ps:part'));
        selectAndStoreFromFamilyModels( getFamModelsByRank(current), class('ps:source'));
    }
    calculateAttributeValuesForResult();
    checkFeatureRestrictions(getSelectedFeatures());
    checkRelations();
    checkConstraints();
}
```

Figure 5.7. Model Evaluation Algorithm (Pseudo Code)
The algorithm has certain implications on the availability of information in restrictions, constraints, and attribute value calculations. For simplicity we will consider for now that all feature and Family Models have the same model rank.

In the first evaluation step all feature selections stored in the VDM are matched to the structure of their Feature Models. First all implicit features are calculated and merged with the feature selected by the user. For this set it is now checked that structural rules for sub feature selections are fulfilled. This means that it is checked that one alternative is selected from an alternative feature group etc. Feature restrictions are not checked. This set of selected features is now stored for later access with `hasElement`.

The next step is to select elements from the Family Models. This is done in three iterations through the model. In a first run all components are checked in a breadth-first-traversal through the family model element hierarchy. For each component the restriction is evaluated. If the restriction evaluates to true, the respective component is added to the set of selected Family Model elements. When all components are checked, all child components of the selected components are checked until no more child components are found. The set of selected components is now stored for later access with `hasElement`. In the next run all restrictions of child part elements of selected components are evaluated in the same way as for components. The last run does this for all child parts of selected source elements. This evaluation order permits part element restrictions to safely access the component configuration, since it will not change anymore. The drawback is that it is not safe to reason about the component configuration in restrictions for components (of the same or lower ranks).

**Warning**

In pure::variants calling "`hasElement`" for an element of the same class (e.g. 'ps:component') and the same model rank will always yield 'false' as result. Make sure that Family Model element restrictions are "safe". That is, they do not contain directly or indirectly references to elements for which the selection is not yet calculated (e.g. in attribute calculations or restrictions).

The above steps are repeated for all model ranks starting with the earliest model rank and increasing to the latest model rank. (Note: the lower the model rank of a model, the earlier it is evaluated in this process, e.g. a model of rank 1 is considered before a model of rank 2).

The last four steps in the model evaluation process are performed only once. First, the attribute values for all selected elements are calculated. Then the restrictions and after that the relations of the selected features are checked. At this point all information about selected features and Family Model elements is available. Finally, the model constraints are evaluated deciding if the current selection is valid or not.

### 5.9. Variant Transformation

pure::variants supports a user-specified generation of product variants using an XML-based transformation component. Input to this transformation process is an XML representation of the Variant Result Model. Transformation modules are bound to nodes of the XML document according to a user-specified module configuration. These processing modules encapsulate the actions to be performed on a matching node in the XML document.

A set of generic modules is supplied with pure::variants, e.g. a module to execute XSLT scripts and a module for collecting and executing transformation actions. The list of available transformation depends on the pure::variants product and installed extensions.

The user may create custom modules and integrate these using the pure::variants API.

The transformation module configuration is part of the Configuration Space properties (see Section 6.3.1, “Setting up a Transformation”).

### 5.9.1. The Transformation Process

The transformation process works by traversing XML document tree. Each node visited during this traversal is checked to see whether any processing modules should be executed on it. If no module has to be executed, then
the node is skipped. Otherwise the actions of each module are performed on the node. Further modules executed on the node can process not only the node itself but also the results produced by previously invoked modules.

The processing modules to be executed are defined in a module configuration file. This file lists the applicable modules and includes configuration information for each module such as the types of nodes on which a module is to be invoked. The transformation engine evaluates this configuration information before the transformation process is started.

**Figure 5.8. XML Transformer**

The transformation engine initializes the available modules before any module is invoked on a node of the XML document tree. This could, for instance, give a database module the opportunity to connect to a database. The transformation engine also informs each module when traversal of the XML document tree is finished. The database module could now disconnect.

Before a module is invoked on a node it is queried as to whether it is ready to run on the node. The module must answer this query referring only on its own internal state.

Part of the SDK is a separately distributed manual contains further information about the XML transformer. This manual shows how the built-in modules are used and how you can create and integrate your own modules.

### 5.9.2. Variant Result Models

For each Feature and Family Model of the Configuration Space a concrete variant is calculated during the model evaluation, called Variant Result Model. Restrictions and constraints are evaluated and removed from Variant Result Models. Attribute value calculations are replaced by their calculated values. Corresponding to these modifications the type of the models is changed to signal that a model is a concrete variant (see Table 5.1, “Mapping between input and Variant Result Model types”).

<table>
<thead>
<tr>
<th>Input Model Type</th>
<th>Result Model Type</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>ps:fm</code> (Feature Model)</td>
<td><code>ps:cfm</code> (Concrete Feature Model)</td>
</tr>
<tr>
<td><code>ps:ccfm</code> (Family Model)</td>
<td><code>ps:ccm</code> (Concrete Family Model)</td>
</tr>
<tr>
<td><code>ps:vdm</code> (Variant Description Model)</td>
<td><code>ps:vdm</code> (Variant Description Model, identical to the input model)</td>
</tr>
</tbody>
</table>

The Variant Result Models and additional variant information, collected in the so-called Variant Result Model, are the input of the pure::variants transformation. The Variant Result Model has the following structure.

```xml
<variant>
  <cil>
    <element idref="element id"/>
    <novalue idref="property id"/>
  </cil>
</variant>
```
The \texttt{cil} subtree of this XML structure lists the concrete elements and property values of all concrete models in the variant. The \texttt{il} subtree contains a list of all inherited element attributes in all models of the variant. Finally the VDM and all Variant Result Models are part of the \texttt{cm:consulmodels} subtree.

This XML structure is used as input for the transformation engine as described above. \texttt{pure::variants} provides a certain set of XSLT extension functions (see Table 9.17, “Extension functions providing model information”) to simplify the navigation and evaluation of this XML structure in an XSLT transformation.

**Tip**

A copy of this XML structure can be saved using the "Save Result to File" button that is shown in the tool bar of a variant description model. In an XSLT transformation, access to the unmodified input models of the transformation can be gained using the \texttt{pure::variants} XSLT extension function \texttt{models()} (see Table 9.17, “Extension functions providing model information”).

### 5.10. Variant Update

The Variant Update allows to merge custom changes made in a variant with a newly transformed version of that variant. Sometimes changes for a specific product need to be done after a variant was transformed. When the variant gets transformed again these changes need to be merged in order to keep both pieces of information. To do this, certain information have to be gathered in order to keep track of who made changes where, and what needs to be merged back into the newly generated variant assets. For that purpose, \texttt{pure::variants} stores each transformation output in an internal repository.

With this information \texttt{pure::variants} is able to update changes to the latest transformation, as well as to the current customer-specific variant, by using a three-way compare. The graphic below shows this process.
Depending on the tool, our connector either supports a file based update or a tool specific approach.

5.10.1. File based Update

If you activate the update functionality in your transformation module (see the section called “Transformation Configuration Page”), three folders will be generated into your output folder.

Working copy (work): a variant created by the transformation that may be edited by the user.

Latest: a variant created by the transformation, which reflects the latest state of the product line.

Ancestor: a variant created by the transformation, which is the common ancestor of both working copy and latest reference.

After all changes have been done and the new version of the variant is generated from the product line, you can merge these changes into your local working copy as follows: Open the context menu of the variant folder you want to update. In the refactor section of the menu, you will find Variant Update, where Merge Variant ... is located. A three-way compare opens, showing the differences between the files of the respective subfolders, where you can choose which part to keep and which to take over from the product line.
When all changes are applied and saved, you can mark the variant as merged, via *Update Variant* \(\rightarrow\) *Mark Variant as Merged*. This will set the "latest" folder as new ancestor and the project is prepared for the next version of the product line to be transformed, so the process can continue.
Chapter 6. Tasks

6.1. Evaluating Variant Descriptions

In pure::variants a variant description, i.e. the selection of features in a VDM, can be evaluated and verified using the Model Evaluation. See Section 5.8, “Variant Description Evaluation” for a detailed description of the evaluation process.

A variant description is evaluated by opening the corresponding VDM in the VDM Editor and clicking on button in the Eclipse toolbar. Detected selection problems are shown as problem markers on the right side of the editor window and in the Problems View. On the left side of the editor window only those markers are shown that point to problems in the currently visible part of the model. Clicking on these markers may open a list with fixes for the corresponding problem.

Figure 6.1. VDM Editor with Outline, Result, Problems, and Attributes View

Automatic evaluation of the variant description is enabled by pressing button in the Eclipse toolbar. This will cause an evaluation of the element selection each time it is changed.

If the variant description is valid, then the result of the evaluation are the concrete variants of the models in the Configuration Space shown in the Result View (see Section 7.4.8, “Result View”). The concrete variants of the models are collected in the Variant Result Model, that can be saved to an XML file using the button. Saved Variant Result Models can be opened with the VRM Editor. See Section 5.9.2, “Variant Result Models” for more information about Variant Result Models, and Section 7.3.5, “Variant Result Model Editor” for a detailed description of the VRM Editor.

6.1.1. Configuring the Evaluation

The model evaluation is configured on the Model Evaluation tab of the Variant Management->Model Handling preferences page (menu Window->Preferences, see Figure 6.2, “Model Evaluation Preferences Page”).
Configuring the Evaluation

Figure 6.2. Model Evaluation Preferences Page

When the "Evaluate Model" button is clicked in the VDM Editor, the current feature selection is analysed to find and optionally resolve conflicting selections, unresolved dependencies, and open alternatives. Additionally the implicitly selected and mapped features are computed. For this analysis a timeout can be set. It defaults to two minutes which should be long enough even for big configuration spaces. The timeout can be disabled by unchecking the "Timeout for checking a feature selection" check box.

Finding mapped features is an iterative process. Mapped features can cause other features to be mapped and thus included into the selection. The default maximal number of iterations is 32. Depending on the complexity of the dependencies between the mapped features it may be necessary to increase this value. In this case pure::variants will show a dialog saying that the maximal number of iterations was reached. The iterations limit can be disabled by unchecking the "Limited feature mapping iterations" check box.

If the automatic model evaluation is enabled, changing the current feature selection in the VDM Editor causes an automatic evaluation of the Configuration Space. The evaluation process is not started immediately but after a short delay. The default is 500 milliseconds. With the "Restart model evaluation after mouse move" switch it is configured whether the timer for the evaluation delay is reset if the user moves the mouse.

It is possible to define a list of element attributes that are ignored during the model evaluation.

**Note**

For listed attributes it is not possible to access them in restrictions and calculations during the model evaluation process. These attributes also do not become part of the Variant Result Model, i.e. the concrete models of the variant.

The default list of ignored attributes contains the administrative attributes ps:Source, ps:Changed, ps:ChangedBy, and ps:Created.
6.1.2. Default Element Selection State

For each element in Feature and Family Models a default selection state may be defined. An element with the default selection state “selected” is selected implicitly if the parent element is selected. To deselect this element either the parent has to be deselected or the element itself has to be excluded by the user or the auto resolver.

Normally Family Model elements and mandatory features are created with the "selected" selection state. All other Feature Model elements are created with the "undefined" selection state.

6.1.3. Automatic Selection Problem Resolving

If a feature selection is evaluated to be invalid, selection problems may be occurred. Such selection problems are for instance failed constraints or restrictions. Certain selection problems are eligible to be resolved automatically, e.g. a not yet selected feature that is required by a relation can be selected automatically. pure::variants provides two levels of auto resolving, i.e. basic and extended auto resolving.

The pure::variants basic auto resolver component provides resolving failed relations and feature selection ranges. Auto resolving of failed relations is for instance the automatic selection of required features. Auto resolving of failed feature selection ranges is for instance the automatic selection of a feature of a group of features where at least one has to be selected.

The pure::variants extended auto resolver component additionally provides resolving failed restrictions and constraints. For instance, if only a feature A is selected and there exists a constraint "A requires B" then feature B becomes automatically selected if the extended auto resolver is enabled.

Note

The auto resolver does not change the selection state of user selected or excluded features.

Auto resolving for a VDM is enabled by clicking button in the tool bar. In Figure 6.3, “Automatically Resolved Feature Selections” a selection was auto resolved. The feature ABS was automatically selected due to the Requires relation on the user selected feature ESP. The feature Electric was automatically selected because it is the default feature of the alternative feature group Electric, Electrohydraulic, Hydraulic. The icons for the different selection types are described in Section 9.4, “Element Selection Types”.

Figure 6.3. Automatically Resolved Feature Selections
6.1.4. Configuring the Auto Resolver

The auto resolving components are configured on the Auto Resolver tab of the Variant Management->Model Handling preferences page (menu Window->Preferences, see Figure 6.4, “Auto Resolver Preferences Page”).

![Auto Resolver Preferences Page](image)

Usually weak relation types like `ps:recommends` and `ps:discourages` are not considered by the auto resolver. Checking box "Auto resolve weak relations..." causes the auto resolver to handle weak relations like hard relations. In detail, `ps:recommends` is handled like `ps:requires`, i.e. select the required feature if possible. And `ps:discourages` is handled like `ps:conflicts`, i.e. exclude conflicting features if they were automatically selected by a `ps:recommends` relation.

Conflicts usually are not automatically resolved. Checking box "Auto resolve ps:conflicts relations" enables a special auto resolving for conflicts. If the conflicting feature was automatically selected due to a `ps:recommends` relation, then this feature becomes automatically excluded.

To get a clean selection before evaluating a model, i.e. a selection only containing user decisions, "Remove auto resolved features..." has to be enabled.

The extended auto resolver can be enabled for Feature and Family Models separately. Depending on the complexity of the Input Models, measured by counting the number of variation points, the extended auto resolver may exceed the memory and time limits of the model evaluation component of pure::variants. In this case the extended auto resolver aborts. To solve this problem following actions may be tried:

- Disable the extended auto resolver for Family Models. In most of the cases extended auto resolving is not interesting for Family Models.
• Review the models and try to reduce its complexity. This can be done for instance by flatten nested alternatives.

• Increase the model evaluation limits in the preferences.

• Disable the extended auto resolver.

To disable the extended auto resolver automatically if the input models exceed a certain count of elements, a model element count limit can be specified. The default is 300 elements. For models with a very low complexity this limit can be strikingly increased.

6.2. Reuse of Variant Descriptions

6.2.1. Hierarchical Variant Composition

pure::variants supports the hierarchical composition of variants as explained in Section 5.6, “Hierarchical Variant Composition”. A variant hierarchy is set up by creating links to VDMs or Configuration Spaces in a Feature Model. Three different kinds of links are available:

• Variant Reference

A variant reference is simply a link in a Feature Model to a concrete VDM of another Configuration Space. The selections in the linked VDM are locked and can not be changed in the resulting variant hierarchy.

• Variant Collection

A variant collection is a link in a Feature Model to another Configuration Space. The VDMs defined in this Configuration Space are automatically linked. The selections in the linked VDMs are locked and can not be changed in the resulting variant hierarchy.

• Variant Instance

A variant instance is a link in a Feature Model to another Configuration Space. In a VDM of a Configuration Space with this Feature Model as input, it is possible to create concrete Instances below the variant instance link, which just means to construct a new linked VDM with an empty and free editable selection for the linked Configuration Space.

While Feature Models from a linked Configuration Space are directly linked below the link elements of the parent Feature Model, the Family Models from the linked Configuration Space are linked into the first Family Model of a corresponding Configuration Space, flat below the special element LINKED_FAMILY_MODELS that is automatically created.

Note

Intentionally there is no restriction towards linking VDMs and Configuration Spaces recursively. Thus it is possible for example to link a VDM which itself links other VDMs or whole Configuration Spaces.

To create a link to a Configuration Space or VDM below an element of a Feature Model select that element, click right and select the wanted kind of link from the context menu (one of Variant Reference, Variant Collection or Variant Instance). This opens a wizard that allows to select the Configuration Space or VDM to link. In case of a variant collection link additionally the variation type of the link element has to be specified. The actual linking of VDMs and Configuration Spaces is not performed directly in the Feature and Family Models containing the links. It is performed when opening the VDMs of a corresponding Configuration Space.

If a variant instance link is created, then the VDM Editor provides two additional actions in the context menu on the corresponding link elements, i.e. New->Instance and Remove Instance. These actions allow to create and remove the concrete instances, i.e. VDMs, of the linked Configuration Space.

Relations between the variants of a variant hierarchy can be expressed using restrictions and constraints. See Section 9.8.10, “Name and ID References” and Section 9.7.1, “Element References” for details on how to reference elements from specific variants.
Unique Names and IDs in linked Variants

To distinguish multiple instances of the same variant in a variant hierarchy, all IDs and the element unique names in the models of each linked variant are changed according to the position of the variant in the hierarchy. Element unique names are prefixed with the unique name of the corresponding link element in the parent variant, separated by a colon ("":"). If the parent variant is not the top of the variant hierarchy, then the unique names of its elements also are prefixed this way. Figure 6.5, “Unique Names in a Variant Hierarchy” and shows a hierarchy of three variants and how the unique names are prefixed in each variant.

Figure 6.5. Unique Names in a Variant Hierarchy

The unique IDs are prefixed in the same way except that the unique ID of the link elements is used as prefix.
Example Variant Hierarchy

Figure 6.6, “Example Variant Hierarchy” shows how a simple house is modeled using Hierarchical Variant Composition. The VDM house is top-level and contains a Variant Instance Link named rooms. The house contains a kitchen, a kids room, a living room and a bedroom. The figure shows the kids room and the kitchen. These rooms are linked VDMs with the name room. This name is prefixed with the name of the corresponding Variant Instance Link element, i.e. Kids_Room:Rooms. This ensures uniqueness of the element unique names. Same rule is applied to the element IDs. The room VDM also contains a Variant Instance Link with name doors. It refers to the doors Configuration Space, visible on the left. For the kids room two doors are available, i.e. Back_Entry and Front_Entry. Note the exclusions in this model. For the concrete house the kitchen is excluded, and for the kids room the back door is also excluded. The exclusion causes the Model Evaluator not to propagate selections of elements that are below the excluded element. Thus the selection is valid although for example kitchen:Doors or Front_Entry:Material are explicitly selected. Warnings are shown to give the user a hint for this fact, e.g. Excluded 'kitchen' overwrites selection of kitchen:Room.
6.2.2. Inheritance of Variant Descriptions

pure::variants supports sharing common feature selections/exclusions between several variant descriptions. This allows users to define the models for each VDM from which selections are to be inherited. Changes in the inherited model selection will be propagated automatically to all inheriting models. Inheritance is possible across Configuration Spaces and projects. See Section 5.7, “Inheritance of Variant Descriptions” for details.

The VDM inheritance hierarchy can be configured on the Inheritance Page of the Model Properties. See Section 7.5.3, “Inheritance Page” for a detailed description of this page.
6.2.3. Load a Variant Description

It is possible to load the feature selection from another VDM into the currently edited VDM. Right-click in the VDM Editor window and choose **Load Selection from VDM** from the context menu. This opens the dialog shown in Figure 6.7, “Load Selection Dialog”.

**Figure 6.7. Load Selection Dialog**

In this dialog the VDM from which to load the selection has to be selected. All selections in the currently edited VDM are overwritten with the selections from the loaded VDM.

6.2.4. Rename Reused Variant Description Model

A reused Variant Description Model (“instance”) can be renamed by selecting **Rename Instance ...** from the context menu as shown in Figure 6.8, “Rename Reused Variant Description Model”.


The opened dialog lets you choose a new name for the instance at hand and also has the option to allow a name comparison. If the option is set in two instances with the same name and the same parent, these instances will be treated as equal in comparisons. If the option is left out, the instance will be treated as unique and independent, although it might be named and positioned as another instance in another Variant Description Model.

6.3. Transforming Variants

pure::variants supports user-defined generation of product variants, described by Variant Description Models, using an XML-based transformation component. See Section 5.9, “Variant Transformation” for a detailed information about the transformation process.

A VDM is transformed by opening it in the VDM Editor and clicking on button in the Eclipse toolbar. If more than one transformation is defined in a Configuration Space then this button can be used to open the list of defined
transformations and to choose one. Additionally this button allows to open the Transformation Configuration Page of the corresponding Configuration Space to add, remove, or modify transformations.

Figure 6.10. Multiple Transform Button

6.3.1. Setting up a Transformation

The transformation must initially be set up for a specific Configuration Space. Therefore the Configuration Space properties have to be opened from the Variant Projects view by choosing Properties from the context menu of the corresponding Configuration Space.

The editor is divided into three separate pages, i.e. the Model List page, the Input-Output page, and the Transformation Configuration page.

Model List Page

This page is used to specify the list of models to be used in the Configuration Space. At least one model must be selected. By default, only models that are located in a Configuration Space's project are shown.

Figure 6.11. Configuration Space properties: Model Selection

In the second column ("R") of the models list the rank of a model in this Configuration Space is specified. The model rank is a positive integer that is used to control the model evaluation order. Models are evaluated from higher to lower ranks i.e. all models with rank 1 (highest) are evaluated before any model with rank 2 or lower.

The third column enables the user to select the variation type of a pure::variant model. Two variation types are available mandatory and optional. An optional model can be deselected in a variant, mandatory models are always part of the variant.
Setting up a Transformation

The next column ("Default") can be used to specify whether an optional model is default selected in the variants or not. This semantic is either equal to the default selected state of pure::variants model elements.

Clicking right in the models list opens a context menu providing operations for changing the model selection, i.e. Select all, Deselect all, and Negate selection.

**Input-Output Page**

This page is used to specify certain input and output options to be used in model transformations. The page can be left unchanged for projects with no transformations.

**Figure 6.12. Configuration Space properties: Transformation input/output paths**

The input path is the directory where the input files for the transformation are located. The output path specifies the directory where to store the transformation results. The transformation log file is used by transformation modules to log their activities while transformation. All path definitions may use the following variables. The variables are resolved by the transformation framework before the actual transformation is started. To see which variables are available for path resolution in transformations refer to Section 9.10, "Predefined Variables"

The Clear transformation output directory check box controls whether pure::variants removes all files and directories in the Output path before a transformation is started. The Ask for confirmation before clearing check box controls whether the user is asked for confirmation before this clearing takes place. The remaining check boxes work in a similar manner and control what happens if the Output path does not exist when a transformation is started.

The Recover time stamp... option instructs the transformation framework to recover the time stamp values for output files whose contents has not been changed during the current transformation. I.e. even if the output directory is cleared before transformation, a newly generated or copied file with the same contents retains its old time stamp. Enable this option if you use tools like make which use the files time stamp to decide if a certain file changed.

The "Save the variant..." option instructs the transformation framework to save the Variant Result Model to the given location. The Variant Result Model is the input of the transformation framework containing the concrete variants of the models in the Configuration Space.

The option "Automatically save the variant result model when variant is saved" does instruct pure::variants to save the Variant Result Model each time the corresponding Variant Description Model is saved.
Setting up a Transformation

Transformation Configuration Page

This page is used to define the model transformation to be performed for the Configuration Space. The transformation configuration is stored in an XML file. If the file has been created by using the wizards in pure::variants it will be named moduleconfig.xml and will be placed inside the Configuration Space. However, there is no restriction on where to place the configuration file, it may be shared with other Configuration Spaces in the same project or in other projects, and even with Configuration Spaces in different workspaces.

Figure 6.13. Configuration Space properties: Transformation Configuration

The Transformation Configuration Page allows to define a free number of Transformation Configurations which all will be available for the Configuration Space. The lower left part of the Transformation Configuration Page allows to create, duplicate, delete and move Module Configuration entries up and down. After pressing the left most button Add a Module Configuration a new entry is added immediately whose name can be changed as desired. If a complex Module Configuration is created it might be useful to create a copy of it and edit it afterwards. Use the button right to the add button Copy selected Module Configuration for this task. Following buttons allow to delete and move a Module Configuration.

When a Transformation Configuration is selected on the left side, it can be edited with the lower right part of the Transformation Configuration Page. A Module Configuration consists of a list of configured modules. Since many modules have dependencies on other modules they must be executed in a specific order. The order of execution of the transformation modules is specified by the order in the Configured Modules list and by the kind of modules. This order in the list can be changed using the Up and Down buttons.

If the Enable Update Support button on the top of the right page is checked, the created output of transformation modules for a given variant has to support variant update scenario. In that case an already existing output for this variant may not be overwritten while transformation but can be updated afterwards with the newly created output.

If the Ignore transformation module errors button on the bottom of the right page is checked, errors reported by transformation modules do not cause the current transformation to be aborted. Use this option with caution, it may lead to invalid transformation results.

The buttons on the right side allow transformation modules to be added to or removed from the configuration, and to be edited. When adding or editing a transformation module a wizard helps to enter or change the module's configuration.
Figure 6.14. Transformation module selection dialog

In the transformation module selection dialog a name has to be entered for the chosen transformation module. The module parameters are configured in the "Module Parameters" dialog opened when clicking on button Next.
A transformation module can have mandatory and optional parameters. A module can not be added to the list of configured modules as long as there are mandatory parameters without a value. Module parameters have a name and a type. If there are values defined for a parameter, a list can be opened to choose a value from (see Figure 6.15, “Transformation module parameters”). If a default value is defined for a parameter, then this value is shown as its value if no other value was entered. Some modules accept additional parameters that can be added and removed using the Add and Remove buttons. Additional parameters are always optional and can have any name, type, and value.

For a special Module Configuration it is also possible to specify special Input and Output paths, which overwrite the settings from Configuration Space. The Input and Output paths can be edited when selecting the Input-Output tab as shown in Figure 4.5, “Transformation configuration in Configuration Space Properties”. Layout and behavior are identical to the Input-Output Page of the Configuration Space Properties Dialog with the exception that Transformation log file and the Save the variant result model to fields are not available. The use of Module Configuration specific Input and Output paths can be enabled with the check button Use configuration specific input-output settings.

Please see Section 5.9, “Variant Transformation” for more information on model transformation.

### 6.3.2. Standard Transformation

The standard transformation is suitable for many projects, such as those with mostly file-related actions for creating a product variant. This transformation also includes some special support for C/C++-related variability mechanisms like preprocessor directives and creation of other C/C++ language constructs.

The standard transformation is based on a type model describing the available element types for Family Models (see Figure 6.16, “The Standard Transformation Type Model”).
The standard transformation supports a rich set of part and source elements for file-oriented variant generation. For each source and part element type a specific transformation action is defined in the standard transformation. Source elements can be combined with any part element (and also with part types which are not from the set of standard transformation part types) unless otherwise noted. For a detailed description of the standard transformation relevant source element types see Section 9.5, “Predefined Source Element Types”.

The supported part element types are intended to capture the typical logical structure of procedural (\texttt{ps:function}, \texttt{ps:functionimpl}) and object-oriented programs (\texttt{ps:class}, \texttt{ps:object}, \texttt{ps:method}, \texttt{ps:operator}, \texttt{ps:classalias}). Some general purpose types like \texttt{ps:project}, \texttt{ps:link}, \texttt{ps:aspect}, \texttt{ps:flag}, \texttt{ps:variable}, \texttt{ps:value} or \texttt{ps:feature} are also available. For a detailed description of the standard transformation relevant part element types see Section 9.6, “Predefined Part Element Types”.

**Setting up the Standard Transformation**

The transformation configuration for the standard transformation is either set up when a Configuration Space is created using the wizard, or can be set up by hand using the following instructions:

- Open the Transformation Configuration page in the Configuration Space properties.

- Add the module \textit{Action List Generator} using the \textit{Add} button. Name it for instance \textit{Generate Standard Transformation Actionlist}.

- Add an \textit{Action List Runner} module. Name it for instance \textit{Execute Actionlist}. Usually there should be only one \textit{Action List Runner} module for an include pattern, otherwise the action list gets executed twice.

---

Figure 6.16. The Standard Transformation Type Model
Providing Values for Part Elements

Some of the part element types have a mandatory attribute `Value`. The value of this attribute is used by child source elements of the part, for example to determine the value of a C preprocessor `#define` generated by a `ps:flagfile` source element. Unless noted otherwise any part element with an attribute `Value` can be combined with any source element using an attribute `Value`. For example, it is possible to use a `ps:value` part with `ps:flagfile` and `ps:makefile` source elements to generate the same value into both a makefile (as Makefile variable) and a header file (as preprocessor `#define`).

Calculation of the value of a `ps:flag` or `ps:variable` part element is based on the value of attribute `Value`. The value may be a constant or calculation. There may be more than one attribute `Value` defined on a part with maybe more than one value guarded by restrictions. The attributes and its values are evaluated in the order in which they are listed in the Attributes page of the element's Properties dialog. The first attribute resp. attribute value with a valid restriction that evaluates to `true` or without a restriction is used.

Figure 6.17, “Multiple attribute definitions for Value calculation” shows typical `Value` attribute definitions. The value 1 is restricted and only set under certain conditions. Otherwise the unrestricted value 0 is used.

Modify Files using Regular Expressions

Text based files can be modified during the transformation using a search and replace operation based on regular expressions. For this purpose the file must be modelled by a source element with a type derived from type `ps:destfile`. The regular expression to modify the file is provided in the attribute `regex:pattern` that has to be added to the source element. This attribute can have several values, each containing a regular expression, that are applied to the file in the order they are given.
Regular Expression Syntax

The syntax of the regular expressions is `sed` based:

```
s/pattern/replacement/flags
```

Prefix `s` indicates to substitute the replacement string for strings in the file that match the pattern. Any character other than backslash or newline can be used instead of a slash to delimit the pattern and the replacement. Within the pattern and the replacement, the pattern delimiter itself can be used as a literal character if it is preceded by a backslash.

An ampersand ( `&` ) appearing in the replacement is replaced by the string matching the pattern. This can be suppressed by preceding it by a backslash. The characters `\n`, where `n` is a digit, are replaced by the text matched by the corresponding back reference expression. This can also be suppressed by preceding it by a backslash.

Both the pattern and the replacement can contain escape sequences, like `\n` (newline) and `\t` (tab).

The following flags can be specified:

- `n` Substitute for the n-th occurrence only of the pattern found within the file.
- `g` Globally substitute for all non-overlapping strings matching the pattern in the file, rather than just for the first one.

See [http://www.opengroup.org/onlinepubs/000095399/utilities/sed.html](http://www.opengroup.org/onlinepubs/000095399/utilities/sed.html) for more details about the `sed` text replacement syntax.
6.3.3. User-defined transformation scripts with JavaScript

In conjunction with the pure::variants JavaScript extension functions JavaScripts can be used to generate product variants. No special requirements are placed on the transformation you have to perform and using the extension functions is quite straightforward:

- Open the transformation configuration page in the Configuration Space properties.
- Add the JavaScript Transformation module using the Add button. Name it for instance Execute JavaScript.
- The module parameters can be changed on next page.
- Enter the path to the script file you want to execute as value of the javascriptfile parameter.
- An (optional) output file can be specified using the outputfile parameter.
- Press Finish to finish set up of the JavaScript transformation.

Example:

To demonstrate how to use JavaScripts for generating a product variant, the following example will show the generation of a text file, which contains a list of used features and some additional information about them. This example uses a user-provided JavaScript. The used JavaScript can also be found in the Javascript Transformation Example project.

Within the JavaScript the pure::variant extensibility options can be used. An API documentation is part of the pure::variants Extensibility SDK.

The example JavaScript looks like this:

```javascript
/** *
* To set up JavaScript Transformation open configuration space properties *
* and go to "Configuration Space" -> "Transformation Configuration" *
* and add a JavaScript Transformation Module with this JavaScript. *
*/

/** *
* Transformation module instance *
*/
var pv_module = module_instance();

/** *
* Do the work of this JavaScript transformation module *
* @return {ClientTransformStatus} the status of this module method *
*/
function work() {
  var status = new ClientTransformStatus();
  status.setMessage(Constants().EMPTY_STRING);
  status.setStatus(ClientTransformStatus().OK);
  try {
    var models = pv_module.getModels();
    // iterator over all models
    for (var index = 0; index < models.length; index++) {
      var model = new IPVModel(models[index]);
      // we only want to process Feature Models
      if (model.getType().equals(ModelConstants().CFM_TYPE)
          || model.getType().equals(ModelConstants().FM_TYPE)) {
        var rootid = model.getElementsRootID();
        printFeatures(model.getElementWithID(rootid));
      }
    }
  } catch (e) {
    // If something went wrong, catch error and return error status with
    // specific error message.
    status.setMessage(e.toString());
  }
}
```
User-defined transformation scripts with JavaScript

```javascript
status.setClientTransformStatus().ERROR();

// if no error occurred return OK status
return status;

/**
* Print the information of a feature to the output file
* and do to the children.
* @param {IPVElement} element The element to print
*/
function printFeatures(element) {
    // add information to output file
    out.println("Visible Name: " + element.getVName());
    out.println("Unique Name: " + element.getName());
    out.println();
    out.println("Description:");
    out.println();

    /**
    * Because the description of a feature is stored in html in this model, and
    * we don't want to see the html tags in our outputfile, we are doing some
    * formatting here.
    */
    out.print(formatDesc(element.getDesc(null, "text/html")));
    out.println("-----------------------------------------------------" + "\n");

    // get Children of current element
    var iter = element.getChildren().iterator();
    while (iter.hasNext()) {
        printFeatures(iter.next());
    }
}

function formatDesc(input) {
    input = input.replaceAll("<p>", "\n");
    input = input.replaceAll("</p>", "\n\n");
    input = input.replaceAll("&nbsp;", " ");
    input = input.replaceAll("&deg;", "\n");
    input = input.replaceAll("&amp;", "\n");
    return input;
}

function addLineBreaks(input) {
    if (input.length() < 100) {
        return input;
    }
    i = input.indexOf(" ", 99);
    if (i == -1) {
        return input;
    }
    j = input.indexOf("\n");
    if ((j != -1) && (j < i)) {
        return input.substring(0, i) + "\n" + addLineBreaks(input.substring(j + 1));
    }
    return input.substring(0, i) + "\n" + addLineBreaks(input.substring(i + 1));
}
```

The script consists of three main functions. These three functions will be called by the transformation module.

* init()

This Method is optional. Necessary work can be done here, before transformation starts, like initializing the script. Gets necessary information from transformation module, like the used variant model, the used models in this variant, some variables and the transformation parameters. All this informations can also be retrieved from the JavaScript transformation module using getter functions.
• work()

Does the whole transformation work.

• done()

This method is optional. After transformation is finished, this function is called, to provide possibility to do some work after transformation.

If the transformation parameter outputfile was used, the variable out can be used to write directly to the given file. Otherwise the variable out writes to the Java standard output. The function module_instance() provides access to the transformation module instance, which is running the JavaScript transformation. This gives access to the transformation module API.

6.3.4. User-defined transformation scripts with XSLT

A highly flexible way of generating product variants is to use XSLT in conjunction with the pure::variants XSLT extension functions. No special requirements are placed on the transformation you have to perform and using the extension functions is quite straightforward:

• Open the transformation configuration page in the Configuration Space properties.

• Add the XSLT script execution module using the Add button. Name it for instance Execute XSLT script.

• Change the module parameters page by pressing Next and enter the name of the XSLT script file you want to execute as value of the in parameter.

• An (optional) output file can be specified using the out parameter.

• Press Finish to close the transformation configuration page and start the transformation.

Example: Conditional Document Parts

To demonstrate how to use XSLT to generate a product variant, the following example will show the generation of a manual in HTML format with different content for different target groups (users, developers). This example uses the standard transformation and a user-provided XSLT script implementing a lite version of the ps:condxml source element functionality. The basic idea is to represent the manual in XML and then to use an XSLT script to generate the HTML representation. Attributes on the nodes of the XML document are used to discriminate between content for different target groups.

The example XML document looks like this:

```xml
<?xml version="1.0" encoding="UTF-8"?>
<document>
  <title condition="pv:hasFeature('developer')">Developer Manual</title>
  <title condition="pv:hasFeature('user')">User Manual</title>
  <version>
    pv:getAttributeValue('build','ps:component','version')
  </version>
  <section name="Introduction">
    Some text about the product...
  </section>
  <section name="Installation">
    Some text about installing the runtime environment...
  </section>
</document>
```
The manual has a title, a version, sections, subsections, and paragraphs. The title and the presence of some sections and subsections are conditional on the target group. The attribute `condition` has been added to the dependent parts of the document to decide which part(s) of the document are to be included. These conditions test the presence of certain features in the product variant. Figure 6.19, “Variant project describing the manual” shows the corresponding Feature and Family Models in a variant project using the standard transformation.

![Figure 6.19. Variant project describing the manual](image)

The Feature Model describes the different target groups that the manual’s content depends on. The Family Model describes how to build the HTML document, i.e. which XSLT script is to be used to transform which XML document into HTML. For this purpose the standard transformation source element `ps:transform` has been used (see Section 9.5, “Predefined Source Element Types”). This source element refers to the XSLT script `build.xsl` shown below:

```xml
<?xml version="1.0" encoding="UTF-8"?>
<xsl:stylesheet version="1.0"
    xmlns:xsl="http://www.w3.org/1999/XSL/Transform"
    xmlns:pv="http://www.pure-systems.com/purevariants"
    xmlns:cm="http://www.pure-systems.com/consul/model"
    xmlns:dyn="http://exslt.org/dynamic"
    extension-element-prefixes="pv dyn">

    <!-- generate text -->
    <xsl:output method="html"/>

    <!-- match document root node -->
    <xsl:template match="*document">
        <html>
            <title></title>
            <body>
                
                </body>
            </html>
        </xsl:template>
    </xsl:stylesheet>
```
The script takes XML as input and produces HTML as output. It has several transformation parts, one for every manual element, where the condition attributes are dynamically evaluated. Note that these condition attributes are expected to be valid XPath expressions. In the XML description of the manual these expressions contain calls to the pure::variants XSLT extension function hasFeature(), this expects the unique name of a feature as an argument and returns true if this feature is in the product variant (see Table 9.17, “Extension functions providing model information”). If a node of the XML document has such a condition and this condition fails, the node and all of its child nodes are ignored and are not transformed into HTML. For example, if a <section> node has the condition hasFeature('user') and the feature user is not selected in the product variant, then this section and all its subsections will be ignored.

In the XML description of the manual a second pure::variants XSLT extension function is called, getAttributeValue(). This function is used to get the manual version from the Family Model. It reads the value of the version attribute of the component build and returns it as string.

Figure 6.20, “The manual for users and developers” shows the two variants of the manual (HTML) generated selecting target group user and then developer.
6.3.5. Transformation of Hierarchical Variants

When a transformation of a hierarchical variant is performed then a single transformation is performed for each variant in the hierarchy. Only those transformations of linked variants are executed that have the name "Default" or the name of the top-level variant transformation (if not "Default").

The order of the transformations is top-down, i.e. first the top-level variant is transformed, then the variants below the top-level variant, and so on. Each single transformation is performed on the whole Variant Result Model, stating two lists of model elements, i.e. the transformation Entry-Points list and the transformation Exit-Points list. These lists describe the section of the Variant Result Model that represents the variant to transform. Some transformation modules may not support these lists and always work on the whole Variant Result Model.

There is a special variable `$VARPATH$` that should be used in a transformation of hierarchical variants to specify the transformation output directory. This variable contains the name of the currently transformed variant (VDM) prefixed by the names of its parent variants (VDMs) according to the variant hierarchy. The variant names are separated by a slash "/". Using this variable makes it possible to build a directory hierarchy corresponding to the variant hierarchy. This may also avoid that the results of the transformation of one variant are overwritten by the results of the transformation of another variant. See Section 9.10, “Predefined Variables” for more information on the use and availability of variables.

Transformations of linked variants have to handle the prefixed unique names and IDs in the models of the variant (see the section called “Unique Names and IDs in linked Variants”). Especially XSLT and Conditional Text resp. Conditional XML transformations have to reference elements with their full, i.e. prefixed, name. If for instance the condition in a file transformed with Conditional Text is "pv:hasFeature('Foo')" then this condition always will
fail if evaluated in the context of a linked variant. The correct condition would be "pv:hasFeature('Link1:Foo')", if linked below the link element with unique name "Link1".

### 6.3.6. Reusing existing Transformation

The transformation module **Reuse Transformation** provides the possibility to reuse already existing transformation configurations. These existing configurations can be run with the first vdm, the last vdm or with each vdm of a configspace or vdm selection.

The **Reuse Transformation** module has two mandatory parameters.

The first parameter *Triggered by* defines for which vdm of the current transformation the reused transformation configuration is triggered. The three allowed values *First VDM*, *Each VDM* and *Last VDM* are provided in a combo box. *Each VDM* is the default.

The second parameter *Transformation* defines the name of the transformation configuration, which will be triggered by this module.

The configuration space settings are inherited as follows:

<table>
<thead>
<tr>
<th>Input Directory</th>
<th>Used from the <strong>Reuse Transformation</strong> configuration, if defined. From Configuration Space otherwise.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output Directory</td>
<td>Used from the <strong>Reuse Transformation</strong> configuration, if defined. From Configuration Space otherwise.</td>
</tr>
<tr>
<td>Create Output Directory</td>
<td>Used from the <strong>Reuse Transformation</strong> configuration, if defined. From Configuration Space otherwise.</td>
</tr>
<tr>
<td>Cleanup Output Directory</td>
<td>Used from the <strong>Reuse Transformation</strong> configuration, if defined. From Configuration Space otherwise.</td>
</tr>
<tr>
<td>Create Output Directory</td>
<td>Used from the <strong>Reuse Transformation</strong> configuration, if defined. From Configuration Space otherwise.</td>
</tr>
<tr>
<td>Confirm Create Output Directory</td>
<td>Used from the <strong>Reuse Transformation</strong> configuration, if defined. From Configuration Space otherwise.</td>
</tr>
<tr>
<td>Confirm Cleanup Output Directory</td>
<td>Used from the <strong>Reuse Transformation</strong> configuration, if defined. From Configuration Space otherwise.</td>
</tr>
<tr>
<td>Recover Timestamps</td>
<td>Used from the <strong>Reuse Transformation</strong> configuration, if defined. From Configuration Space otherwise.</td>
</tr>
<tr>
<td>Force Transformation</td>
<td>Always true, because decision was made by user before running <strong>Reuse Transformation</strong> already.</td>
</tr>
<tr>
<td>Save Variant Result Model</td>
<td>Always false, because cannot be defined in transformation configurations. It is configuration space settings only.</td>
</tr>
<tr>
<td>Ignore Transformation Errors</td>
<td>Used from the <strong>Reuse Transformation</strong> configuration.</td>
</tr>
</tbody>
</table>

### 6.3.7. Ant Build Transformation Module

The transformation module **Ant Build Module** provides the possibility to call an Ant build during the transformation. The module has two parameter.

The first parameter *Build File* defines the location of the Ant build file.

The second parameter *Target* defines the target for the build. If no target is given the default target of the Ant build file will be used.
6.4. Validating Models

In the context of pure::variants, Model Validation is the process of checking the validity of feature, family, and variant description models. Two kinds of model validation are supported, i.e. validating the XML structure of models using a corresponding XML Schema and performing a configurable set of checks using the model check framework.

6.4.1. XML Schema Model Validation

This model validation uses an XML Schema to check if the XML structure of a pure::variants model is correct. This is pure syntax check, no further analyses of the model are performed.

The XML Schema model validation is disabled per default. It can be enabled selecting option "Validate XML structure of models..." on the Variant Management->Model Handling preferences page (menu Window->Preferences). If enabled all pure::variants models are validated when opened.

Note

Invalid models will not be opened correctly if the XML Schema model validation is enabled.

For more information about XML Schema see the W3C XML Schema Documentation.

6.4.2. Model Check Framework

The model check framework allows the validation of models using a configurable and extensible set of rules (called "model checks"). There are no restrictions on the complexity of model checks.

Configuring the Framework

The model check framework is configured on the Variant Management->Model Validation preference page (menu Window->Preferences). On the Check Configurations tab the model check configurations can be managed and activated (see Figure 6.21, “Model Validation Preferences Page”).
The two default configurations "All Model Checks" and "All Element Checks" are always available. "All Model Checks" contains all model checks that perform whole model analyses. Compared with "All Element Checks" containing all checks that perform analyses on element level. The configuration "All Element Checks" is enabled per default if the pure::variants perspective is opened the first time.

A model check configuration is activated by selecting it in the Available Configurations list. If more than one configuration is selected, the checks from all selected configurations are merged into one set that becomes activated.

The checks contained in a configuration are shown in the Selected Configuration list by clicking on the name of the configuration. The checks are listed by its names followed by the list of model types supported by a check. Additionally the icon reveals if the check is enabled for automatic model validation (see the section called “Performing Model Checks”). A brief description of a check is shown by moving the mouse pointer over the check name.

All but the two default configurations "All Model Checks" and "All Element Checks" can be deleted by clicking first on the name of the configuration and then on button Delete.

A new configuration can be created by clicking on button New. This will open the New Check Configuration dialog as shown in Figure 6.22, “New Check Configuration Dialog”.

Figure 6.21. Model Validation Preferences Page
For a new check configuration a unique name for the configuration has to be entered. The available checks are shown in the Available Checks tree and can be selected for the new configuration by clicking on the check boxes of the checks. Clicking on the root of a sub-tree selects/deselects all checks of this sub-tree.

Detailed information about a check are displayed in the Check Details area of the dialog if the name of a check is selected. The Model Types field shows the list of model types for which the corresponding check is applicable. The Description field shows the description of the check.

The same dialog appears for editing and copying check configurations using the Edit and Copy buttons. Only non-default configurations can be edited.

And with the "Enable check for..." button (or clicking on the icon of a check)

**Automatic Model Validation**

On the Automatic Validation tab it can be configured which checks are allowed to be performed automatically (see Figure 6.23, "Automatic Model Validation Preferences Page"). If the automatic model validation is enabled, after every change on the model those checks are performed from the active check configurations that are enabled for automatic model validation.
The **Available Checks** tree shows all known checks independently from the selected check configuration. Clicking on the check box of a check toggles the automatic validation state of the corresponding check. Clicking on the root of a sub-tree toggles all checks of this sub-tree.

A description of the check is shown by moving the mouse pointer over the check name.

**Performing Model Checks**

A model can be checked using the selected model check configurations by opening the model in a corresponding model editor and pressing button in the tool bar. This will start a single model validation cycle. The progress of the model validation is shown in the Progress view.
Figure 6.24. Model Validation in Progress

If no model check configuration is selected a dialog is opened inviting the user to choose a non-empty check configuration. This dialog can be disabled by enabling the "Do not show again" check box of the dialog.

The button is used to enable automatic model checking, i.e. after every change on the model a new check cycle is started automatically. In contrast to the single model validation cycle only those checks are performed from the active check configurations that are enabled for automatic model validation. Automatic model validation is enabled by default.

The result of a model check cycle is a list of problems found in the model. These problems are shown in the Problems view and as markers on the model. A list of quick fixes for a problem can be shown either by choosing "Quick Fix" from the context menu of the problem in the Problems view or by clicking on the corresponding marker on the model. For some problems special quick fixes are provided fixing all problems of the same kind.

6.5. Refactoring Models

To simplify the editing of Feature and Family Models pure::variants provides a set of refactoring operations. They support the user to efficiently change model objects like elements, relations, restrictions and attributes.

The refactoring operations can be accessed via the context menu of the Feature and Family Model Editors, see Figure 6.25, "Refactoring context menu for a feature".
Comparing Models

Figure 6.25. Refactoring context menu for a feature

The refactoring operations provided in the context menu depend on the selection made in the editor. For instance, select two or more features and right-click on one of the selected features to open the context menu. The appearing Refactoring menu contains for example items for changing the variation type. This operation allows to modify the variation type for all selected features at once. Compared with the conventional way that opens the element properties dialog for each feature, refactoring operations save a lot of time. There are numerous operations that can be performed on model objects.

The following list summarizes the available refactoring operations.

Table 6.2. Refactoring Operations

<table>
<thead>
<tr>
<th>Operation on</th>
<th>Available Operations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Elements</td>
<td>Variation Type Change</td>
</tr>
<tr>
<td></td>
<td>Element Type Change</td>
</tr>
<tr>
<td></td>
<td>Default-Selected State Change</td>
</tr>
<tr>
<td>Attributes</td>
<td>Attribute Name, Type, and Value Change</td>
</tr>
<tr>
<td></td>
<td>Inheritable and Fixed State Change</td>
</tr>
<tr>
<td>Restrictions and Constraints</td>
<td>Restriction/Constraint Code Change</td>
</tr>
<tr>
<td>Relations</td>
<td>Relation Type Change</td>
</tr>
<tr>
<td></td>
<td>Relation Targets Change</td>
</tr>
</tbody>
</table>

6.6. Comparing Models

In pure::variants two models can be compared using the Model Compare Editor. It is based on the Eclipse Compare.

6.6.1. General Eclipse Compare

In general, comparison of resources is divided into two different types. One is to compare two resources with each other. This is called a two-way compare. A two-way compare can only reveal differences between resources, but can not recognize in which resource a change was performed. A two-way compare in Eclipse is obtained by selecting two resources and then choosing Compare With->Each Other from the context menu. Other two-way comparisons supported by Eclipse are Compare With->Revision and Compare With->Local History.

A more comfortable comparison is so called three-way compare. In addition it has an ancestor resource from which is known that this is the unchanged resource. In this way it can be determined which change was performed in which resource. Such compare editors are opened for instance for synchronizing resources with CVS repositories
which always maintain a third ancestor resource by using \textit{Compare With->Latest from Head} and \textit{Compare With->Another Branch or Version}.

The compare editor is divided into an upper and a lower part. The upper part shows structural changes in a difference tree. The lower part presents two text editors located next to each other. Changes are highlighted in colored lines or rectangles on both sides. Those belonging to one change are connected with a line. For two-way comparisons the changes are always grey-colored. In three-way comparisons outgoing (local) changes are grey-colored, incoming (remote) changes blue-colored, and changes on both sides which are conflicting are red-colored.

A resource compare can be used to view changes for two resources. In addition it provides the possibility to apply single changes to local models. Therefor the compare editor provides a toolbar, located between the upper and the lower part, with actions which can be used to apply changes: \textit{Copy All from Left to Right}, \textit{Copy All Non-Conflicting Changes from Right to Left}, \textit{Copy Current Change from Left to Right}, \textit{Copy Current Change from Right to Left}, \textit{Select Next Change}, \textit{Select Previous Change}. You can step through the changes and apply them if the specific buttons are enabled. As stated above refer to the Eclipse \textit{Workbench User Guide} for detailed information on this.

\subsection*{6.6.2. Model Compare Editor}

In general the Eclipse text compare editor is opened for any resource after calling the actions described in the previous section. For pure::variants models the special pure::variants Model Compare Editor is opened. This makes it easier to recognize changes in pure::variants models. Typical changes are for example \textit{Element Added}, \textit{Attribute Removed}, \textit{Relation Target Changed}.

The upper part of the editor, i.e. the structure view, displays a patch tree with a maximum depth of three. Here all patches are grouped by their affiliation to elements. Thus \textit{Element Added} and \textit{Element Removed} are shown as top level patches. All other patches are grouped into categories below their elements they belong to. Following categories exist: \texttt{General}, \texttt{Attributes}, \texttt{Relations}, \texttt{Restrictions}, \texttt{Constraints} and \texttt{Misc}. The names of the categories indicate which patches are grouped together. Below the category \texttt{Misc} only patches are shown that are usually not displayed in the models tree viewer. As in the Eclipse text compare you can step through the patches with the specific buttons. Each step down always expands a model patch if possible and steps into it. The labels for the patch consist of a brief patch description, the label of the patched model item and a concrete visualization of the old and the new value if it makes sense. Here is an example: \texttt{Attribute Constant Changed}: \texttt{attrname = 'newValue' <- oldValue}. In this attribute patch’s label a new value is not additionally appended, because it is part of the attributes (new) label "\texttt{attrname = 'newValue' "}.

The lower part of the model compare editor is realized using the usual model tree viewers also used in the model editors. They are always expanded to ensure that all patches are visible. As in the text compare editors, patches are visualized by colorized highlighted rectangle areas or lines using the same colors. In opposite to the text compare they are only shown if the patch is selected in the upper structure view. For two-way comparisons it is ambiguous which model was changed. Because of this an additional button is provided in the toolbar which allows to exchange two models currently opened in the model compare editor. This leads from a remove-patch into an add-patch, and for a change the new and the old value are exchanged.

The model compare editor compares two model resources on the model abstraction layer. Hence textual differences may exist between two models where the model compare editor shows no changes. Thus conflicts that would be shown in a textual compare are not shown in the model compare editor. This allows the user to apply all patches in one direction as desired and then to override into the other direction.

\subsection*{6.6.3. Conflicts}

In three-way comparisons it may occur that an incoming and an outgoing patch conflict with each other. In general the model compare editor distinguishes between fatal conflicting patches and warning conflicts. In the tree viewer conflicts are red-colored. A fatal conflict is for example an element change on one side, while this element was deleted on the other side. One of these patches is strictly not executable. Usually warning conflicts can be merged, but it is not sure that the resulting model is patched correctly. Typical misbehaviour could be that some items are order inverted. To view which patch conflicts with which other path just move the mouse above one of the conflicting patches in the upper structure view. This and the conflicting patch then change their background color either to red for fatal conflicts or yellow for conflict warnings.
In general a sophisticated algorithm tries to determine conflicts between two patches. These results are very safe hints, but 100% safety is not given. For a conflicting or non-conflicting patch it may occur that it can not be executed. Conflict warning patches may be executed without problems and lead to a correct model change. In general the user can try to execute any patch. If there are problems then the user is informed about that. If there are problems applying a non-conflicting patch, the editor should be closed without saving and reopened. Then another order of applying patches can solve this problem. The actions Apply All Changes ... do only apply incoming and non-conflicting changes. Other patches must be selected and patched separately.

6.6.4. Compare Example

Figure 6.26, “Model Compare Editor” shows an example how a model compare editor could look like for a model that is synchronized with CVS. The upper part shows the structure view with all patches visible and expanded representing the model differences. A CVS synchronize is always a three-way compare. There are incoming changes (made in the remote CVS model) and outgoing (local) changes. As to see in the figure the incoming changes have a blue left arrow as icon, while outgoing changes have a grey right-arrow as icon. Added or removed items have a plus or a minus composed to the icon. Conflicting changes are marked with a red arrow in both directions displayed only at the element as the patches top level change. In this example a conflict arises at the element conflicting. In CVS its unique name changed and a relation was added while this element was deleted locally. Two patches show a red background because the mouse hovered above one of these patches which is not visible in the figure. Note that the tree viewers in the lower part show only the patches which are selected above. The colors correspond to the patch direction.
6.7. Searching in Models

6.7.1. Variant Search

Feature and Family Models can be searched using the Variant Search dialog. It supports searching for elements, attributes, attribute values, restrictions, and constraints.

The Variant Search dialog is opened either by choosing the Search->Variant menu item, by clicking on the Eclipse Search button and switching to the Variant Search tab, or by choosing Search from the context menu of the model editor.
The dialog is divided into the following sections.

**Search String**

The search string input field specifies the match pattern for the search. This pattern supports the wildcards "*" and "?".

<table>
<thead>
<tr>
<th>Wildcard</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>?</td>
<td>match any character</td>
</tr>
<tr>
<td>*</td>
<td>match any sequence of characters</td>
</tr>
</tbody>
</table>

Case sensitive search can be enabled by checking the "Case sensitive" check box. The settings for previous searches can be restored by choosing a previous search pattern from the list displayed when pressing the down arrow button of the Search String input field.

**Search Type**

In this group it is specified what kind of model elements is considered for the search.

- **Elements**: Search element names matching the pattern.
- **Attributes**: Search element attribute names matching the pattern.
- **Attribute Values**: Search element attribute values matching the pattern.
- **Restrictions**: Search restrictions matching the pattern.
- **Constraints**: Search constraints matching the pattern.

For refining the search the "Element Scope" group is activated for search type Elements and the "Attribute Scope" group is activated for search type Attribute Values.

**Limit To**

This group is used to limit the search to a specific model type. The following limitations can be made.

- **All Occurrences**: All model types are searched.
Family Models Only Family Models are searched.

Feature Models Only Feature Models are searched.

**Element Scope**

This group is only activated if Elements search type is selected. Here it can be configured against which element name the search pattern is matched.

- **Unique Name** Match against the unique name of the element.
- **Visible Name** Match against the visible name of the element.

At least one of the options has to be chosen.

**Attribute Scope**

This group is only activated if Attribute Values search type is selected. In this group the following refinements can be made.

- **Calculations** Match against attribute value calculations.
- **Constants** Match against constant attribute values.

At least one has to be selected. To limit the search to values of attributes with a specific name, this name can be inserted into the Attribute Name input field.

**Scope**

This group is used to limit the search to a certain set of models. The following options are available.

- **Workspace** Search in all variant projects of the workspace.
- **Selected resources** Search only in the projects, folders, and files that are selected in the Variant Projects view.
- **Enclosing projects** Search only in the enclosing projects of selected project entries in the Variant Projects view.
- **Working set** Search only in projects included in the chosen working set.

For more information about working sets, please consult the Workbench User Guide provided with Eclipse (Help->Help Contents, section "Concepts"->"Workbench"->"Working sets").

**Search Results**

The results of the search are listed in the Variant Search view supporting a tree and table representation and a search result history. For more information about the Variant Search view see Section 7.4.3, “Search View”.

After the search is finished blue markers are created on the right side of models containing matches. These markers visualize the matches in the model and provide an easy way to navigate to the matched model items simply by clicking on a marker.

### 6.7.2. Quick Overview

Within a model editor it is possible to search using the Quick Overview. Especially in large models it is sometimes hard to find an element with a known name or a known part of the name. To shorten the navigation through tree nodes or tables in model editors pure::variants provides a quick overview which you may already know from Eclipse as *Quick Outline*. If a model editor (e.g. a Feature Model Editor) is active then pressing the shortcut `<CTRL>+O` opens a small window with a sorted and filtered list of all model elements. Figure 6.28, “Quick Overview in a Feature Model” shows an example for the quick overview.
After the quick overview popped up a filter text can be entered. Shortly after the modification of the filter text the list of the quick overview will be updated according to the given filter. The filter can contain wildcards like the question mark `?` and the asterisk `*` as place holders for one arbitrary character and an arbitrary sequence of characters, respectively. You may also use CamelCase notation. Camel case means that between each capital letter and the letter in front of it a `*` wildcard is placed internally to the filter text. For example, typing `ProS` as filter text would also find elements like `Protocol Statistics` or `Project Settings`.

Finally, if the desired element is shown in the quick overview then a double-click on it lets the editor navigate to that element. You can also use the arrow keys to select the item from the list and press **ENTER** to get the same effect.

**Note**

The quick overview presents only those model objects which the active model editor shows. For instance, if the editor shows relations then the quick overview presents them, too. Additionally the filter set to the editor has effect to visibility of elements in the quick overview.

### 6.8. Analyse Models

Having a configuration space with a lot of variant description models it is very likely, that some of the variants are very similar or even equal. This section describes tasks, which enable the user to find similar variants and selection cluster within these variants.

#### 6.8.1. Finding variant description models with similar selections

For finding variant description models with similar selections, pure::variants provides two solutions.

The first one starts with one vdm, selected by the user and calculates the similarity between this base vdm and all other vdms from the same configuration space. The second possibility is to calculate the similarity between a selection of vdms from a configuration space.

**Note**

The similarity algorithm does not take attribute values into account. It does just calculate the similarity based on element selections.
Finding variant description models similar to one base vdm

To calculate the similarity, between one vdm and the other vdms of the same configuration space, select the base vdm and start the calculation with the *Similar Variants* action in the *Model and Variant Analysis* sub menu of the context menu.

**Figure 6.29.**

A dialog comes up, as soon as the calculation is finished. This dialog shows all variants of the configuration space and the similarity to the base vdm in percent. This dialog allows the user to select vdms for further analysis.
Finding variant description models with similar selections

Figure 6.30. The similarity calculation result dialog

![Similarity Calculation Result Dialog](image)

The selected vdm's can be opened using one of the buttons in the lower part of the dialog.

- **In Matrix** opens the selected vdm's in the matrix editor. An already open matrix editor is reused.
- **In VDM Editor** opens each selected vdm in a variant description model editor.
- **In Compare Editor** opens one compare editor for each selected vdm, which shows the compare result between the selected vdm and the base vdm.

**Calculating similarity between multiple variant description models**

To calculate the similarity between a selection of variant description models from one configuration space the action Open Similarity Matrix in the Model and Variant Analysis submenu in the context menu is used. This action starts the calculation of the similarity between all selected vdm's. It is also possible to start this action for the whole configuration space by selecting the configuration space folder. The used algorithm is the same as for the Same Selection and Similar Variants actions.

The result of the calculation is presented in the Similarity Matrix. Each row shows the similarity values between the vdm represented by this row and the vdm's represented by the columns.
Finding variant description models with the same selection

Figure 6.31. Similarity Matrix

The Open Compare Editor action from the context menu of one similarity value is used to have a detailed look on the differences between the corresponding vdms. This opens the vdms in a compare editor.

With the Export Similarity Matrix... action from the context menu the similarity matrix can be exported to a Microsoft Excel document.

Figure 6.32.

6.8.2. Finding variant description models with the same selection

The algorithm, which is used here is the same algorithm used in the Similar Variants analysis. The scope is just set to 100% similarity. The action is used the same way like the Similar Variant action. Select one base vdm and start the calculation with the Same Selection action in the Model and Variant Analysis sub menu of the context menu.

The same selection result dialog comes up, which shows all variants from the same configuration space, that have the same selections as the base vdm. This dialog allows the user to select vdms for further analysis.
Find elements with the same selection states in all variant description models

Figure 6.33. The same selection result dialog

The selected vdm can be opened using one of the buttons in the lower part of the dialog.

- **In Matrix** opens the selected vdm in the matrix editor. An already open matrix editor is reused.

- **In VDM Editor** opens each selected vdm in a variant description model editor.

- **In Compare Editor** opens one compare editor for each selected vdm, which shows the compare result between the selected vdm and the base vdm.

### 6.8.3. Find elements with the same selection states in all variant description models

To find elements, which selection state is equal in all variants pure::variants provides the action *Element Cluster Analysis* from the context menu of several selected vdm or the whole configuration space folder. Having the same selection state in all selected variants means, that an element a has the same selection state as element b for all selected variants. It does not mean, that element a and element b are selected or deselected in all checked variants. The selection state may change from variant to variant.

This action brings up the input model selection dialog. This dialog allows the user to define the scope of the analysis. Deselected input models will not contribute to the analysis. The option *Include manadatory elements* includes mandatory elements into the calculation, since this elements are automatically selected, they are ignored during the analysis by default. Option *Use suer selection only* causes the analysis to ignore all automatic selections during the calculation and just consider selection made by an user.
Figure 6.34. The same selection result dialog

The calculation result is presented in the view Element Cluster. Elements, which are having the same selection state in all vdmns are grouped in element cluster. There are 4 types of clusters:

- The cluster *Always On* lists all elements, which are selected in all considered variants.
- The cluster *Always Off* lists all elements, which are never selected in the considered variants.
- The cluster *Multi Selection Cluster* lists variable elements. A Multi Selection Cluster contains more than one element.
- The cluster *Single Selection Cluster* lists variable elements. A Single Selection Cluster contains exactly one element.

Each cluster contains the following informations. The number of elements in that cluster, shown in brackets after the cluster name. The elements grouped by the input models and their selector. For each selector the vdm is shown.

Besides the elements for each vdm is shown, if the elements of that cluster are selected or deselected.

**Hint:** pure::variants navigates to the elements in the input models after double clicking on the elements in the result view.
6.8.4. Find constant and variable elements in all variant description models

To find out which elements are variable and which elements are constant in all variants pure::variants provides the action Selection State Analysis from the context menu of several selected vdims or the whole configuration space folder. An element is considered to be variable, if it is at least selected in one vdm and not selected in all considered vdims.

This action brings up the input model selection dialog. This dialog allows the user to define the scope of the analysis. Deselected input models will not contribute to the analysis. The option Include mandatory elements includes mandatory elements into the calculation, since this elements are automatically selected, they are ignored during the analysis by default. Option Use user selection only causes the analysis to ignore all automatic selections during the calculation and just consider selection made by an user.
Find constant and variable elements in all variant description models

**Figure 6.36. The same selection result dialog**

The calculation result is presented in the view *Selection State Cluster*. There are 3 types of cluster:

- The cluster *Allways On* lists all constant elements, which are selected in all considered variants.
- The cluster *Allways Off* lists all constant elements, which are never selected in the considered variants.
- The cluster *Variable* lists variable elements.

Each cluster contains the following informations. The number of elements in that cluster, shown in brackets after the cluster name. The elements grouped by the input models and their selector. For each selector the vdm is shown. In the label of the elements the number of selections is shown.

**Hint:** pure::variants navigates to the elements in the input models after double clicking on the elements in the result view.
For further analysis the result view provides some actions. For each cluster a filter can be created using the *Create Filter for Cluster Elements* action in the context menu on a cluster tree item. This creates a filter, which can be used in all pure::variants editors to set the focus on the elements of that cluster.

The action *Export Result to CSV* exports the result data to a csv file, which can be used for further data analysis outside pure::variants.

### 6.9. Filtering Models

Most views and editors support filtering. Depending on the type of view, the filtered elements are either not shown (table-like views) or shown in a different style (tree views). Filters can be defined, or cleared, from the context menu of the respective view/editor page. When the view/editor has several pages the filter is active for all pages.
Arbitrarily complex filters based on comparison operations between feature/element properties (name, attribute values, etc.) and logical expressions (and/or/not) are supported. Comparison operations include conditions like equality and containment, regular expressions (matches) and checks for the existence of an attribute for a given element (empty/not empty). See Section 9.11, “Regular Expressions” for more information on regular expressions.

Filters can be named for later reuse using the Named Filter field. The drop-down box allows access to previously defined filters. Fast access to named filters is provided by the Visualization view, which can be activated using the Windows->Views->Other->Variant Management->Visualization item. See Section 7.4.2, “Visualization View” for more information on the view.

6.10. Computing Model Metrics

All pure::variants model editors provide an extensible set of metrics for the opened models. These metrics can be displayed by choosing Show Metrics from the context menu of a model editor. If metrics shall be displayed only for a sub-tree of a model, the root of this sub-tree has to be selected before the context menu is opened.
The available metrics are listed in a tree showing the name and overall results of the metrics on top level. Partial results and detailed information provided by a metric are listed in the corresponding subtree. An explaining description of a metric is displayed in the **Description** field if the name of the metric is marked.

The radio buttons at the bottom of the metrics dialog are used to switch between whole model and selected elements metric calculation. For VDMs, metrics are always calculated for the whole model. If a VDM has not been evaluated yet, the calculated metrics may be outdated and can show incorrect values.

On the **Variant Management->Metrics** preferences page (menu **Window->Preferences**), the set of metrics to apply can be configured.

### 6.11. Extending the Type Model

For every project a Type Model can be created extending the global Type Model. This model belongs to the project and can be shared like any other pure::variants model. This is an easy and a straightforward way to contribute own types to be used in the Feature and Family Models of the project containing the Type Model.

To create a Type Model right-click on a project in the Variant Project View and choose **New->Type Model** from the context menu. This creates a new file in the project named like the project and with extension ".typemodel". Note that only one Type Model can be created per project. The new Type Model is opened in the Type Model Editor. This editor also is opened by double-clicking on an existing Type Model file (see Figure 6.40, “Type Model Editor Example”).

The Type Model Editor consists of two parts. The left part shows the list of types defined in the model, while the right part provides an editing area for the type selected on the left. Additionally the left part provides a context menu for adding and removing types of the model.

The Type Model Editor allows to add element and attribute types. After adding an attribute type the right part allows to change the **Name**, **Base Type** (that is the type which this type is specializing), whether this type is **Abstract** (and thus can only be used as base type for other types), and whether this is an enumeration type only allowing one of the listed values.
The editor provides for element types to change the Label, Name and the Base Type. Additionally the element type may be set Abstract and if there shall be a generic New Wizard, which would allow to easily create an element of that type.

For an element type attributes can be created. Those attributes present the default attributes which are defined for a concrete element of that type. For each attribute a Name, a Type, whether it is a Single Value, List or Set can be specified. Following flags can be set for an attribute: Optional (whether this attribute is required for an element), Fixed (whether it has a constant value or can be overridden in a VDM), Read Only (whether the user can provide a value for it) and Invisible (whether it is visible to the user).

After a Type Model was created or changed, the types defined in the Type Model are immediately available for modeling in the corresponding project.

Figure 6.40. Type Model Editor Example

6.12. Using Multiple Languages in Models

pure::variants is able to deal with multiple languages for the visible name of elements and for all descriptions. This allows to define Feature and Family Models in more than one language.

The default language for models is defined in the preferences on the visualization page. Select Window->Preferences... from menu and then Variant Management->Visualization to change it. The default language is used for all views and editors.

To edit visible names or descriptions for a particular language use the language button () in the element properties dialog as in Figure 6.41, “Language selection in the element properties dialog”. Clicking on the arrow of that button shows a list of languages currently in use in the model. By selecting a language from that list the visible name and all descriptions in the element properties dialog are shown in that language. You can change them, switch to another language and then change them again, pure::variants saves the visible name and all descriptions for each chosen language. If the desired language is not present in the language list then select the More... item to chose the language in the upcoming dialog. The selected language will be added to the language list.
Note

There is a language with name *Unspecified* and abbreviation `??` available. This language can be used like others. Typically, it is used when the language of visible names and descriptions do not play a role. After installation of pure::variants it is set as the first default language. All texts of old models are treated as if they were entered for the language *Unspecified*.

The visible name and the description fields sometimes show texts from another language than the active, usually with an annotation like *[Language: EN]*. This occurs when no visible name or description was entered for the active language, to point out that there is a text for another language (in the example EN stands for English). However, simply modify the text to specify a text for the active language. Or, you may replace it by its translation.

Multiple languages of visible names and descriptions are also supported in the properties view (see Section 7.4.6, “Properties View”) and in the model properties page as well as in the general properties page of a model (see Section 7.5.1, “Common Properties Page” and Section 7.5.2, “General Properties Page”). Look for the language button and use it like described above.

### 6.13. Importing and Exporting Models

#### 6.13.1. Exporting Models

Models may be exported from pure::variants in a variety of formats. An Export item is provided in the Navigator and Variants Project views context menus and in the File menu. Select **Variant Resources** from category **Variant Management** and choose one of the provided export formats.

Currently supported export data formats are HTML, XML, CSV and Directed Graph. The Directed Graph format is only supported for some models. Additional formats may be available if other plug-ins have been installed.
HTML export format is a hierarchical representation of the model. XML export format is an XML file containing the corresponding model unchanged.

CSV, character separated values, export format results in a text file that can be opened with most spreadsheet programs (e.g. Microsoft Excel or OpenOffice). CSV export respects the filters set in the editor of the model to export, i.e. only the matching elements are exported. The export wizard permits the columns to be generated in the output file to be selected.

**HTML Export**

The HTML Export generates representations for feature and family models in HTML. The generated HTML file can be opened by any browser (e.g. "Internet Explorer", "Firefox", etc.).

The export will generate a navigation section which represents all model elements hierarchical in a tree and the data of the elements on the right side of the generated html page. The navigation tree will help to navigate to elements quickly. The selected element in the navigation section will be shown on top of the content section. Each section of an element includes the following paragraphs:

- **General Properties**
- **Description**
- **Properties**
- **Relations, Restrictions and Constraints**

The **General Properties** paragraph shows information like Unique Name, Element Class, Variation Type, Element Type and Default Selected.

The following two pictures are showing the HTML Export wizard. The first page enables the user to define an absolute path for the output file. Using pure:variants path variables is supported. The style of the html output can be adjusted individually by referencing your own stylesheet (*.css) either as web URL or local file. The stylesheet can either be linked or inlined in the html output file.
Figure 6.42. HTML Export Wizard

Define output path and css file path.

On the second configuration page a filter can be selected, which applies to the selected model. Elements which apply to the filter are not included in html output. Please see Section 6.9, “Filtering Models” for further instructions. To hide specific information (e.g. “Restrictions”, “Specific Attributes”,...) in the selected model a tree layout can be selected in the combo box Layouts. For further Information see the section called “Tree Editing Page”. 
Define filter and tree layout.

The following stylesheet classes are supported in the HTML Export.

**Table 6.3. Table of CSS classes**

<table>
<thead>
<tr>
<th>CSS Class</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>.section</td>
<td>All sections including &quot;General Properties&quot;, &quot;Description&quot;, &quot;Properties&quot; and...</td>
</tr>
<tr>
<td>.ps-general</td>
<td>&quot;General Properties&quot; section placed beneath Feature headline</td>
</tr>
<tr>
<td>.ps-description</td>
<td>&quot;Description&quot; section placed beneath &quot;General Properties&quot;</td>
</tr>
<tr>
<td>.ps-properties</td>
<td>&quot;Properties&quot; section placed beneath &quot;Description&quot;</td>
</tr>
<tr>
<td>.ps-reations</td>
<td>&quot;Relations, Restrictions, Constraints&quot; placed beneath &quot;Properties&quot;</td>
</tr>
<tr>
<td>.ps-breadcrumb</td>
<td>Breadcrumb navigation path beneath Feature's headline</td>
</tr>
<tr>
<td>.ps-feature</td>
<td>Section of a Feature</td>
</tr>
</tbody>
</table>

Is the html output opened in a browser the following interactions are available:

- Breadcrumb navigation placed beneath each element headline to navigate quickly to the parents of the element.
- Expand/Collapse tree buttons on the bottom of the navigation on the left side of the website to expand/collapse the navigation tree.
- Expand/Collapse model buttons on the right bottom of the website to expand/collapse all element sections.
- Expand/Collapse buttons on any element sections and headline to expand/collapse all element sections and headline of the same type in the whole html document.
• Elements having a relation have a hyperlink to quickly navigate to the related elements.

The following image shows a typical html export.

**Figure 6.44. HTML Export Result**

![HTML Export example.](image)

It is not possible to export a Variant Description Model using the export wizard as described above. For exporting a vdm a transformation module is used. The transformation is described in the next section.

**HTML Transformation Module**

For exporting a vdm to a html document the transformation module *HTML Transformation Module* is used. See below the module in the transformation module selection dialog.
The next image shows the parameter of this transformation module.

The parameter **Output** enables the user to define a different output folder, for the result of the HTML transformation.

The transformation module for HTML has three different modi, called **Result Models Tailored**, **Result Models Annotated** and **Input Models Only**. The modus is selected with the parameter **Mode**.

The **Result Models Tailored** mode executes a transformation of on variant description model and will output the transformed feature and family models as html representation. Each model will generate a single html output file. The name of this file will be the name of the model suffixed with the model type. In this mode only elements part of the variant will get exported to the html.

The **Result Models Annotated** mode exports all elements defined in the input models, but it will gray out all the elements, which are not part of the transformed variant.

The **Input Models Only** mode doesn't execute a transformation but exports all input models defined in the used configuration space. Furthermore are all configuration parameters definable except the filter parameter.

Third parameter **Layout** is optional. If used it defines a tree layout, which will be used during the transformation. (the section called “Tree Editing Page”)

Fourth parameter **Stylesheet** defines whether **No Stylesheet** is used or if a **Link Stylesheet** is used, or if a **Inline stylesheet** is used.

Parameter **Stylesheet Path** is optional, but needed if **Link Stylesheet** or **Inline Stylesheet** was selected. It defines the path to the local css file or a URL to a remote css file.

The last two optional parameter allow the user to filter the input models of the configuration space. The **Model Type Filter** allows the user to filter the input models regarding their type. Additionally the parameter **Model Name Filter** allows the user to specify a regular expression, which is used to filter the models by their names.
Directed Graph Export

The directed graph export format generates a model graphs in the DOT language and with appropriate tools installed also images in many other image format such as JPEG, PNG, BMP. This can be used for generation of images for use in documentation or for printing. If the DOT language interpreter from the GraphViz package (http://www.graphviz.org/) is installed in the computers executable path or the packages location is provided as a preference (Windows->Preferences->Variant Management->Image Export), many image formats can be generated directly. The dialog shown in Figure 6.47, “Directed graph export example” permits many details of the output, such as paper size or the layout direction for the model graph, to be specified. Graphs for sub-models may be exported by setting the root node to any model element. The Depth field is used to specify the distance below the root node beyond which no nodes are exported. The Colored option specifies whether Feature Models are exported with a colored feature background indicating the feature relation (yellow=ps:mandatory, blue=ps:or, magenta=ps:option, green=ps:alternative). Figure 6.48, “Directed graph export example (options LR direction, Colored)” shows the results of a Feature Model export using the Left to Right graph direction and Colored options.
6.13.2. Importing Models

An Import item is provided in the Navigator and Variants Project views context menus and in the File menu. Select **Variant Models or Projects** from category **Variant Management** and choose one of the provided import sources.

Currently two generic imports are provided. The first one imports a Family Model from source directories. This import creates a Family Model or parts of a Family Model from an existing directory structure of Java or C/C++ source code files.

The second generic import, imports a Feature Model or a Family Model from a CSV file. While importing a few fields are directly used by pure::variants to build the model. Other fields are imported as attributes to the elements. These fields are:

<table>
<thead>
<tr>
<th>Unique Name</th>
<th>Unique ID</th>
<th>Unique name of an element.</th>
<th>Unique Id of an element</th>
</tr>
</thead>
</table>

Table 6.4.
## Importing Models

<table>
<thead>
<tr>
<th>Visible Name</th>
<th>Visible name of an element.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variation Type</td>
<td>The variation type of an element. Possible values are: ps:mandatory, ps:optional, ps:or and ps:alternative. If no variation type is given ps:mandatory is used.</td>
</tr>
<tr>
<td>Parent Unique ID</td>
<td>The Unique ID of the parent element.</td>
</tr>
<tr>
<td>Parent Unique Name</td>
<td>The Unique Name of the parent element.</td>
</tr>
<tr>
<td>Parent Visible Name</td>
<td>The Visible Name of the parent element.</td>
</tr>
<tr>
<td>Parent Type</td>
<td>The Type of the parent element.</td>
</tr>
<tr>
<td>Class</td>
<td>The class of an element, most likely ps:feature for Feature Model or ps:component for Family Model.</td>
</tr>
<tr>
<td>Type</td>
<td>The type of an element, most likely ps:feature for Feature Model or ps:component for Family Model.</td>
</tr>
</tbody>
</table>

For importing a CSV to a Feature Model the field **Unique Name** is necessary. If you like to import a hierarchical model either the fields **Unique ID** and **Parent Unique ID** or **Unique Name** and **Parent Unique Name** are necessary as well. In case of importing an hierarchical model the element without Parent Unique ID will be the root element, if no Parent Unique IDs given, the first element without will be the model root.

Please note, the CSV export of pure::variants exports more fields as the CSV import of pure::variants can import. Fields such as **Relations**, **Restriction** and **Constraint** are ignored by CSV import. Therefore a full roundtrip with the help of the CSV data format is not possible.

Additional imports may be available if different plug-ins are installed.

### User-defined import manipulator with JavaScript

For customization of an imported pure::variants model a **JavaScript Manipulator** is provided. This manipulator is available for all importer, which support import manipulators.
On the JavaScript Manipulator wizard page, a JavaScript file needs to be given, which is performed after the import is done, to customize the resulting pure::variants model. It is allowed to use pure::variants path variables in the JavaScript path.

Additionally, parameters for the JavaScript can be defined on this page. Parameters are simple name-value pairs. The JavaScript can also define parameters and default values in a comment at the top of the script. These parameters are automatically added to the parameters table, if the script is loaded.

**Note**

An example JavaScript is generated using the "New -> JavaScript Manipulation Script" entry from the context menu in the projects view. This script shows a basic model manipulation and how parameters are defined in a JavaScript.

### 6.14. External Build Support (Ant Tasks)

pure::variants provides some useful Ant tasks. They can be used with buildfiles inside Eclipse or in headless mode.

#### 6.14.1. pv.import

The pv.import task imports a pure::variants project into the workspace. If the project is already part of the workspace nothing happens.

**Example:**

```xml
<pv.import path="C:\Projects\Weather Station"/>
<pv.import server="http://pv.server.com" name="Weather Station" revision="v2"/>
```

This task has the following attributes:
• **importreferences** if `true` the references to other projects are also imported (default is `true`)

• **path** is the absolute path to the project in the file system

• **server, name, revision** are the server URL, the name of the project, and optionally the version of a remote project to import

### 6.14.2. pv.evaluate

The `pv.evaluate` task performs an evaluation and stores the result in the given result model file.

Example:

```xml
<pv.evaluate vdm="Weather Station\Config\Indoor.vdm" vrm="Weather Station\Indoor.vrm"/>
<pv.evaluate vdm="Weather Station\Config\Outdoor.vdm" vrm="Weather Station\Outdoor.vrm">
  <property name="autoresolve" value="extended"/>
  <property name="timeout" value="120"/>
</pv.evaluate>
```

This task has the following attributes:

• **vdm** is the path to the Variant Description Model to evaluate

• **vrm** is the path to the Variant Result Model

• **continueOnError** If this property is set to `true` the task does not throw BuildExceptions, but writes problems to standard out and finishes successfully.

The `pv.evaluate` task supports optional properties which influence the evaluation:

• **autoresolve** set the mode of the auto resolver. Possible values are `off`, `simple`, `extended`

• **timeout** set the maximal time used for the evaluation in seconds

### 6.14.3. pv.transform

The `pv.transform` task performs a transformation of a Variant Description Model or Variant Result Model.

Example:

```xml
<pv.transform vdm="Weather Station\Config\Indoor.vdm" name="Default" force="true">
  <property name="autoresolve" value="extended"/>
  <property name="timeout" value="120"/>
</pv.transform>
<pv.transform vrm="Weather Station\Outdoor.vrm" name="Default"/>
```

This task has the following attributes:

• **vdm** is the Variant Description Model to transform

• **vrm** is the Variant Result Model to transform

• **name** is the name of the Transformation Configuration

• **force** if `true` the transformation runs always also if the result has errors

• **continueOnError** If this property is set to `true` the task does not throw BuildExceptions, but writes problems to standard out and finishes successfully.

The `pv.transform` task supports optional properties which influence the evaluation, which runs before the transformation:
• **autoresolve** set the mode of the auto resolver. Possible values are off, simple, extended

• **timeout** set the maximal time used for the evaluation in seconds

### 6.14.4. pv.inherit

The `pv.inherit` task changes the inheritance between VDMs.

Example:

```xml
<pv.inherit vdm="Weather Station\Config\Indoor.vdm">
  <super vdm="Weather Station\Config\Base.vdm"/>
</pv.inherit>
```

This task has the following attributes:

- **vdm** is the Variant Description Model which inherits (pv.inherit tag), or which is inherited (super tag)

### 6.14.5. pv.connect

The `pv.connect` task connects to a server and login as given user.

Example:

```xml
<pv.connect server="http://pv.server.com" user="example" pass="example"/>
```

This task has the following attributes:

- **server** is the pure::variants server to connect to
- **user** is the name of the user
- **pass** is the password for the user

### 6.14.6. pv.sync

The `pv.sync` task updates a model imported by a connector. The connector specific synchronization job is called to update the models data.

Example:

```xml
<pv.sync model="Weather Station\Sources.ccfm"/>
```

This task has the following attributes:

- **model** is the model to update

### 6.14.7. pv.mergeselection

The `pv.mergeselection` task creates or updates a variant description model by merging all selections from the given variant description models. The following rules are applied. If an element is excluded in at least one source model the element is also excluded in the result. If an element is selected in at least one source model it is also selected in the result if not excluded by any other source model.

Example:

```xml
<pv.mergeselection vdm="Weather Station\Config\Merged.vdm">
  <source vdm="Weather Station\Config\IndoorBase.vdm"/>
  <source vdm="Weather Station\Config\TempOnly.vdm"/>
  <source vdm="Weather Station\Config\CommUSB.vdm"/>
</pv.mergeselection>
```
This task has the following attributes:

- **vdm** is the result model (pv.mergeselection tag) or the source model (source tag)

### 6.14.8. pv.javascript

The pv.javascript task performs a given javascript in a specific context. This allows the user to automate existing javascripts. The script can be performed in the context of one model or in the context of one project. If both a project and a model is given, the model is used for the context.

**Example:**

```xml
<pv.javascript script="C:\Temp\javascript.js" project="Weather Station"
               model="$(PROJECT)\Sources.ccfm" />
```

This task has the following attributes:

- **script** is the path to the performed javascript. This path has to be absolute or relative to the used ANT workspace.
- **model** is the path to the context model. This property is optional. Variant path variables can be used here.
- **project** is the path to the context project. This property is optional. Variant path variables can be used here.

### 6.14.9. pv.offline

The pv.offline task switches the server project into offline mode. The project is selected by the name attribute. This task does nothing if the project is already offline or if the project is a local project.

**Example:**

```xml
<pv.offline name="Weather Station" />
```

This task has the following attributes:

- **name** is the name of the project

### 6.14.10. pv.online

The pv.online task switches the server project into online mode. The task performs a "Override and update" if there are differences between the remote project and the local representation. Meaning the local data is overwritten with the current state of the project on the pure::variants Server. The project is selected by the name attribute. This task does nothing if the project is already online or if the project is a local project.

**Example:**

```xml
<pv.online name="Weather Station" />
```

This task has the following attributes:

- **name** is the name of the project

### 6.15. Linking between pure::variants and external resources

pure::variants model objects can be linked with any external resource in both directions. To create a link to an external resource inside a pure::variants object's HTML description, use the "Insert/Edit Link" ( ) action in the description editor to add the link location to your description. Alternatively you can also drag an URL and drop it
directly into the editor or on the model element. All links from the description of the selected element are shown in the Relations View.

Figures 6.50. Relations View with external Links

A double click on a link results in navigating to the link's destination if a link hander is registered for the respective link type.

To support linking in the inverse direction, pure::variants model elements can also be accessed by URL links. To get a model element's URL use the "Copy URL" context menu action on that element. The URL is made available in the Clipboard and can be pasted into any other resource or application. If external applications are able to handle drop events, a simple drag of the model element with the mouse and dropping it on the external application will work too.

The pure::variants installer for Windows will setup a link handler, which allows direct navigation from external applications to the linked pure::variants model element. However, the handler only works if an instance of pure::variants is running and the linked model element is available in the currently used workspace.

6.16. Manipulating Text Files

The pure::variants standard transformation can be used to manipulate text files based on pvSCL conditions and calculations. To achieve this, the transformation and family model needs to be set up for transforming a text file, and the file needs to be annotated with pvSCL conditions and calculations.

6.16.1. Setting Up the Transformation

For setting up the standard transformation, please refer to the section called “Setting up the Standard Transformation”. Now the text file to transform still needs to be referenced. This is done in the family model. Figure 6.51, “Family Model with ps:pvscletext transformation setup” shows an example family model referencing the input file "ConditionalPVSCLText.txt". To create the necessary family model elements, the easiest way is to use a wizard. To do this, add an element of class ps:part to the family model and select "New"->"PVSCCL Conditional Text" from the part's context menu. Please refer to Section 9.5.9, “ps:pvscletext”, for details about supported attributes.
6.16.2. Editing Conditions and Calculations in Text Files

Conditions and calculations are added to the text file as special statements, such as `PVSCL:IFCOND (pvSCL condition)` or `PVSCL:EVAL (pvSCL calculation)`. See Section 9.5.9, “ps:pvscletext” for a list of all statements and a small example text document.

To edit conditions and calculations, use the actions "Add PVSCl Condition” (select), "Add PVSCl Calculation” (select), and "Edit PVSCl Condition/Calculation” (select), which are available in the toolbar. These actions give you the same support in writing pvSCL rules as already known from editing restrictions or constraints.

For adding a condition to a section of your text, mark a section of your text and press select. Now a pvSCL editor opens, in which you can write the pvSCL rule that should apply to this text section (see Figure 6.52, “Editing pvSCL conditions or calculations”). For using auto-completion, syntax highlighting, and error checks, the editor still needs to know the pure::variants project, in which context the written rule should be evaluated. Therefore, select the context model by pressing select. Only feature models are allowed as context model. However, all other models of the same and referenced projects are considered automatically. After pressing "OK", the new condition is wrapped around the selected text.

Adding a calculation to your text works in a similar way. Press select and use the pvSCL editor to write your rule. After closing the editor, the marked text is replaced with the calculation.

To edit an existing condition or calculation, move the text selection to a place inside the calculation or condition and press select. For conditions, any place between the beginning of `PVSCL:IFCOND` and the beginning of `PVSCL:ENDCOND` is ok. For calculations, any place between the beginning of `PVSCL:EVAL` and the closing `)` is accepted. If a condition or calculation is found at your current text selection or caret position, the pvSCL editor opens, and you can edit your rule.

Figure 6.52. Editing pvSCL conditions or calculations
Chapter 7. Graphical User Interface

The layout and usage of the pure::variants User Interface closely follows Eclipse guidelines. See the Workbench User Guide provided with Eclipse (Help->Help Contents) for more information on this.

7.1. Getting Started with Eclipse

This section gives a short introduction to the elements of the Eclipse UI before introducing the pure::variants UI. Readers with Eclipse experience may skip this section.

Eclipse is based around the concepts of workspaces and projects. Workspaces are used by Eclipse to refer to enclosed projects, preferences and other kinds of meta-data. A user may have any number of workspaces for different purposes. Outside of Eclipse, workspaces are represented as a directory in the file system with a subdirectory .meta-data where all workspace-related information is stored. A workspace may only be used by a single Eclipse instance at a time. Projects are structures for representing a related set of resources (e.g. the source code of a library or application). The contents and structure of a project depends on the nature of the project. A project may have more than one nature. For example, Java projects have a Java nature in addition to any project-specific natures they may have. Natures are used by Eclipse to determine the type of the project and to provide specialised behaviour. Project-specific meta information is stored in a .project file inside the project directory. This directory could be located anywhere in the file system, but projects are often placed inside a workspace directory. Projects may be used in more than one workspace by importing them using (File->Import->Import Existing Project).

Figure 7.1, “Eclipse workbench elements” shows an Eclipse workbench window. A perspective determines the layout of this window. A perspective is a (preconfigured) collection of menu items, toolbar entries and sub-windows (views and editors). For instance this figure shows the standard layout of the Resource perspective. Perspectives are designed for performing a specific set of tasks (e.g. the Java perspective is used for developing Java programs). Users may change the layout of a perspective according to their needs by placing views or editors in different locations, by adding or closing views or editors, menu items and so on. These custom layouts may be saved as new perspectives and reopened later. The standard layout of a perspective may be restored using Window->Reset Perspective.

Editors represent resources, such as files, that are in the process of being changed by the user. A single resource cannot be open in more than one editor at a time. A resource is normally opened by double-clicking on it in a Navigator view or by using a context menu. When there are several suitable editors for a given resource type the context menu allows the desired one to be chosen. The figure below shows some of the main User Interface elements:

Figure 7.1. Eclipse workbench elements

Eclipse uses Views to represent any kind of information. Despite their name, data in some types of view may be changed. Only one instance of a specific type of view, such as the Outline view, may be shown in the workbench at a time. All available views are accessible via Windows->Show View->Other.
7.2. Variant Management Perspective

pure::variants adds a Variant Management perspective to Eclipse to provide comprehensive support for variant management. This perspective is opened using Window->Open Perspective->Other->Variant Management. Figure 7.2, “Variant management perspective standard layout” shows this perspective with a sample project.

![Figure 7.2. Variant management perspective standard layout](image)

7.3. Editors

pure::variants provides specialized editors for each type of model. Each editor can have several pages representing different model visualizations (e.g. tree-based or table-based). Selecting the desired page tab within the editor window changes between these pages.

7.3.1. Common Editor Pages

Since most models are represented as hierarchical tree structures, different model editors share a common set of pages and dialogs.

**Tree Editing Page**

The tree-editing page shows the model in a tree-like fashion (like Windows Explorer). This page allows multiple-selection of elements and supports drag and drop. Tree nodes can also be cut, copied, and pasted using the global keyboard shortcuts (see Section 9.12, “Keyboard Shortcuts”) or via a context menu.

Selection of a tree node causes other views to be updated, for instance the Properties view. Conversely, some views also propagate changes in selection back to the editor (e.g. the outline views).
A context menu enables the expansion or collapse of all children of a node. The level of details shown in the tree can be changed in the "Tree Layout" sub-menu of the context menu. If an attribute is selected in the tree and the context menu is opened, this sub-menu contains the special entry "Hide Attribute: name" is shown. It is used to hide this attribute in the tree view. Hidden attributes can be made visible again with the sub-menu action Table Layout->Change. A dialog is opened which presents a list of all visible attributes and all invisible attributes. This list can be adapted as desired. Additionally the tree layout allows to generally show or hide "Restrictions", "Constraints", "Relations", "Attributes" and "Inherited Attributes". If attributes are set as hidden, the tables mentioned above have no effect. In addition the layouts can be given a name to store them permanently in the eclipse workspace. A named layout can be set as default layout, which can apply for only one tree layout, which then always is used for any newly opened model (see Section 7.4.2, “Visualization View” for more information on it).

Double-clicking on a node opens a property dialog for it.

The labels of the elements shown in the tree can be customized on the Variant Management->Visualization preference page.

Table Editing Page

The table view is available in many views and editors. This view is a tabular representation of the tree nodes. The visible columns and also the position and width of the columns can be customized via a context menu (Table Layout->Change). A layout can be given a name. Named layouts are shown in, and can be restored from, the Visualization view (see Section 7.4.2, “Visualization View”). Named layouts and layout changes for each table are stored permanently in the Eclipse workspace. As for tree layouts a table layout can be set as default. Clicking on a column header sorts that column. The sort direction may be reversed with a second click on the same column header.

Tip

Double clicking on a column header separator adjusts the column width to match the maximal width required to completely show all cells of that column.

Most cells in table views are directly editable. A single-click into a cell selects the row; a second click opens the cell editor for the selected cell. The context menu for a row permits addition of new elements or deletion of the row. A double-click on a row starts a property dialog for the element associated with the row.

Constraints Editing Page

The Constraints page is available in the Feature and Family Model Editor and shows all constraints in the current model. Constraints can be edited or new created on this page. It also supports to change the element defining a constraint.

Figure 7.3, “Constraints view” shows the Constraints page containing two constraints formulated in pvSCL. The first column in the table of the page contains the name of the constraint. The constraint expression is shown in the second column. In column three the type of the element defining the constraint is shown. The defining element itself is shown in the last column.
New constraints can be added by pressing button "New". The name of a constraint can be changed by double-clicking into the name field of the constraint and entering the new name in the opened cell editor. Double-clicking into the "Defining Element" column of a constraint opens an element selection dialog allowing the user to change the defining element.

Clicking on a constraint shows the constraint expression in the editor in the bottom half of the page. The kind of editor depends on the language in which the constraint is formulated (see the section called “Advanced Expression Editor” for more information about the editor). The language for the constraint expression can be changed by choosing a different language from the "Language" list button.

Changes to constraints are applied using the "Apply" button and discarded using the "Restore" button.

**Graph Visualization Page**

The graph visualization page is primarily intended for the graphical representation and printing of models. Although the usual model editing operations like copy, cut, and paste and the addition, editing, and deletion of model elements also are supported.

**Note**

The graph visualization is only available if the Graphical Editing Framework (GEF) is installed in the Eclipse running pure::variants. More information about GEF are available on the GEF Home Page.

For nearly all actions on a graph that are explained in the next sections keyboard shortcuts are available listed in Section 9.12, “Keyboard Shortcuts”.

**Graph Elements**

Model elements are represented in the graph as boxes containing the name of the element and an associated icon. Feature model elements are represented as shown in the next figure.

The representation of Family Model elements slightly differs for part and source elements.
Parent-child relations are visualized by arrows between the parent and child elements.

Other relations are visualized using colored connection lines between the related elements. The color of the connection line depends on the relation and matches the color that is used for this relation on the tree editing page.

If an element has children a triangle is shown in the upper right-hand corner of the element box. Depending on whether the element is collapsed or expanded a red or white corner is shown.

**Graph Layout**

The layout of the graph can be changed in several ways. Graph elements can be moved, expanded, collapsed, hidden, and automatically aligned. The graph can be zoomed and the layout of the connections between the elements of the graph can be changed.

Two automatic graph layouts are supported, i.e. horizontal aligned and vertical aligned. Choosing "Layout Horizontal" from the context menu of the graph visualization page automatically layouts the elements of the graph from left to right. The elements are layouted from top to bottom choosing "Layout Vertical" from the context menu.

Depending on the complexity of a graph the default positioning of the connection lines between the elements of the graph may not be optimal, e.g. the lines overlap or elements are covered by lines. This may be changed by choosing one of three available docking rules for connection lines from the submenu "Select Node Orientation" of the context menu.

**No Docking Rule**

The connection lines point to the center of connected elements. Thus connection lines can appear everywhere around an element.

**Dock Connections on Left or Right**

The connection lines are positioned in the middle of the left or right side of connected elements. This is especially useful for horizontally layouted graphs.
Dock Connections on Top or Bottom

The connection lines are positioned in the middle of the top or bottom side of connected elements. This is especially useful for vertically layouted graphs.

The graph can be zoomed using the "Zoom In" and "Zoom Out" items of the context menu of the graph visualization page.

Several elements can be selected by holding down the \texttt{SHIFT} or \texttt{STRG} key while selecting further elements, or by clicking somewhere in the empty space of the graph visualization page and dragging the mouse over elements. A dashed line appears and all elements that are partially or wholly enclosed in it will be selected.

If an element has children the element can be expanded or collapsed by clicking on the triangle in the upper right-hand corner of the element's box. Another way is to use the "Collapse Element", "Expand Element", and "Expand Subtree" context menu items. In contrast to the "Expand Element" action, "Expand Subtree" expands the whole subtree of an element, not only the direct children.

To hide an element in the graph this element has to be selected and "Hide Element" has to be chosen from the context menu. Attributes, relations, and the connection lines between related elements (relations arrows) also can be hidden by choosing one of the items in the "Show In Graph" submenu of the context menu.

Elements can be moved by clicking on an element and move the mouse while keeping the mouse button pressed. This only works if the element selection tool in the tool bar is selected.

\textbf{Figure 7.4. Selected Element Selection Tool}
Graph Editing

Basic editing operations are available for the graph. The elements shown in the graph can be edited by choosing "Properties" from the context menu of an element. Elements can be copied, cut, pasted, and deleted using the corresponding context menu items.

New elements can be created either by choosing one of the items below the "New" context menu entry or by using the element creation tool provided in the tool bar of the graph visualization page.

Figure 7.5. Feature/Family Model Element Creation Tools

Graph Printing

Printing of a graph is performed by choosing the File -> Print menu item. The graph is printed in the current layout.

Note

Printing is only available on Windows operating systems.

Element Properties Dialog

The properties dialog for an element contains a General, Relations, Attributes, Restrictions, and Constraints page.

General Page

This page configures the general properties of a model element. According to the model type the available element properties differ (see Figure 7.6, “Family Model Element Properties”).
The following list describes the properties that are always available.

**Unique ID**
The unique identifier for the model element. This identifier is generated automatically and cannot be changed. Every Feature Model element has to have a unique identifier.

**Unique Name**
The unique name for the model element. The name must not begin with a numeric character and must not contain spaces. The uniqueness of the name is automatically checked against other elements of the same model. The unique name can be used to identify elements instead of their unique identifier. Unique names are required for each feature, but not for other model elements. The Unique name is displayed by default (in brackets if the visible name is also displayed).

**Visible Name**
The informal name for the model element. This name is displayed in views by default. This name can be composed of any characters and doesn't have to be unique.

**Class/Type**
The class and type of the model element. In feature models elements can only have class `ps:feature`. Thus the element class for features cannot be changed. Elements in Family Models can have one of the following classes: `ps:component`, `ps:part`, or `ps:source`. The root element of a family model always has the class `ps:family`. The type of a model element is freely selectable.

**Variation Type**
The Variation type of a model element. The variation type specifies, which selection group applies to the element. One of "mandatory", "optional", "alternative", or "or" can be selected.

**Range**
For variation type "or" it is possible to specify the number of features / family elements that have to be selected in a valid configuration in terms of a range expression. These range expressions can either be a number, e.g. 2, or an inclusive number range given in
square brackets, e.g. \([1,3]\), or a set of number ranges delimited by commas, e.g. \([1,3], [5, 8]\). The asterisk character \(*\) or the letter \(n\) may be used to indicate that the upper bound is equal to the number of elements in the Or group.

**Default Selected**

This property defines the default selection state of a model element. Default selected elements are selected implicitly if the parent element is selected. To deselect this element either the parent has to be deselected or the element itself has to be excluded by the user or the auto resolver. Note, that by default the default selection state is disabled for features and enabled for family elements.

**Description**

The description of the model element. For formatted text editing see Section 7.5.1, “Common Properties Page”. The description field is also available on the other pages.

**Relations Page**

This page allows definition of additional relations between an element and other elements, such as features or components (see Figure 7.7, “Element Relations Page”). Typical relations between features, such as requires or conflicts, can be expressed using a number of built-in relationship types. The user may also extend the available relationship types. More information on element relations can be found in Section 5.2.3, “Element Relations”.

![Figure 7.7. Element Relations Page](image)

**Attributes Page**

Every element may have an unlimited number of associated attributes (name-value pairs).

The attributes page uses a table of trees to visualize the attribute declaration (root row) and optional attribute value definitions (child rows).

Each attribute has an associated Type and may have any number of Value definitions associated with it. The values must be of the specified Type. The number of attribute value definitions is shown in the \# column. In the example in Figure 7.8, “Sample attribute definitions for a feature”, the attribute DemoAttribute has two value definitions (1 and 0).
Attributes can be *inherited* from parent elements. Checking the inheritable cell (column icon \( \mathbb{F} \)) in the parent elements Attribute page does this. An inherited attribute may be overridden in a child element by defining a new attribute with the same name as the inherited attribute. The new attribute may or may not be inheritable as required.

Attributes can be *fixed* by checking the cell in the \( \mathbb{F} \) column. Fixed attributes are calculated from value definitions in the model in which they are declared, in contrast to non-fixed attributes for which the value is specified in a VDM. Default values can be (optionally) defined here for non-fixed attributes. These are used if no value is specified in the VDM.

An attribute may have a restricted availability. This is indicated by a check mark in the \( \mathbb{F} \) column. Clicking on a cell in this column activates the Restrictions editor. To restrict the complete attribute definition use the restriction cell in the attribute declaration (root) row. To restrict an attribute value, expand the attribute tree and click into the restriction cell of the value. In the appearing dialog restrictions can either be entered directly into a cell or by using the Restrictions editor. Clicking on the button marked \( \ldots \) which appears in the cell when it is being edited opens this editor. See the section called “Restrictions Page” for detailed information.

During model evaluation, attribute values are calculated in the listed order. The **Move Up** and **Move Down** buttons on the right side of the page can be used to change this order. The first definition with a valid restriction (if any) and a constant, or a valid calculation result, defines the resulting attribute value.

Values can be entered directly into a cell, or by choosing a value from a list (combo box) of predefined values, or by using the Value editor. Clicking on the button marked \( \ldots \) which appears in the cell when it is being edited, opens this editor. The editor also allows the value definition type to be switched between constant and calculation. The calculation type can use the *pvProlog* language to provide more complex value definitions. More information on calculating attribute values is given in the section called “Attribute Value Calculations with pvProlog”.

The name of an attribute can be inserted directly or chosen from a list of attributes defined for the corresponding element type in the pure::variants type model. When choosing an attribute from the list, the attribute type and the fixed state of the attribute are set automatically.
It is also possible to provide attributes which have a configurable collection of values as data type. Each contained value is available in a variant if the corresponding restriction holds true. To use this feature, square brackets ("[]") for list values or curly brackets ("{}") for set values have to be appended to the data type of the attribute in column **Type**, e.g. `ps:string{}` , `ps:boolean{}` , or `ps:integer{}`.

The use of attributes is covered further in Section 5.2.4, “Element Attributes”.

**Restrictions Page**

The Restrictions page defines element restrictions. Any element that can have restrictions can have any number of them. A new restriction can be created using the **Add** button. An existing restriction can be removed using **Remove**. Restrictions are OR combined and evaluated in the given order. The order of the restrictions may be changed using the **Move Up** and **Move Down** buttons on the right side of the page.

**Figure 7.9. Restrictions page of element properties dialog**

For each restriction a descriptive name can be specified. It has no further meaning other than a short description of what the restriction checks. A restriction can be edited in place using the cell editor (shown in the right side of figure Figure 7.9, “Restrictions page of element properties dialog”). Note the difference in restriction #1 in the left and right sides of the figure. Unless they are being edited, the element identifiers in restrictions are shown as their respective Visible names (e.g. 'Wind Speed Sensor) when available. When the editor is opened the unique name is shown (e.g. 'WindSpeed'), and no element identifier substitution takes place. The ... button opens an advanced editor that is more suitable for complex restrictions. This editor is described more detailed in the section called “Advanced Expression Editor”.

**Constraints Page**

The Constraints page defines model constraints. Any element that can have constraints can have any number of them. A new constraint can be created using the **Add** button. An existing constraint can be removed using **Remove**. The order of constraints may be changed using the **Move Up** and **Move Down** buttons on the right side of the page. This has no effect on whether a constraint is evaluated or not; constraints are always evaluated.
Figure 7.10. Constraints page of element properties dialog

For each constraint a descriptive name can be specified. It has no further meaning other than a short description of what the constraint checks. A constraint can be edited in place using the cell editor (shown in the right side of figure Figure 7.10, “Constraints page of element properties dialog”). The ... button opens an advanced editor dialog that is more suitable for complex constraints. This editor is described more detailed in the section called “Advanced Expression Editor”.

Advanced Expression Editor

The advanced expression editor is used everywhere in pure::variants where more complex expressions may be inserted. This is for instance when writing more complex restrictions, constraints, or calculations.

Currently it supports the two languages *pvProlog* and *pvSCL*. Special editors are available for both languages. Figure 7.11, “Advanced pvSCL expression editor” shows the *pvSCL* editor editing a constraint.
Figure 7.11. Advanced pvSCL expression editor

This dialog supports syntax highlighting for pvSCL keywords and auto completion for identifiers. There are two forms of completion. Pressing CTRL+SPACE while typing in an identifier opens a list with matching model elements and pvSCL keywords as shown in the figure. If the user enters "<ModelName>." or "@<ModelId>/" a list with the elements of the model is opened automatically. When pressing CTRL+SPACE the opened list contains all kind of proposals: models, elements and operations, if there is no context information available. Therefore an typing of "" opens the list with only elements contained. When then one of the elements is selected, the full qualified name of the element is inserted into the code, i.e. "<ModelName>.<ElementName>". There is always a special entry at the end of such a list, "Open Element Selection Dialog...", which opens the Element Selection dialog supporting better element selection. This dialog is described more detailed in the section called “Element Selection Dialog”.

Warning

The pvSCL syntax is not checked in this editor. A syntactically wrong expression will cause the model evaluation to fail.

Figure 7.12, “Advanced pvProlog expression editor” shows the pvProlog editor directly editing a constraint expression.
Pressing **CTRL+SPACE** in this editor opens the element selection dialog. All element identifiers selected in this dialog are inserted into the expression as quoted strings. This dialog is described more detailed in the section called “Element Selection Dialog”.

**Warning**

The *pvProlog* syntax is not checked in this editor. A syntactically wrong expression will cause the model evaluation to fail.

**Figure 7.13. “pvProlog expression pilot”** shows the *pvProlog* editor editing a constraint in the expression pilot. In contrast to the *pvProlog* source editor the pilot always produces syntactically correct *pvProlog* code.
A *pvProlog* function can be inserted into the expression by pressing on button "New" or choosing Add->New from the context menu. The inserted function can be changed by choosing another function in field "Operator". The argument of the function is added by pressing on button ". . ." next to field "Value". If the check button "Use Unique Name" is checked, the unique name of the selected element is inserted as argument. Otherwise the id of the selected element is inserted.

An operator can be added by choosing the corresponding operator from the Add context menu entry. To change an operator the context menu entry "Change to" is used. The "Negate" button adds a "NOT" operator on top of the selected function or operator.

A selected function or operator can be removed by pressing button "Remove". The "Move up" and "Move down" buttons are used to move operands up or down (for instance to swap operands).

The resulting *pvProlog* source code for the constructed expression is shown in the bottom half of the editor.

**Element Selection Dialog**

The element selection dialog (figure Figure 7.14, “Element selection dialog”) is used in most cases when a single element or a set of elements has to be selected, e.g. for choosing the relation target elements when inserting a new relation. The left pane lists the potentially available elements, the right pane lists the selected elements. To select additional elements, select them in the left pane and press the button &=&>. Multiple selection is also supported. To remove elements from the selection, select them in the right pane and use the button <==. 

---

**Figure 7.13. pvProlog expression pilot**

![pvProlog expression pilot](image-url)
Figure 7.14. Element selection dialog

The model selection and filter fields in the lower part of the dialog control the elements that are shown in the left Label field. By default, all elements for all models within the current project are shown. If a filter is selected, then only those elements matching the filter are shown. If one or more models are selected, then only elements of the selected models are visible. If the scope is set to Workspace then all models from the current workspace are listed. The model selection is stored, so for subsequent element selections the previous configuration is used.

Tip

The element information shown in the left and right Label fields is configurable. Use Table Layout->Change... from the context menu to select and arrange the visible columns. See the section called "Table Editing Page" for additional information on table views.

7.3.2. Feature Model Editor

Every open Feature Model is shown in a separate Feature Model editor tab in Eclipse. This editor is used to add new features, to change features, or to remove features. Variant configuration is not possible using this editor. Instead, this is done in a variant description model editor (see Section 7.3.4, “Variant Description Model Editor” and Section 4.4, “Using Configuration Spaces” for more information).

The default page of a Feature Model Editor is the tree-editing page. The root feature is shown as the root of the tree and child nodes in the tree denote sub-features. The icon associated with a feature shows the relation of that feature to its parent feature (see Table 9.4, “Element variation types and its icons”).
Some keyboard shortcuts are supported in addition to mouse gestures (see Section 9.12, “Keyboard Shortcuts”).

Creating and Changing Features

Whenever a new Feature Model is created, a root feature of the same name is automatically created and associated with the model.

Additional sub-features may be added to an existing feature using the New context menu item. This opens the New Feature wizard (see Figure 7.16, “New Feature wizard”) where the user must enter a unique name for the feature and may enter other information such as a visible name or some feature relations. All feature properties can be changed later using the Property dialog (context menu entry Properties, see the section called “Changing feature properties”).

A feature may be deleted from the model using the context menu entry Delete. This also deletes all of the feature's child features.

Cut, copy and paste commands are supported to manipulate sub-trees of the model. These commands are available on the Edit menu, the context menu of an element and as keyboard shortcuts (see Section 9.12, “Keyboard Shortcuts”).
Figure 7.16. New Feature wizard

Changing feature properties

Feature properties, other than a feature’s Unique Identifier, may be changed using the Property dialog. This dialog is opened by double-clicking the feature or by using the context menu item Properties (see Figure 7.17, “Feature Model Element Properties”).
See the section called “Element Properties Dialog” for more information about the dialog.

### 7.3.3. Family Model Editor

The Family Model Editor shows a tree view of the components, parts, and source elements of a solution space. Each element in the tree is shown with an icon representing the type of the element (see Table 9.8, “Predefined part types”). The element may additionally be decorated with the restriction sign if it has associated restriction rules. For more information on Family Model concepts see Section 5.4, “Family Models”.

![Feature Model Element Properties](image)
7.3.4. Variant Description Model Editor

The VDM Editor is used to specify the configuration of an individual product variant. This editor allows the user to make and validate element selections, to set attribute values, and to exclude model elements from the configuration.

In this editor there are two tree views, one showing all feature models in the Configuration Space and another showing all family models in the Configuration Space.

Element Selection

A specific model element can be explicitly included in the configuration by marking the check box next to the element. Additional editing options are available in the context menu. For instance, there are menu entries for deselecting or excluding one or whole sub-trees of elements. It is not supported to make a selection for two elements with the same unique name of models with the same name.

Elements may also be selected automatically, e.g. by the Auto Resolver enabled by pressing button. However, the context menu allows the exclusion of an element; this prevents the Auto Resolver from selecting the element.

Each selected element is shown with an icon indicating how the selection was made. The different types of icons are documented in Table 9.5, “Types of element selections”. If the user selects an element that has already been selected automatically its selection type becomes user selected and only the user can change the selection.

When the icon is shown instead of the selection icon, the selection of the element is inadvisable since it will probably cause a conflict.

Attribute Overriding

The value of non-fixed attributes is specified in the VDM. Therefore, the Variant Description Model Editor allows to change non-fixed attributes. There are three possibilities:
• with the Properties view (see Section 7.4.6, “Properties View”)

• with the Attributes view (see Section 7.4.1, “Attributes View”)

• with the cell editors of the Variant Description Model Editor itself

Only the first possibility will be explained in detail. The other two possibilities are similar to the first.

First make sure the VDM editor displays attributes (use context menu Table Layout -> Attributes). Next, double-click on the attribute you would like to specify a value for. A cell editor opens and a text can be entered for the attribute or pressing the ... button opens the Value editor dialog. The given value will be applied with a click somewhere else in the tree.

**Figure 7.19. Specifying an attribute value in VDM with cell editor**

For list and set attributes a special dialog appears when editing attribute values in VDMs. The dialog contains a text field with each line representing one attribute value.

Attributes of grey color mean that there is currently no value set for the attribute and that the default value of the attribute is taken from the associated Feature or Family Model. If no value is specified in VDM for an attribute with default value then a warning will be shown, calling attention to that issue. Attributes with no value in VDM and no default value will produce an error during evaluation.

**Element Selection Outline View**

The outline view of the VDM shows the selected elements with their selection state. You can click on an element to navigate to it in the VDM. This view may be filtered from the views filter icon or context menu.
7.3.5. Variant Result Model Editor

The Variant Result Model Editor (VRM Editor) is used to view a saved Variant Result Model. To open a Variant Result Model, double-click on the corresponding file (suffix `.vrm`) in the Variant Projects View. This opens the editor in the style of the VDM Editor.

A Variant Result Model can not be changed because it already represents a concrete variant. Thus the shown element selection is read-only.

If a Variant Result Model is located below a Configuration Space folder, transformation of the Variant Result Model is possible. The required information for the transformation is taken from the Configuration Space. If no valid transformation configuration is found, the transformation will be rejected. A warning is shown if the models of the Configuration Space do not conform to the models in the Variant Result Model.

Figure 7.21, “VRM Editor with outline and properties view” shows a sample variant result model.
Figure 7.21. VRM Editor with outline and properties view

See Section 5.9.2, “Variant Result Models” for more information about Variant Result Models.

7.3.6. Model Compare Editor

The Model Compare Editor is a special editor provided by pure::variants to view and treat differences between pure::variants models. The behaviour of this editor is very similar to that of the Eclipse text compare editor. For general information about the Eclipse compare capabilities please refer to the Eclipse Workbench User Guide. The Task section contains a subsection Comparing resources which explains the compare action in detail. For more information on the use of the pure::variants Model Compare Editor see Section 6.6, “Comparing Models”.

7.3.7. Matrix Editor

The matrix editor gives an overview of feature selections and attribute values across the variants in a configuration space. The editor is opened by double-clicking on the configuration space icon in the Variant Projects view (see Figure 7.22, “Matrix Editor of a Configuration Space”). The editor may be filtered based on the selection states of features in the individual Variant Description models: one filter shows the features that have not been selected in any model, one filter shows the features that have been selected in all models, and one filter shows the features that have been selected in at least one model. The filters are accessed via the context menu for the editor (Show elements). The general filtering mechanism can also be used to further specify which features are visible (also accessible from the context menu).
The Matrix Editor allows to change selection for each VDM and attribute values per VDM. As for the table the columns of the Matrix Editor can be changed via the same context menu (Table Layout->Change...). Only the first column which shows the Configuration Space relevant Input Models in the order as they would appear for the VDM Editor can not be (re)moved. Note for that column the manner of providing the features. The Matrix Editor supports two ways of representing the features for the Input Models: Flat and Hierarchical. In the flat manner the models are displayed as root elements and all elements flat directly as children of the models. Only the attributes of the elements are located as children of their containing element. In the hierarchical manner the elements are represented as they are in the Variant Description Model Editor that means, they are displayed in their normal tree hierarchy.

In addition the Matrix Editor allows to evaluate the VDMs. This is done with the Evaluate Models button in the editors toolbar, identical to the VDM Editor. Evaluation capability of the Matrix Editor also includes the buttons in the toolbar Enable automatic checking... and Enable auto resolver.... If an evaluation is performed, only the currently visible VDMs are evaluated.

Finally it is even possible to perform transformation of the visible VDMs. Use the Transform all models button to perform transformation. See Section 5.9, “Variant Transformation” for detailed information.
Figure 7.23. Matrix Editor of a Configuration Space

The Matrix shown in the editor can be exported to various output formats using the Export Matrix... action from the context menu. The dialog, which opens, allows the user to choose the output format and location for the export.

The action exports the visible content of the matrix editor, it does even take the expansion state of an element into account. Meaning collapsed elements and attributes will not be visible in the export result. As well as filtered elements and variants not opened in the editor.

In the dialog a custom report template can be selected. As a starting point we recommend to use the standard report template, which can be saved with the Save Report Template... After customizing the report template, it can be used for future matrix exports.

**Note**

The template contains a table, which is named "Matrix". This table is the entry point for the matrix exporter. The table can be modified, but there has to be a variant column, which defines the layout for the columns inserted by the exporter. Which column is the variant column is defined with a user property on the table. Name of the property is "VariantColumn", type is integer. The value is the index of the variant column. The index is 0 based, so third column has index 2. This column is replaced by the exporter with the necessary variant columns.

### 7.4. Views

#### 7.4.1. Attributes View

The attributes view shows for a VDM the available attributes of the associated Feature and Family Models. The user can set the value of non-fixed attributes in this view by clicking in the Value column of an attribute. If no value is set for an attribute then the value set in the associated Feature / Family Model is shown in grey in the Value column. This view may also be filtered to show only the attributes of selected features and/or where no value has been set.
7.4.2. Visualization View

The model editors and most of the views support named layouts and filters. The Visualization view shows all named layouts and named filters defined in the current Eclipse workspace (see Figure 7.25, “Visualization view (left) showing 2 named filters and 2 named layouts”).

Figure 7.25. Visualization view (left) showing 2 named filters and 2 named layouts
When the Visualization view is opened, the first level of layouts and filters is expanded. To expand or collapse the visualizations manually use the "Expand.." and "Collapse.." buttons in the tool bar of the view. Additional filters and layouts may be imported from a file by choosing "Import" from the context menu. To export all visualizations listed in the Visualization view choose "Export" from the context menu. Exported visualizations are stored in a file which can be imported into another Eclipse installation or shared in the project's team repository. Visualizations can be applied either by double clicking on the name of the visualization or by choosing "Apply Item" from the context menu of a visualization. Other actions on visualizations are Delete and Rename by choosing the corresponding context menu entries.

Three top-level categories are available in the visualization view. These are Filters, Table Layouts and Tree Layouts. The corresponding items can only be created in the editors. See the section called “Table Editing Page”, the section called “Tree Editing Page” and Section 6.9, “Filtering Models” for information on it. Tree Layouts can only be applied to Editors Tree Viewers, Table Layouts to Editors Table Viewers and Filters to all pure::variants Model Editors. Note that some filters may not work as expected on different models. For example a Variant Model Filter, filtering on selections will not work for a Feature Model Editor.

Additionally the layout and filter items may be organized within categories. Layouts or filters, created once appear at first directly below their top-level category. The view allows to create a category by choosing "Create Category..." from the context menu on a parent Category. The context menu provides an action "Move To" on an item selection, which allows to move it to any desired category.

7.4.3. Search View

Feature and Family Models can be searched using the Variant Search dialog. The Variant Search view shows the result of this search and is opened automatically when the search is started. The search results are listed in a table or in a tree representation.

The tree representation structures the search results in a simple tree. The first level of the tree lists the models containing matches. On the second level the matched elements are listed. The next levels finally list the matched attributes, attribute values, restrictions, and constraints.

Figure 7.26. Variant Search View (Tree)

Behind every element in the tree that is a root element of a sub-tree the number of matches in this sub-tree is shown. Double-clicking on an item in the tree opens the corresponding model in an editor with the corresponding match selected. The search results can be sorted alphabetically using the button "Sort by alphabet" in the tool bar of the Search view.

By pressing button "Switch to Table" the table representation of the search results is enabled. The table shows the matched model items in a flat list. Double-clicking on an item in the list opens the corresponding model in an editor with the corresponding match selected. The search results can be sorted alphabetically by clicking on the "Label" column title.
A search result history is shown when the button "Show Previous Searches" in the tool bar of the search view is pressed. With this history previous search results can be easily restored. The history can be cleared by choosing "Clear History" from the "Show Previous Searches" drop down menu. Single history entries can be removed using the "Remove" button in the Previous Searches dialog.

**Note**

The history for many consecutive searches with a lot of results may lead to high memory consumption. In this case clear the whole history or remove single history entries using the Previous Searches dialog.

A new search can be started by clicking on button "Start new Search".

For more information about how to search in models using the Variant Search see Section 6.7, "Searching in Models".

### 7.4.4. Outline View

The Outline view shows information about a model and allows navigation around a model. The outline view for some models has additional capabilities. These are documented in the section for the associated model editor.

### 7.4.5. Problem View/Task View

pure::variants uses the standard Eclipse Problems View to indicate problems in models. If more than one element is causing a problem, clicking on the problem selects the first element in the editor. For some problems a Quick Fix (see context menu of task list entry) may be available.

### 7.4.6. Properties View

pure::variants uses the standard Eclipse Properties View. This view shows important information about the selected object and allows editing of most property values. To open the view chose menu Window->Show View->Properties.
Figure 7.28. Properties view for a feature

Figure 7.28, “Properties view for a feature” shows the properties view after a feature was selected in the Feature Model Editor. At the left side there are selectable tabs, each containing a set of properties that logically belong together. Usually, tabs General and Description are shown. The middle area of the properties view presents the properties for the active tab.

The properties view depends on the selection in the workbench made by the user. For instance, selecting a family element like a component allows to edit unique and visible names, whereas for a selected relation the type and the relation targets can be changed in the General tab. At the moment, general properties of elements, relations, attributes, attribute values and restrictions can be modified and each of them can have descriptions given in the Description tab (see Figure 7.29, “Description tab in Properties view for a relation”).

Figure 7.29. Description tab in Properties view for a relation

Properties that are edited won't be applied until the edited field loses the input focus or the ENTER key is pressed. That allows you to discard the current change in a text field with the ESCAPE key if you like.

If a VDM Editor is active in the workbench and an attribute of the variant is selected then the properties view allows to define the value of the attribute for that variant.

Figure 7.30. Properties view for a variant attribute
For the visible name of features and family elements as well as for descriptions it is possible to specify text in different languages. See Section 6.12, “Using Multiple Languages in Models” for more information about language support. For formatted text editing of descriptions see Section 7.5.1, “Common Properties Page”.

### 7.4.7. Relations View

The Relations view shows the relations of the currently selected element (feature/component/part/source element) to other elements. The relations shown in the view are gathered from different locations. The basic locations are:

- **Model Structure**: From the model structure, the relations view gathers information about the parent and child elements of an element.

- **Element Relations**: From the relations defined on an element, the relations view gathers information about the elements depending on the selected element according to the defined relations. Related elements can be elements from the same model or from other models. If a relation to an element of another model cannot be resolved, it may be necessary to explicitly open the other model to let the relations view resolve the element.

- **Restrictions**: From the restrictions defined on an element or on a relation, property, or property value of the element, the relations view gathers information about the elements referenced in these restrictions. According to the language used to formulate the restriction, i.e. pvProlog or pvSCL, the relations view shows the referenced elements below the entry "Prolog Script" or "Simple Constraint Language".

- **Constraints**: From the constraints defined on an element, the relations view gathers information about the elements referenced in these constraints. According to the language used to formulate the constraint, i.e. pvProlog or pvSCL, the relations view shows the referenced elements below the entry "Prolog Script" or "Simple Constraint Language".

- **Element Properties**: From the properties of an element, the relations view gathers information about mapped features. For this purpose there must be a property with the value type "ps:feature". Mapped features can be elements from the same model or from other models. If the mapped feature is an element of another model, it may be necessary to explicitly open the other model to let the relations view resolve the element.

The relations view can be extended to view other relations than the basic relations described above. Please see the pure::variants Extensibility Guide for more information about extending the relations view.

Double-clicking on a related element shown in the Relations View selects that element in the editor. The small arrow in the lower part of the relation icon shows the direction of the relation. This arrow always points from the relation source to the relation destination. For some relations the default icon ⊘ is shown. The number in parentheses shown after an element's name is the count of child relations. So, in the figure below the element has one requires relation indicated by (1).
Figure 7.31. Relations view (different layouts) for feature with a `ps:requires` to feature 'Main Component Big'

The Relations view is available in four different layout styles: two tree styles combined with two table styles. These styles are accessed via icons or a menu on the Relations view toolbar.

The relations view supports filtering based on relation types. To filter the view use the Filter Types menu item from the menu accessible by clicking on the down arrow icon in the view's toolbar.

Attribute values of type "ps:url" are shown as links to external documents in the relations view. A double-click on the appropriate entry opens the assigned system application for the referenced URL.

7.4.8. Result View

The result view shows the results of model evaluation after a selection check has been performed. It lists all selected feature and Family Model elements representing the given variant.

The result view also provides a special operation mode where, instead of a result, the difference (delta) between two results are shown, similar to the model compare capability for Feature and Family Models.

Toolbar icons allow the view to be shown as a tree or table ( ), allow the sort direction to be changed ( ), and control activation/deactivation of the result delta mode ( ).

Filtering is available for the linear (table like) view, ( ). The Model Visibility item in the result view menu (third button from right in toolbar) permits selection of the models to be shown in the result view.

The result view displays a result corresponding to the currently selected VDM. If no VDM is selected, the result view will be empty. The result view is automatically updated whenever a VDM is evaluated.
Figure 7.32. Result View

**Result Delta Mode**

The result delta mode is enabled with the plus-minus button (±) in the result view's toolbar. In this mode the view displays the difference between the current evaluation result and a reference result - either the result of the previous evaluation (default) or an evaluation result set by the user as a fixed reference. In the first case, the reference result is updated after each evaluation to become the current evaluation result. The delta is therefore always calculated from the last two evaluation results. In the second case the reference result does not change. All deltas show the difference between the current result and the fixed reference result.

The fixed reference can be either set to the current result or can be loaded from a previously saved variant result (.vrm file). The reference result is set from the result view menu (third button from right in toolbar). To set a fixed result as reference use Set current result as reference. To load the reference from a file use Load reference result from file. To activate the default mode use Release reference result. The Switch Delta Mode submenu allows the level of delta details shown to be set by the user.
Figure 7.33. Result View in Delta Mode

Icons are used to indicate if an element, attribute or relation was changed, added or removed. A plus sign indicates that the marked item is only present in the current result. A minus sign indicates that the item is only present in the reference result. A dot sign indicates that the item contains changes in its properties or its child elements. Both old and new values are shown for changed attribute values (left hand side is new, right hand side is old).

7.4.9. Impact View

Variant description models are used to configure variation points in pure::variants. These vdms are connected to a configuration space, which lists all input models. Variation points can be either feature-based or manually configured. The feature-based configuration is used to automatically configure variation points based on selections of features. The feature-based configuration depends directly on the inout models of the configuration space. Changing the input models may have an impact on the existing variation point configurations.

The impact view shows possible impacts on the variant configurations while changing the input models.

To open the Impact View use the Show View -> Impact View action form the Window menu.
After opening the view work on the input models can be started. The impact analysis is disabled by default and needs to be explicitly enabled for each input model, which shall be considered by the impact analysis. To enable the analysis open an input model and click on the *Enable Input Analysis* button. The initial analysis is performed now for all variant models, which use the input model. The impact view shows the state of each variant model after the analysis is done. There are 5 different states:

- ✗ the variant is currently analysed by the impact analysis
- ✔️ the variant is valid and not changed by the input model changes
- 🚫 the variant is valid but changed by the input model changes
- ❌ the variant is invalid
- ✗ ✗ the variant is deactivated

The impact is calculated automatically for every change on the input models, for which the impact analysis is activated. With the ⏸ button the automatic calculation can be paused, if the user is performing a lot of changes and can be resumed after the changes are done. Resetting the impact analysis is triggered with the ⏯ button. This removes the current analysis result and starts a fresh calculation of the impact. The result is the same as enabling the impact calculation the first time on the current state of the input models.
Figure 7.35. Impact Calculation Result

Figure 7.35, “Impact Calculation Result” shows an example result for the impact analysis. If there are problems the result contains details on the problem. The same applies to changes in the variant description models. For changes it is possible to see more details with the action Show in Text Compare from the context menu of one change.

The context menu of the impact view allows the user to change the scope of the impact analysis. The Action Add Variant Models ... allows the user to add additional variant models to the analysis. Remove Variant Model removes the selected models from the impact analysis. Deactivate deactivates the analysis for the selected variant models. This action keeps them in the impact view and just ignores them during calculation.
Navigation from the information shown in the impact view to the corresponding elements or models is enabled using the *Go to ...* action from the context menu or by just double clicking the elements or models in the impact view.

### 7.4.10. Variant Projects View

The Variant Projects View (upper left part in Figure 7.37, “The Variant Projects View”) shows all variant management projects in the current workspace. Projects and folders or models in the projects can be opened in a tree-like representation. Wizards available from the project's context menu allow the creation of Feature Models, Family Models, and Configuration Spaces. Double-clicking on an existing model opens the model editor, usually shown in the upper right part of the perspective. In Figure 7.37, “The Variant Projects View” one editor is shown for a variant description model with some features selected.
7.5. Model Properties

pure::variants models have a set of properties. Each model has at least a name. Optionally it can have an author, version, description, and a set of custom properties. Model properties are set by right-clicking on a model in the \textit{Variant Projects} view and choosing \textit{Properties} from the context menu. Depending on the kind of model and the registered extensions, several property pages are available.

7.5.1. Common Properties Page

The common properties are provided on the \textit{Model} page (see Figure 7.38, “Feature Model Properties Page”).

The common properties of all models are the name, author, version, and description of the model. Additionally the description type can be changed. Available types are plain text and HTML text. Models created with a version lower than 3.0 of pure::variants usually have the plain text type. Setting to HTML text description type allows to format descriptions with styles like bold and italic or with text align like left, center and right (see again Figure 7.38, “Feature Model Properties Page”). For a full set of HTML formatting possibilities open the extended HTML description dialog by pressing the \textit{button in the tool bar of the description field.}
Figure 7.38. Feature Model Properties Page

7.5.2. General Properties Page

Custom model properties are defined on the General Properties page (see Figure 7.39, “General Model Properties Page”).
For each property a name, type, and value has to be specified. Optionally a description can be provided.

New properties are added by clicking on button Add or by double-clicking in the first empty row of the table. Additional attribute values can be added by selecting the property and then clicking on button Add value. To remove a value select it and click on button Remove value. A whole property can be removed by selecting the attribute and clicking on button Remove.

As for element attributes, model properties can also have a list type by simply adding square brackets ("[") to the type name, e.g. ps:string[], ps:integer[].

Special model properties, like the name, author, version, and description of the model usually configured on other model property pages, are not shown in the General Properties list. To include these properties in the list, check option "Include invisible properties in list".

7.5.3. Inheritance Page

The Inheritance page is only available for VDMs. It is used to select the models from which a VDM inherits (see Figure 7.40, “Variant Description Model Inheritance Page”).
The left table shows the models which can be inherited. To avoid inheritance cycles models inheriting from the current model are greyed out and can not be inherited. The right table shows the models from which the current model inherits.

Models can be selected from the current Configuration Space, the current project, and referenced projects. See Section 5.7, “Inheritance of Variant Descriptions” for more information on variant description model inheritance.
Chapter 8. Additional pure::variants Extensions

The features offered by pure::variants may be further extended by the incorporation of additional software extensions. An extensions may just contribute to the Graphical User Interface or it may extend or provide other functionality. For instance an extensions could add a new editor tab for model editors or a new view. The online version of this user guide contains documentation for additional extensions. Printable documentation for the additional extensions is distributed with the extensions and can be accessed from the online documentation via a hyperlink.

Currently available extensions can be found on our web site (https://www.pure-systems.com/products/extensions-304.html)

8.1. Installation of Additional pure::variants Extensions

Additional pure::variants extensions are distributed and installed in several ways:

- **Installation from an Update Site** Installation via the Eclipse update mechanism is a convenient way of installing and updating pure::variants from an internet site. See task "Updating features with the update manager" resp. "Updating and installing software" in the Eclipse Workbench User Guide for detailed information on the Eclipse update mechanism (menu Help -> Help Contents and then Workbench User Guide->Tasks).

  The location of the site depends on the pure::variants product variant. Visit the pure-systems web site (http://www.pure-systems.com) or read your registration e-mail to find out which site is relevant for the version of the software you are using. Open the page in your browser to get information on how to use update sites with Eclipse.

- **Archived Update Site** pure::variants uses also archived update sites, distributed as ZIP files, for offline installation into an existing Eclipse installation.

  Archived update sites are available for download from the pure::variants internet update site. The location of the site depends on the pure::variants product variant. Visit the pure-systems web site (http://www.pure-systems.com) or read your registration e-mail to find out which site is relevant for the version of the software you are using. Open the page in your browser to get additional information on how to use update sites with Eclipse. pure::variants archived update site file names start with *updatesite* followed by an identification of the contents of the update site. The installation process is similar to the internet update site installation.
Chapter 9. Reference

9.1. Element Attribute Types

<table>
<thead>
<tr>
<th>Attribute Type</th>
<th>Description</th>
<th>Allowed Values</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>ps:boolean</code></td>
<td>boolean value</td>
<td>true and false</td>
</tr>
<tr>
<td><code>ps:integer</code></td>
<td>integer number</td>
<td>a valid integer number of format (`'0x' [0-9a-fA-F]+</td>
</tr>
<tr>
<td><code>ps:float</code></td>
<td>floating point number</td>
<td>a valid floating point number of format `[+-]? [0-9]+ ('.' [0-9]+)? ([eE] [+</td>
</tr>
<tr>
<td><code>ps:string</code></td>
<td>any kind of unspecific text</td>
<td>any</td>
</tr>
<tr>
<td><code>ps:path</code></td>
<td>path to a file in a file system</td>
<td>any</td>
</tr>
<tr>
<td><code>ps:directory</code></td>
<td>path to a directory in a file system</td>
<td>any</td>
</tr>
<tr>
<td><code>ps:url</code></td>
<td>a URL or URI</td>
<td>any</td>
</tr>
<tr>
<td><code>ps:html</code></td>
<td>HTML code</td>
<td>any</td>
</tr>
<tr>
<td><code>ps:datetime</code></td>
<td>date and time (e.g. in ISO 8601 format)</td>
<td>any</td>
</tr>
<tr>
<td><code>ps:version</code></td>
<td>a version string (with wildcards)</td>
<td>a string of format [0-9]+ ('.' [0-9]+ ('.' [0-9]+ ('.' [0-9-za-z-]+)+))?</td>
</tr>
<tr>
<td><code>ps:filetype</code></td>
<td>file type identifier</td>
<td>def, impl, misc, app, undefined</td>
</tr>
<tr>
<td><code>ps:insertionmode</code></td>
<td>value type of source element type <code>ps:fragment</code></td>
<td>before and after</td>
</tr>
<tr>
<td><code>ps:element</code></td>
<td>feature or family model element reference</td>
<td>a valid ID of an element</td>
</tr>
<tr>
<td><code>ps:feature</code></td>
<td>feature reference</td>
<td>a valid ID of a feature</td>
</tr>
<tr>
<td><code>ps:class</code></td>
<td><code>ps:class</code> source element reference</td>
<td>a valid ID of a <code>ps:class</code> source element</td>
</tr>
</tbody>
</table>

9.2. Element Relation Types

Relations can be defined between the element containing the relation on one side and all other elements of the same or other models on the other side. In the following table, showing the supported element relations, the defining element $D$ is the element on which the relation is defined, and $EL$ is the list of related elements $E_1 \ldots E_n$.

Note

Users can use their own custom relation types, which are ignored during evaluation. Some of the supported and thus evaluated relation types exist only since a specific release version of pure::variants. In previous versions they are treated as customer relations and are not evaluated at all. So, using models containing such relations in previous versions of pure::variants, which does not support them yet, can lead to invalid variant configurations. To avoid this source of error, the user is responsible to ensure that these models are not used in previous versions. One possibility for that is to add a pvSCL version guard constraint in each feature or family model, which uses such a new relation. See the section called “pv:PVVersion()” for that.
<table>
<thead>
<tr>
<th>Relation</th>
<th>Description</th>
<th>Logical equivalent</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>ps:requires(EL)</code></td>
<td>At least one element in <code>EL</code> has to be selected if the defining element is selected.</td>
<td>(D \implies (E_1\ or\ ...\ or\ E_n))</td>
</tr>
<tr>
<td><code>ps:requiresAll(EL)</code></td>
<td>All elements in <code>EL</code> have to be selected if the defining element is selected.</td>
<td>(D \implies (E_1\ and\ ...\ and\ E_n))</td>
</tr>
<tr>
<td><code>ps:requiredFor(EL)</code></td>
<td>If at least one element in <code>EL</code> is selected, then the defining element has to be selected.</td>
<td>((E_1\ or\ ...\ or\ E_n) \implies D)</td>
</tr>
<tr>
<td><code>ps:requiredForAll(EL)</code></td>
<td>If all elements in <code>EL</code> are selected, then the defining element has to be selected.</td>
<td>((E_1\ and\ ...\ and\ E_n) \implies D)</td>
</tr>
<tr>
<td><code>ps:conditionalRequires(EL)</code></td>
<td>Similar to <code>ps:requires</code>, but the relation is considered only for elements whose parent element is selected.</td>
<td>(D \implies ((parentSel(E_1) \implies E_1)\ or\ ...\ or\ (parentSel(root) = true)))</td>
</tr>
<tr>
<td><code>ps:recommends(EL)</code></td>
<td>Like <code>ps:requires</code>, but not treated as error if not complied.</td>
<td>(D \implies (E_1\ or\ ...\ or\ E_n))</td>
</tr>
<tr>
<td><code>ps:recommendsAll(EL)</code></td>
<td>Like <code>ps:requiresAll</code>, but not treated as error if not complied.</td>
<td>(D \implies (E_1\ and\ ...\ and\ E_n))</td>
</tr>
<tr>
<td><code>ps:recommendedFor(EL)</code></td>
<td>Like <code>ps:requiredFor</code>, but not treated as error if not complied.</td>
<td>((E_1\ or\ ...\ or\ E_n) \implies D)</td>
</tr>
<tr>
<td><code>ps:recommendedForAll(EL)</code></td>
<td>Like <code>ps:requiredForAll</code>, but not treated as error if not complied.</td>
<td>((E_1\ and\ ...\ and\ E_n) \implies D)</td>
</tr>
<tr>
<td><code>ps:equalsAny(EL)</code></td>
<td>If the defining element is selected, at least one element in <code>EL</code> has to be selected. If the defining element is not selected, none of the elements in <code>EL</code> may be selected.</td>
<td>(D \implies (E_1\ or\ ...\ or\ E_n))</td>
</tr>
<tr>
<td>(available since pure::variants 4.0.7)</td>
<td>If the defining element is selected, all elements in <code>EL</code> have to be selected. If the defining element is not selected, not all of the elements in <code>EL</code> may be selected.</td>
<td>(D \implies (E_1\ and\ ...\ and\ E_n))</td>
</tr>
<tr>
<td><code>ps:equalsAll(EL)</code></td>
<td>If the defining element is selected, all elements in <code>EL</code> have to be selected. If the defining element is not selected, not all of the elements in <code>EL</code> may be selected.</td>
<td>(D \implies (E_1\ or\ ...\ or\ E_n))</td>
</tr>
<tr>
<td>(available since pure::variants 4.0.7)</td>
<td>If all element in <code>EL</code> are selected, then the defining element must not be selected.</td>
<td>((E_1\ and\ ...\ and\ E_n) \implies not(D))</td>
</tr>
<tr>
<td><code>ps:conflicts(EL)</code></td>
<td>If any element in <code>EL</code> is selected, then the defining element must not be selected.</td>
<td>((E_1\ or\ ...\ or\ E_n) \implies not(D))</td>
</tr>
<tr>
<td><code>ps:conflictsAny(EL)</code></td>
<td>Like <code>ps:conflicts</code>, but not treated as error if not complied.</td>
<td>((E_1\ and\ ...\ and\ E_n) \implies not(D))</td>
</tr>
<tr>
<td><code>ps:discourages(EL)</code></td>
<td>Like <code>ps:conflicts</code>, but not treated as error if not complied.</td>
<td>((E_1\ and\ ...\ and\ E_n) \implies not(D))</td>
</tr>
<tr>
<td><code>ps:discouragesAny(EL)</code></td>
<td>Like <code>ps:conflictsAny</code>, but not treated as error if not complied.</td>
<td>((E_1\ or\ ...\ or\ E_n) \implies not(D))</td>
</tr>
<tr>
<td><code>ps:influences(EL)</code></td>
<td>The elements in <code>EL</code> are influenced in some way by the selection of the defining element. The interpretation of the influence is up to the user.</td>
<td>-</td>
</tr>
<tr>
<td><code>ps:provides(EL)</code></td>
<td>The “inverse” relation to <code>ps:requires</code>. For all selected elements in <code>EL</code> at least one defining element has to be selected.</td>
<td>(E \implies (D_1\ or\ ...\ or\ D_n))</td>
</tr>
</tbody>
</table>
### Table 9.3. Supported Relations between Elements (II)

<table>
<thead>
<tr>
<th>Relation</th>
<th>Description</th>
<th>Use for</th>
<th>Partner relation</th>
</tr>
</thead>
<tbody>
<tr>
<td>\textit{ps:supports(EL)}</td>
<td>Like \textit{ps:provides}, but not treated as error if not complied.</td>
<td></td>
<td>\textit{E implies (D_1 \text{ or } ... \text{ or } D_n)}</td>
</tr>
<tr>
<td>\textit{ps:exclusiveProvider(id)}</td>
<td>In a valid configuration at most one \textit{exclusiveProvider} or one set of \textit{sharedProvider} for a given id is allowed. Thus, the relation defines a mutual exclusion relation between elements.</td>
<td>Concurrent implementations for an abstract concept.</td>
<td>\textit{ps:requestsProvider}</td>
</tr>
<tr>
<td>\textit{ps:sharedProvider(id)}</td>
<td>In a valid configuration at most one \textit{exclusiveProvider} or one set of \textit{sharedProvider} for a given id is allowed. Thus, the relation defines a mutual exclusion relation between elements.</td>
<td>Shared implementations for an abstract concept.</td>
<td>\textit{ps:requestsProvider}</td>
</tr>
<tr>
<td>\textit{ps:requestsProvider(id)}</td>
<td>In a valid configuration for each \textit{requestsProvider} with the given id there must be an \textit{exclusiveProvider} or any number of \textit{sharedProvider} with the same id. There may be any number of \textit{requestsProvider} relations for the same id.</td>
<td>Request existence of an abstract concept.</td>
<td>\textit{ps:exclusiveProvider}</td>
</tr>
<tr>
<td>\textit{ps:expansionProvider(id)}</td>
<td>In a valid configuration at most one \textit{expansionProvider} for a given id is allowed. Thus, the relation defines a mutual exclusion relation between elements.</td>
<td>Provides mechanism for implementing variation points with default solution.</td>
<td>\textit{ps:defaultProvider}</td>
</tr>
<tr>
<td>\textit{ps:defaultProvider(id)}</td>
<td>If an element marked as \textit{expansionProvider} is additionally marked as \textit{defaultProvider} for the same given id and there is more than one possible element claiming to be an \textit{expansionProvider} for this id, then all \textit{defaultProvider} are excluded. If there are more than one \textit{defaultProvider} selected and no non-\textit{defaultProvider} selected, one \textit{defaultProvider} must be chosen manually.</td>
<td>Provides mechanism for implementing variation points with default solution.</td>
<td>\textit{ps:expansionProvider}</td>
</tr>
</tbody>
</table>

### 9.3. Element Variation Types

#### Table 9.4. Element variation types and its icons

<table>
<thead>
<tr>
<th>Short name</th>
<th>Variation Type</th>
<th>Description</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>mandatory</td>
<td>\textit{ps:mandatory}</td>
<td>A mandatory element is implicitly selected if its parent element is selected.</td>
<td>![Icon]</td>
</tr>
<tr>
<td>optional</td>
<td>\textit{ps:optional}</td>
<td>Optional elements are selected independently.</td>
<td>![Icon]</td>
</tr>
</tbody>
</table>
### 9.4. Element Selection Types

#### Table 9.5. Types of element selections

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>User</td>
<td>Explicitly selected by the user. Auto resolver will never change the selection state of a user selected element.</td>
<td>![checkmark]</td>
</tr>
<tr>
<td>Auto resolved</td>
<td>An element selected by the auto resolver to correct problems in the element selection. Auto resolver may change the state of an auto resolved element but does not deselect these elements when the user changes an element selection state.</td>
<td>![checkmark]</td>
</tr>
<tr>
<td>Mapped</td>
<td>The auto resolver detected a valid feature-mapping request for this feature in a feature map and in turn selected the feature. The feature mapping selection state is automatically changed/rechecked when the user changes the element selection.</td>
<td>![checkmark]</td>
</tr>
<tr>
<td>Implicit</td>
<td>All elements from the root to any selected element and mandatory elements below a selected element are implicitly selected if not selected otherwise.</td>
<td>![checkmark]</td>
</tr>
<tr>
<td>Excluded</td>
<td>The user may exclude an element from the selection process (via a context menu). When the selection of an excluded or any child element of an excluded element is required, an error message is shown.</td>
<td>![error]</td>
</tr>
<tr>
<td>Auto Excluded</td>
<td>An element excluded by the auto resolver to correct conflicts. When the selection of an excluded or any child element of an excluded element is required, an error message is shown.</td>
<td>![error]</td>
</tr>
<tr>
<td>Non-Selectable</td>
<td>For a specific element selection the auto resolver may recognize elements as non-selectable. This means, selection of these elements always results in an invalid element selection. For other element selections these elements may not non-selectable.</td>
<td>![error]</td>
</tr>
</tbody>
</table>

### 9.5. Predefined Source Element Types

#### Table 9.6. Predefined source element types

<table>
<thead>
<tr>
<th>Source Type</th>
<th>Description</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>ps:dir</code></td>
<td>Maps directly to a directory.</td>
<td>![folder]</td>
</tr>
<tr>
<td><code>ps:file</code></td>
<td>Maps directly to a file.</td>
<td>![file]</td>
</tr>
<tr>
<td><code>ps:fragment</code></td>
<td>Represents a file fragment to be appended to another file.</td>
<td>![file]</td>
</tr>
<tr>
<td><code>ps:transform</code></td>
<td>Describes an XSLT script transformation of a document.</td>
<td>![file]</td>
</tr>
<tr>
<td><code>ps:condxml</code></td>
<td>Maps directly to an XML document containing variation points (conditional parts) using XPath expressions.</td>
<td>![file]</td>
</tr>
<tr>
<td><code>ps:condtext</code></td>
<td>Maps directly to a text document containing variation points (conditional parts) using XPath expressions.</td>
<td>![file]</td>
</tr>
<tr>
<td><code>ps:pvSCLxml</code></td>
<td>Maps directly to an XML document containing variation points (conditional parts) using pvSCL expressions.</td>
<td>![file]</td>
</tr>
</tbody>
</table>
The following sections provide detailed descriptions of the family model source element types that are relevant for the standard transformation (see Section 6.3.2, “Standard Transformation”).

All file-related source element types derived from element type ps:destfile specify the location of a file using the two attributes dir and file. Using the standard transformation the corresponding file is copied from <ConfigSpaceInputDir>/<dir>/<file> to <ConfigSpaceOutputDir>/<dir>/<file>. Source element types derived from ps:srcdestfile optionally can specify a different source file location using the attributes srcdir and srcfile. If one or both of these attributes are not used, the values from dir and file are used instead. The source file location is relative to the <ConfigSpaceInputDir>.

Every description has the following form:

### 9.5.1. aSourceElementType

Attributes: 

```text
attributeName1 [typeName1]
attributeName2? [typeName2]
```

The source element type aSourceElementType has one mandatory attribute named attributeName1 and an optional attribute named attributeName2. The option is indicated by the trailing question mark.

### 9.5.2. ps:dir

Attributes: 

```text
dir [ps:directory]
srcdir? [ps:directory]
```

This source element type is used to copy a directory from the source location to the destination location. All included subdirectories will also copied. The optional attribute srcdir is used for directories that are located in a different place in the source hierarchy and/or have a different name.

### 9.5.3. ps:file

Attributes: 

```text
dir [ps:directory]
file [ps:path]
type [ps:filetype]
srcdir? [ps:directory]
srcref? [ps:path]
```

This source element type is used for files that are used without modification. The source file is copied from the source location to the destination location. The optional attributes srcdir and srcref are used for files that are located in a different place in the source hierarchy and/or have a different source file name.

The value of attribute type should be def or impl when the file contains definitions (e.g. a C/C++ Header) or implementations. For most other files the type misc is appropriate.

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>impl</td>
<td>This type is used for files containing an implementation, e.g. .cc or .cpp files</td>
</tr>
<tr>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>def</td>
<td>This type is used for files containing declarations, e.g. C++ header files. In the context of \texttt{ps:classalias} calculations this information is used to determine the include files required for a given class.</td>
</tr>
<tr>
<td>misc</td>
<td>This type is used for any file that does not fit into the other categories.</td>
</tr>
<tr>
<td>app</td>
<td>This type is used for the main application file.</td>
</tr>
<tr>
<td>undefined</td>
<td>This type is for files for which no special meaning and/or action is defined.</td>
</tr>
</tbody>
</table>

### 9.5.4. \texttt{ps:fragment}

Attributes:

- \texttt{dir [ps:directory]}
- \texttt{file [ps:path]}
- \texttt{type [ps:filetype]}
- \texttt{srcdir? [ps:directory]}
- \texttt{srcfile? [ps:path]}
- \texttt{mode [ps:insertionmode]}
- \texttt{content? [ps:string]}

This source element type is used to append text or another file to a file. The content is taken either from a file if \texttt{srcdir} and \texttt{srcfile} are given, or from a string if \texttt{content} is given. The attribute \texttt{mode} is used to specify the point at which this content is appended to the file, i.e. before or after the child parts of the current node’s parent part are visited. The default value is \texttt{before}.

### 9.5.5. \texttt{ps:transform}

Attributes:

- \texttt{dir [ps:directory]}
- \texttt{file [ps:path]}
- \texttt{type [ps:filetype]}
- \texttt{srcdir? [ps:directory]}
- \texttt{srcfile? [ps:path]}
- \texttt{scriptdir [ps:directory]}
- \texttt{scriptfile [ps:path]}
- \texttt{[scriptparameters]? [ps:string]}

The source element type is used to transform a document using an XSLT script and to save the transformation output to a file. The document to transform is searched in \texttt{<ConfigSpaceInputDir>}/\texttt{<srcdir>}/\texttt{<srcfile>}. The transformation output is written to \texttt{<ConfigSpaceInputDir>}/\texttt{<dir>}/\texttt{<file>}. \texttt{<ConfigSpaceInputDir>}/\texttt{<script\ dir>}/\texttt{<scriptfile>} specifies the location of the XSLT script to use. Any other attributes are interpreted as script parameters and are accessible as global script parameters in the XSLT script initialized with the corresponding attribute values.

### 9.5.6. \texttt{ps:condxml}

Attributes:

- \texttt{dir [ps:directory]}
- \texttt{file [ps:path]}
- \texttt{type [ps:filetype]}
- \texttt{srcdir? [ps:directory]}
- \texttt{srcfile? [ps:path]}
- \texttt{conditionname? [ps:string]}
- \texttt{copycondition? [ps:boolean]}

This source element type is used to copy an XML document and optionally to save the copy to a file. Special conditional attributes on the nodes of the XML document are dynamically evaluated to decide whether this node (and its subnodes) are copied into the result document. The name of the evaluated condition attribute is specified using the attribute \texttt{conditionname} and defaults to \texttt{condition}. If the attribute \texttt{copycondition} is not set to \texttt{false}, the condition attribute is copied into the target document as well.
Note

Before pure::variants release 1.2.4 the attribute names `pv.copy_condition` and `pv.condition_name` were used. These attributes are still supported in existing models but should not be used for new models. Support for these attribute names has been removed in pure::variants release 1.4.

The condition itself has to be a valid XPath expression and may use the XSLT extension functions defined in the following namespaces. Calls to these functions have to be prefixed by the given namespace prefix followed by a colon (":"), e.g. `pv:hasFeature('F')`.

### Table 9.7. Registered XSLT Extensions

<table>
<thead>
<tr>
<th>Namespace Prefix</th>
<th>Namespace</th>
</tr>
</thead>
<tbody>
<tr>
<td>pv</td>
<td><a href="http://www.pure-systems.com/purevariants">http://www.pure-systems.com/purevariants</a></td>
</tr>
<tr>
<td>pvpath</td>
<td><a href="http://www.pure-systems.com/path">http://www.pure-systems.com/path</a></td>
</tr>
<tr>
<td>pvstring</td>
<td><a href="http://www.pure-systems.com/string">http://www.pure-systems.com/string</a></td>
</tr>
<tr>
<td>xmlts</td>
<td><a href="http://www.pure-systems.com/xmlts">http://www.pure-systems.com/xmlts</a></td>
</tr>
<tr>
<td>dynamic</td>
<td><a href="http://exslt.org/dynamic">http://exslt.org/dynamic</a></td>
</tr>
<tr>
<td>math</td>
<td><a href="http://exslt.org/math">http://exslt.org/math</a></td>
</tr>
<tr>
<td>sets</td>
<td><a href="http://exslt.org/sets">http://exslt.org/sets</a></td>
</tr>
<tr>
<td>strings</td>
<td><a href="http://exslt.org/strings">http://exslt.org/strings</a></td>
</tr>
<tr>
<td>datetime</td>
<td><a href="http://exslt.org/dates-and-times">http://exslt.org/dates-and-times</a></td>
</tr>
<tr>
<td>common</td>
<td><a href="http://exslt.org/common">http://exslt.org/common</a></td>
</tr>
<tr>
<td>crypto</td>
<td><a href="http://exslt.org/crypto">http://exslt.org/crypto</a></td>
</tr>
</tbody>
</table>

For a description of the pure::variants XSLT extension functions see Table 9.17, “Extension functions providing model information”. For a description of the EXSLT extension functions see [http://www.exslt.org](http://www.exslt.org).

In the example document given below after processing with an `ps:condxml` transformation, the resulting XML document only contains an introductory chapter if the corresponding feature `WithIntroduction` is selected.

**Example 9.1. A sample conditional document for use with the ps:condxml transformation**

```xml
<?xml version='1.0'?>
<text>
  <chapter condition="pv:hasFeature('WithIntroduction')">  
    This is some introductory text.  
  </chapter>
  This text is always in the resulting xml output.  
</chapter>
</text>
```

A special XML node is supported for calculating and inserting the value of an XPath expression. The name of this node is `pv:value-of` (namespace "pv" is defined as "http://www.pure-systems.com/purevariants"). The expression to evaluate has to be given in the attribute `select`. The `pv:value-of` node is replaced by the calculated value in the result document.
Example 9.2. Example use of pv:value-of

Source document:
<?xml version='1.0'?>
<version xmlns:pv="http://www.pure-systems.com/purevariants">
  <pv:value-of select="pv:getAttributeValue('Version','ps:feature','version')"/>
</version>

Result document:
<?xml version='1.0'?>
<version xmlns:pv="http://www.pure-systems.com/purevariants">
  1.0
</version>

9.5.7. ps:condtext

Attributes:  
dir [ps:directory]  
file [ps:path]  
type [ps:filetype]  
srcdir? [ps:directory]  
srcfile? [ps:path]  
encoding? [ps:encoding]

This source element type is used to copy a text document and optionally to save the copy to a file. Special statements in the text document are evaluated to decide which parts of the text document are copied into the result document, or to insert additional text. If no text document encoding is given, then UTF-8 encoding is assumed.

The statements (macro-like calls) that can be used in the text document are listed in the following table.

<table>
<thead>
<tr>
<th>Macro</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PV:IFCOND(condition)</td>
<td>Open a new conditional text block. The text in the block is included in the resulting text output if the given condition evaluates to true. The opened conditional text block has to be closed by a PV:ENDCOND call.</td>
</tr>
<tr>
<td>PV:IFCONDLN(condition)</td>
<td>This macro can be used after a PV:IFCOND or PV:ELSEIFCOND call. If the condition of the preceding PV:IFCOND or PV:ELSEIFCOND is failed, the condition of this PV:ELSEIFCOND is checked. If it evaluates to true, the enclosed text is included in the resulting text output.</td>
</tr>
<tr>
<td>PV:ELSEIFCOND(condition)</td>
<td>This macro can be used after a PV:IFCOND or PV:ELSEIFCOND call. If the condition of the preceding PV:IFCOND or PV:ELSEIFCOND is failed, the enclosed text is included in the resulting text output.</td>
</tr>
<tr>
<td>PV:ELSEIFCONDLN(condition)</td>
<td>This macro can be used after a PV:IFCOND or PV:ELSEIFCOND call. If the condition of the preceding PV:IFCOND or PV:ELSEIFCOND is failed, the enclosed text is included in the resulting text output.</td>
</tr>
<tr>
<td>PV:ELSECOND</td>
<td>This macro can be used after a PV:IFCOND or PV:ELSEIFCOND call. If the condition of the preceding PV:IFCOND or PV:ELSEIFCOND is failed, the enclosed text is included in the resulting text output.</td>
</tr>
<tr>
<td>PV:ELSECONDLN</td>
<td>This macro can be used after a PV:IFCOND or PV:ELSEIFCOND call. If the condition of the preceding PV:IFCOND or PV:ELSEIFCOND is failed, the enclosed text is included in the resulting text output.</td>
</tr>
<tr>
<td>PV:ENDCOND</td>
<td>Close a conditional text block. The macro is allowed after a PV:IFCOND, PV:ELSEIFCOND, or PV:ENDCOND call.</td>
</tr>
<tr>
<td>PV:ENDCONDLN</td>
<td>Close a conditional text block. The macro is allowed after a PV:IFCOND, PV:ELSEIFCOND, or PV:ENDCOND call.</td>
</tr>
<tr>
<td>PV:EVAL(expression)</td>
<td>Evaluate the given expression and insert the expression value into the result document.</td>
</tr>
<tr>
<td>PV:EVALLN(expression)</td>
<td>Evaluate the given expression and insert the expression value into the result document.</td>
</tr>
</tbody>
</table>

These macros can occur everywhere in the text document and are directly matched, i.e. independently of the surrounding text. The conditions of PV:IFCOND and PV:ELSEIFCOND and the expression of PV:EVAL are the same as the conditions described for source element type ps:condxml (see Section 9.5.6, “ps:condxml” for details).

Conditional text blocks can be nested. That means, that a PV:IFCOND block can contain another PV:IFCOND block defining a nested conditional text block that is evaluated only if the surrounding text block is included in the resulting text output.

For each macro a version with suffix LN exists, i.e. PV:IFCONDLN, PV:ELSEIFCONDLN, PV:ELSECONDLN, PV:ENDCONDLN, and PV:EVALLN. These macros affect the whole line and are only allowed if there is no other macro
call in the same line. All characters before and behind such a macro call are removed from the line. It is allowed
to mix macros with and without suffix LN, e.g. PV:IFCONDLN can be followed by PV:ENDCOND and PV:IFCOND by
PV:ENDCONDLN.

In the example document given below after processing with an `ps:condtext` transformation, the resulting text doc-
ument only contains an introductory chapter if the corresponding feature `WithIntroduction` is selected.

**Example 9.3. A sample conditional document**

for use with the `ps:condtext` transformation

```
PV:IFCOND(pv:hasFeature('WithIntroduction'))
  This text is in the resulting text output
  if feature WithIntroduction is selected.
PV:ELSECOND
  This text is in the resulting text output
  if feature WithIntroduction is not selected.
PV:ENDCOND
  This text is always in the resulting text output.
```

### 9.5.8. `ps:pvsclxml`

**Attributes:**

- `dir` [ps:directory]
- `file` [ps:path]
- `type` [ps:filetype]
- `srcdir?` [ps:directory]
- `srcfile?` [ps:path]
- `conditionname?` [ps:string]
- `copycondition?` [ps:boolean]

This source element type is used to copy an XML document and optionally to save the copy to a file. Special condi-
tional attributes on the nodes of the XML document are dynamically evaluated to decide whether this node
(and its subnodes) are copied into the result document. The name of the evaluated condition attribute is specified
using the attribute `conditionname` and defaults to `pv:condition`. If the attribute `copycondition` is not set to `false`,
the condition attribute is copied into the target document as well.

The condition itself has to be a valid pvSCL expression. For details on writing pvSCL expressions, see **Section 9.8, “Expression Language pvSCL”**.

In the example document given below after processing with an `ps:pvsclxml` transformation, the resulting XML
document only contains an introductory chapter if the corresponding feature `WithIntroduction` is selected.

**Example 9.4. A sample conditional document**

for use with the `ps:pvsclxml` transformation

```
<?xml version='1.0'?>
<text xmlns:pv="http://www.pure-systems.com/purevariants">
  <chapter pv:condition="WithIntroduction">
    This is some introductory text.
  </chapter>
  <chapter>
    This text is always in the resulting xml output.
  </chapter>
</text>
```

A special XML node is supported for calculating and inserting the value pvSCL expression. The name of this
node is `pv:eval` (namespace "pv" is defined as "http://www.pure-systems.com/purevariants"). The `pv:eval` node
is replaced by the calculated value in the result document.
Example 9.5. Example use of pv:eval

Source document:

```xml
<?xml version='1.0'?>
<version xmlns:pv="http://www.pure-systems.com/purevariants">
  <pv:eval>Version-&gt;version</pv:eval>
</version>
```

Result document:

```xml
<?xml version='1.0'?>
<version xmlns:pv="http://www.pure-systems.com/purevariants">
  1.0
</version>
```

9.5.9. ps:pvscltext

Attributes:

- dir [ps:directory]
- file [ps:path]
- type [ps:filetype]
- srcdir? [ps:directory]
- srcfile? [ps:path]
- encoding? [ps:encoding]

This source element type is used to copy a text document and optionally to save the copy to a file. Special statements in the text document are evaluated to decide which parts of the text document are copied into the result document, or to insert additional text. If no text document encoding is given, then UTF-8 encoding is assumed.

The statements (macro-like calls) that can be used in the text document are listed in the following table.

<table>
<thead>
<tr>
<th>Statement</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PVSCL:IFCOND(condition)</td>
<td>Open a new conditional text block. The text in the block is included in the resulting text output if the given condition evaluates to true. The opened conditional text block has to be closed by a PVSCL:ENDCOND call.</td>
</tr>
<tr>
<td>PVSCL:ELSEIFCOND(condition)</td>
<td>This macro can be used after a PVSCL:IFCOND or PVSCL:ELSEIFCOND call. If the condition of the preceding PVSCL:IFCOND or PVSCL:ELSEIFCOND is failed, the condition of this PVSCL:ELSEIFCOND is checked. If it evaluates to true, the enclosed text is included in the resulting text output.</td>
</tr>
<tr>
<td>PVSCL:ELSECOND</td>
<td>This macro can be used after a PVSCL:IFCOND or PVSCL:ELSEIFCOND call. If the condition of the preceding PVSCL:IFCOND or PVSCL:ELSEIFCOND is failed, the enclosed text is included in the resulting text output.</td>
</tr>
<tr>
<td>PVSCL:ENDCOND</td>
<td>Close a conditional text block. This macro is allowed after a PVSCL:IFCOND, PVSCL:ELSEIFCOND, or PVSCL:ENDCOND call.</td>
</tr>
<tr>
<td>PVSCL:EVAL(expression)</td>
<td>Evaluate the given pvSCL expression and insert the value of the expression into the result document.</td>
</tr>
</tbody>
</table>

These statements can occur everywhere in the text document and are directly matched, i.e. independently of the surrounding text. The conditions of PVSCL:IFCOND and PVSCL:ELSEIFCOND and the expression of PVSCL:EVAL are the same as the conditions described for source element type ps:pvsclxml (see Section 9.5.8, “ps:pvsclxml” for details), except for a list of comma-separated flags that can follow the pvSCL code. Following flags are supported.

<table>
<thead>
<tr>
<th>Flag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LINE</td>
<td>Clear or remove the line containing the pvSCL conditional text statement.</td>
</tr>
</tbody>
</table>

Example for a multi-line if-statement utilizing flag LINE:

```c
/* PVSCL:IFCOND(Temperature,LINE) */
initializeSensor("temperature", PVSCL:EVAL(Temperature-&gt;max));
```
### Conditional text blocks can be nested. That means, that a PVSCL:IFCOND block can contain another PVSCL:IFCOND block defining a nested conditional text block that is evaluated only if the surrounding text block is included in the resulting text output.

In the example document given below after processing with a ps:pvscltext transformation, the resulting text document only contains an introductory chapter if the corresponding feature WithIntroduction is selected.

**Example 9.6. A sample conditional document for use with the ps:pvscltext transformation**

```xml
<PVSCL:IFCOND(WithIntroduction)
  This text is in the resulting text output
  if feature WithIntroduction is selected.
PVSCL:ELSECOND
  This text is in the resulting text output
  if feature WithIntroduction is not selected.
PVSCL:ENDIF
  This text is always in the resulting text output.
</PVSCL:IFCOND>
```

### 9.5.10. ps:flagfile

**Attributes:**
- `dir` [ps:directory]
- `file` [ps:path]
- `type` [ps:filetype]
- `flag` [ps:string]

This source element type is used to generate C/C++-Header files containing #define `<flag>` `<flagValue>` statements. The `<flagValue>` part of these statements is the value of the attribute `Value` of the parent part element. The name of the flag is specified by the attribute `flag`. See the section called “Providing Values for Part Elements” for more details. The same file location can be used in more than one ps:flagfile definition to include multiple #define statements in a single file.

**Example 9.7. Generated code for a ps:flagfile for flag "DEFAULT" with value "1"**

```c
#ifndef __guard_DEBUG
#define __guard_DEBUG
#undef DEBUG
#define DEBUG 1
#endif
```

### 9.5.11. ps:makefile

**Attributes:**
- `dir` [ps:directory]
- `file` [ps:path]

This source element type is used to generate Makefile sections containing `#define <flag> <flagValue>` statements. The `<flagValue>` part of these statements is the value of the attribute `Value` of the parent part element. The name of the flag is specified by the attribute `flag`. See the section called “Providing Values for Part Elements” for more details. The same file location can be used in more than one ps:flagfile definition to include multiple #define statements in a single file.

**Example 9.7. Generated code for a ps:flagfile for flag "DEFAULT" with value "1"**

```makefile
#ifdef __guard_DEBUG
#define __guard_DEBUG
#undef DEBUG
#define DEBUG 1
#endif
```
This source element type is used to generate makefile variables using a `<variable> += '<varValue>'` statement. The `<varValue>` part of the statement is the value of the attribute Value of the parent part element. The name of the variable is specified by the attribute variable. See the section called "Providing Values for Part Elements" for more details. The attribute set defines if the variable is set to the value (true) or if the variable is extended by the value (false). The generated code is compatible with the gmake system. To generate code for a different make system the attribute makesystem can be used. The same file location can be used for more than one `ps:makefile` element to include multiple makefile variables in a single file.

**Example 9.8. Generated code for a ps:makefile for variable "CXX_OPTFLAGS" with value "-O6"**

CXX_OPTFLAGS += "-O6"

### 9.5.12. ps:classaliasfile

**Attributes:**
- **dir** [ps:directory]
- **file** [ps:path]
- **type** [ps:filetype]
- **alias** [ps:string]

This source element type is used to support different classes with different names that are concurrently used in the same place in the class hierarchy. This transformation is C/C++ specific and can be used as an efficient replacement for templates in some cases. This definition is only used in conjunction with the part type `ps:classalias`. A `typedef aliasValue alias;` statement is generated by the standard transformation for this element type. `aliasValue` is the value of the attribute Value of the parent part element. Furthermore, in the standard transformation the Variant Result Model is searched for a class with name `aliasValue` and `#include` statements are generated for each of its `ps:file` source elements that have a `type` attribute with the value 'def'. If the alias name contains a namespace prefix, corresponding namespace blocks are generated around the `typedef` statement.

**Example 9.9. Generated code for a ps:classalias for alias "io::net::PCConn" with aliased class "NoConn"**

```
#ifndef __PCConn_include__
#define __PCConn_include__
#include "C:\Weather Station Example\output\usr\wm-src\NoConn.h"
namespace io {
    namespace net {
        typedef NoConn PCConn;
    }
}
#endif __PCConn_include__
```

### 9.5.13. ps:symlink

**Attributes:**
- **dir** [ps:directory]
- **file** [ps:path]
- **type** [ps:filetype]
- **linktarget** [ps:string]

This source element type is used to create a symbolic link to a file or directory named `<linktarget>`.

**Note**

Symbolic links are not supported under Microsoft Windows operating systems. Instead files and directories are copied.
9.6. Predefined Part Element Types

Table 9.8. Predefined part types

<table>
<thead>
<tr>
<th>Part type</th>
<th>Description</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>$ps:class$</td>
<td>Maps directly to a class in an object-oriented programming language.</td>
<td></td>
</tr>
<tr>
<td>$ps:clasalias$</td>
<td>Different classes may be mapped to a single class name. Value restrictions must ensure that in every possible configuration only one class is assigned to the alias.</td>
<td></td>
</tr>
<tr>
<td>$ps:object$</td>
<td>Maps directly to an object in an object-oriented programming language.</td>
<td></td>
</tr>
<tr>
<td>$ps:variable$</td>
<td>Describes a configuration variable name, usually evaluated in make files. The variable can have a value assigned.</td>
<td></td>
</tr>
<tr>
<td>$ps:flag$</td>
<td>A synonym for $ps:variable$. This part type maps to a source code flag. A flag can be undefined or can have an associated value that is calculated at configuration time. $ps:flag$ is usually used in conjunction with the flagfile source element, which generates a C++ preprocessor <code>#define &lt;flagName&gt; &lt;flagValue&gt;</code> statement in the specified file.</td>
<td></td>
</tr>
<tr>
<td>$ps:project$</td>
<td>$ps:project$ can be used as the part type for anything that does not fit into other part types.</td>
<td></td>
</tr>
<tr>
<td>$ps:aspect$</td>
<td>Maps directly to an aspect in an aspect-oriented language (e.g. AspectJ or AspectC++).</td>
<td></td>
</tr>
<tr>
<td>$ps:feature$</td>
<td>Maps directly to a feature in a Feature Model.</td>
<td></td>
</tr>
<tr>
<td>$ps:value$</td>
<td>General abstraction of a value.</td>
<td></td>
</tr>
<tr>
<td>$ps:method$</td>
<td>Maps directly to a method of a class in an object-oriented programming language.</td>
<td></td>
</tr>
<tr>
<td>$ps:function$</td>
<td>Describes the declaration of a function.</td>
<td></td>
</tr>
<tr>
<td>$ps:functionimpl$</td>
<td>Describes the implementation of a function.</td>
<td></td>
</tr>
<tr>
<td>$ps:operator$</td>
<td>Maps directly to a programming language operator or operator function.</td>
<td></td>
</tr>
<tr>
<td>$ps:link$</td>
<td>General abstraction for a link. This could be for instance a www link or file system link.</td>
<td></td>
</tr>
</tbody>
</table>

The following sections provide detailed descriptions of the family model part element types that are relevant for the standard transformation (see Section 6.3.2, “Standard Transformation”).

Every description has the following form:

**9.6.1. aPartElementType**

Attributes: `attributeName1 [typeName1]`  
`attributeName2? [typeName2]`

The part element type `aPartElementType` has one mandatory attribute named `attributeName1` and an optional attribute named `attributeName2`. The option is indicated by the trailing question mark.

**9.6.2. ps:clasalias**

Attributes: `Value [ps:string]`

A class alias is an abstract place holder for variant specific type instantiations. It allows to use concepts similar to interface inheritance with virtual methods in C++ without any overhead. The corresponding source element `ps:clasaliasfile` can be used to generate the required C++ code. The unique name of the `ps:clasalias` element represents the class name to be used when creating or referencing to objects implementing this abstract interface.

The values of attribute `Value` must evaluate to unique names of `ps:class` elements. The value calculated during evaluation is used to locate the implementation class for the abstract class alias.

For more information and an example see Section 9.5.12, “ps:clasaliasfile”.
9.6.3. ps:class

Attributes:  

    classname? [ps:string]

A class represents a class in the architecture. It can be used in conjunction with ps:classalias.

The value of the optional attribute `classname` represents the fully qualified name of the class (e.g. `std::string`) to be used when generating code using the standard transformation. Otherwise the unique name of the element is used for this purpose.

For more information and an example on using `ps:class` together with `ps:classalias` see Section 9.5.12, “ps:classaliasfile”.

9.6.4. ps:flag

Attributes:  

    Value [ps:string]

A flag represents any kind of named value, e.g. a C/C++ preprocessor constant. For the standard transformation the value of attribute `Value` is evaluated by `ps:flagfile` resp. `ps:makefile` source elements to generate C/C++ specific preprocessor definitions resp. `make` file variables.

For more information about the `ps:flagfile` and `ps:makefile` source element types see Section 9.5.10, “ps:flagfile” and Section 9.5.11, “ps:makefile”.

9.6.5. ps:variable

Attributes:  

    Value [ps:string]

A variable represents any kind of named value, e.g. a `make` file or programming language variable. For the standard transformation the value of attribute `Value` is evaluated by `ps:flagfile` resp. `ps:makefile` source elements to generate C/C++ specific preprocessor definitions resp. `make` file variables.

For more information about the `ps:flagfile` and `ps:makefile` source element types see Section 9.5.10, “ps:flagfile” and Section 9.5.11, “ps:makefile”.

9.6.6. ps:feature

Attributes:  

    fid [ps:feature]

This special part type is used to define features which have to be present if the part element is selected. If pure::variants detects a selected part of type `ps:feature`, the current feature selection must contain the feature with the id given as value of the attribute `fid`. Otherwise the result is not considered to be valid. The selection problem Auto Resolver (if activated) tries to satisfy feature selections expected by `ps:feature` part elements. This functionality does not depend on the use of any specific transformation modules.

9.7. Expression Language pvProlog

**Warning**

Starting with pure::variants 4 usage of Prolog language is no longer recommended. Please use pvSCL. Prolog language may be removed in future major releases.

The pure::variants expression language `pvProlog` is a dialect of the Prolog programming language. However, `pvProlog` expressions more closely resemble those in languages such as OCL and XPath, than expressions in Prolog do. In most cases the provided logical operators and functions are sufficient to specify restrictions and constraints. If more complicated computations have to be done, the full power of the underlying Prolog engine can be used. See [http://www.swi-prolog.org](http://www.swi-prolog.org) for more information on SWI-Prolog syntax and semantics.

<table>
<thead>
<tr>
<th>Expr</th>
<th>= Func</th>
<th>UnaryOpExpr</th>
</tr>
</thead>
</table>

Table 9.9. pvProlog Syntax (EBNF notation)
Element References

9.7.1. Element References

Most of the *pvProlog* functions require a model element reference as argument. These element references have to be put in single quotes and have the following format.

**Table 9.10. Element references**

<table>
<thead>
<tr>
<th>Format</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>ElementName</code></td>
<td>Refers to the element with the unique name <code>ElementName</code>. If no model name is given, then the element name is resolved first in the model containing the <em>pvProlog</em> expression, then in all other models of the Configuration Space. Otherwise it is resolved in the model with the same name <code>ModelName</code>.</td>
</tr>
<tr>
<td><code>ModelName.ElementName</code></td>
<td></td>
</tr>
<tr>
<td><code>ElementId</code></td>
<td>Refers to the element with the unique id <code>ElementId</code>. If no model id is given, then the element is resolved first in the model containing the <em>pvProlog</em> expression, then in all other models of the configuration space. Otherwise it is resolved in the model with the id <code>ModelId</code>.</td>
</tr>
<tr>
<td><code>ModelId/ElementId</code></td>
<td></td>
</tr>
<tr>
<td><code>:ElementName</code></td>
<td>Full qualified element reference. The element reference is resolved in the context of the top parent model.</td>
</tr>
<tr>
<td><code>:ModelName.ElementName</code></td>
<td></td>
</tr>
<tr>
<td><code>ElementName:ElementName</code></td>
<td>Qualified element name reference. The element reference is resolved in the context of the model containing the element reference.</td>
</tr>
<tr>
<td><code>ModelName.ElementName:ElementName</code></td>
<td></td>
</tr>
<tr>
<td><code>ElementName:ModelName.ElementName</code></td>
<td></td>
</tr>
<tr>
<td><code>ModelName.ElementName:ModelName.ElementName</code></td>
<td></td>
</tr>
<tr>
<td><code>ElementId:ElementId</code></td>
<td>Qualified element id reference. The element reference is resolved first in the context of the top parent model. If it could not be resolved, it is resolved in the context of the model containing the element reference.</td>
</tr>
<tr>
<td><code>ModelId/ElementId:ElementId</code></td>
<td></td>
</tr>
<tr>
<td><code>ElementName[0]</code></td>
<td>Anonymous context change. This syntax allows to reference elements in the n-th linked model below a Link Element. This is useful especially to reference elements in variant collections.</td>
</tr>
<tr>
<td><code>ModelName.ElementName[3]</code></td>
<td></td>
</tr>
</tbody>
</table>

| `BinOp` | 'xor' |
| `UnaryOp Expr` | '=' |
| `UnaryOp expr` | 'equiv' |
| `UnaryOp expr` | 'and' |
| `UnaryOp expr` | 'implies' |
| `UnaryOp expr` | 'or' |
| `Func` | FuncName '(' Args ')' |
| `Args` | Argument |
| `Argument` | String |
| `String` | '''[.]*''' |
| `Number` | ('+'|'-')? ['0'-'9']+ ('.' ['0'-'9']+)? |
| `FuncName` | ['a'-'z']['a'-'z''A'-'Z''0'-'9''_']* |
Parent context access. In a linked model, `parent` resolves to the parent context. The parent context is the context of the parent model, i.e., the model that contains the link. If a model is not linked by another model, then `parent` is ignored. `parent` can only occur at the beginning of a qualified element reference or directly after another `parent` qualifier, and has to be followed by the context operator ":".

**Table 9.11. Examples**

<table>
<thead>
<tr>
<th>Example</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>hasFeature('Product1')</code></td>
<td>Check if element 'Product1' is selected.</td>
</tr>
<tr>
<td><code>hasFeature('Products.Product2')</code></td>
<td>Check if element 'Product1' of model 'Products' is selected.</td>
</tr>
<tr>
<td><code>hasFeature('Network.Computer:Office.Monitor')</code></td>
<td>Check if feature Monitor is selected in the linked model Office.</td>
</tr>
<tr>
<td><code>hasFeature('Network.Computer[42]:Monitor')</code></td>
<td>Check if feature Monitor is selected in the 42th linked Computer model of model Network.</td>
</tr>
<tr>
<td><code>hasFeature('Networks.Network[0]:Computer[42]:Monitor')</code></td>
<td>Check if feature Monitor is selected in the 42th linked Computer model of the first linked Network model of model Networks.</td>
</tr>
<tr>
<td><code>hasFeature('parent:parent:MonitorSupport')</code></td>
<td>Check if feature MonitorSupport is selected in the parent model of the parent model of the model containing the element reference.</td>
</tr>
</tbody>
</table>

### 9.7.2. Logical Operators

**Table 9.12. Logical operators in pvProlog**

<table>
<thead>
<tr>
<th>Name/Symbol</th>
<th>Association</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>xor</code></td>
<td>right</td>
<td>binary</td>
<td>logical exclusive or</td>
</tr>
<tr>
<td><code>equiv</code></td>
<td>none</td>
<td>binary</td>
<td>not(A xor B)</td>
</tr>
<tr>
<td><code>and</code></td>
<td>left</td>
<td>binary</td>
<td>logical and</td>
</tr>
<tr>
<td><code>or</code></td>
<td>left</td>
<td>binary</td>
<td>logical or</td>
</tr>
<tr>
<td><code>implies</code></td>
<td>left</td>
<td>binary</td>
<td>logical implication</td>
</tr>
</tbody>
</table>

### 9.7.3. Supported Functions

The following abbreviations are used in this section:

**AID** Attribute id. The full id path of the attribute (modelId/attributeId).

**AN** Attribute name. This can be the name of an attribute or the full id path (modelId/attributeId).

**CID,PID,SID** Component/part/source id. This must be the full id path (modelId/elementId).

**CN,PN,SN** Component/part/source name. This can be the unique name of the component/part/source or the full id path (modelId/elementId).
Supported Functions

EN Element name (can point to any element type). This can be the unique name of the element or the full element id path (modelId/elementId).

EID Element id. This must be the full id path (modelId/elementId).

EL Element id list. List of elements given as full id paths (modelId/elementId).

FID Feature id. This must be the full feature id path (modelId/featureId).

FN Feature name. This can be the unique name of the feature or the full feature id path (modelId/featureId).

Table 9.13. Logical functions in pvProlog

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>true</td>
<td>Always true</td>
</tr>
<tr>
<td>false</td>
<td>Always false</td>
</tr>
<tr>
<td>not(EXP)</td>
<td>True if EXP is false</td>
</tr>
</tbody>
</table>

Table 9.14. Functions for value calculations, restrictions, and constraints in pvProlog

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>isElement(EID)</td>
<td>True if the element with id EID is found in any model.</td>
</tr>
<tr>
<td>isFamilyModelElement(EID)</td>
<td>True if the element with id EID is found in a family model.</td>
</tr>
<tr>
<td>isFeatureModelElement(EID)</td>
<td>True if the element with id EID is found in a Feature Model.</td>
</tr>
<tr>
<td>hasAttribute(AID)</td>
<td>These methods check the existence of a definition for the specified attribute. Attribute is identified by its id (AID), by the symbolic name of its associated element and its symbolic name (EN, AN) or similarly by additionally specifying the element type ET. To ensure correct operation of hasAttribute variants using symbolic names, symbolic element names EN must be unique inside the Configuration Space or inside the element space of the Configuration Space [(ET, EN), (EC, ET, EN)] and the symbolic attribute name AN must be unique inside the attribute space of the element.</td>
</tr>
<tr>
<td>hasAttribute(EN, AN)</td>
<td></td>
</tr>
<tr>
<td>hasAttribute(ET, EN, AN)</td>
<td></td>
</tr>
<tr>
<td>hasAttribute(EC, ET, EN, AN)</td>
<td></td>
</tr>
<tr>
<td>getAttribute(AID, VALUE)</td>
<td>These methods get or check the existence and value of the specified attribute. Attribute is identified by its id (AID), by the symbolic name of its associated element and its symbolic name (EN, AN), or similarly by additionally specifying the element type ET. When VALUE is a constant, getAttribute checks that the attribute has the specified value. If VALUE is a variable, then subsequent rules can access the attributes value using the specified variable name. To ensure correct operation of hasAttribute variants using symbolic names, symbolic element names EN must be unique inside the Configuration Space or inside the element space of the Configuration Space [(ET, EN), (EC, ET, EN)] and the symbolic attribute name AN must be unique inside the attribute space of the element.</td>
</tr>
<tr>
<td>getAttribute(EN, AN, VALUE)</td>
<td></td>
</tr>
<tr>
<td>getAttribute(ET, EN, AN, VALUE)</td>
<td></td>
</tr>
<tr>
<td>getAttribute(EC, ET, EN, AN, VALUE)</td>
<td></td>
</tr>
<tr>
<td>getAttributeName(AID, ANAME)</td>
<td>ANAME is unified with the attribute name of the attribute specified with AID.</td>
</tr>
</tbody>
</table>

Note: Due to the evaluation algorithm it is not supported to use one of these functions in a restriction of an attribute to check the existence of the same attribute. Instead the existence of the attribute should be checked in a restriction on the associated element.
### Supported Functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>getAttributeType(AID,ATYPE)</code></td>
<td><code>ATYPE</code> is unified with the meta-model attribute type of the attribute specified with <code>AID</code>.</td>
</tr>
<tr>
<td><code>getAttributeId(EN,AN,AID)</code></td>
<td><code>AID</code> is unified with the ID of the attribute with the name <code>AN</code> on the element with the unique name <code>EN</code>.</td>
</tr>
</tbody>
</table>
| `isTrue(VALUE)` | If `VALUE` is equal to the internal representation of the true value for an attribute of type `ps:boolean`, it will evaluate to true. Example usage in a restriction: 
  ```
generateContext(EID) and getAttribute(EID,'ABoolean',BV) and isTrue(BV)  ``` |
| `isFalse(VALUE)` | If `VALUE` is not equal to the internal representation of the true value for an attribute of type `ps:boolean`, it will evaluate to true. |
| `getContext(EID)` | These methods can be used to determine the restriction/calculation context. `EID` is bound to the unique id of the element that is the immediate ancestor of the restriction or calculation. So, inside an attribute calculation it will be bound to the id of the element containing the attribute definition. `SELF` is the unique id of the calculation/restriction itself. Example: Access the attribute X of the same element in a calculation: 
  ```
genContext(EID), getAttribute(EID,'X',XValue)  ``` |
| `getSelf(SELF)` | |
| `getVariantContextId(VCID)` | |
| `getVariantContextName(VCN)` | These methods are used to get the ID and name of the current variant context element. This element marks a context change in the evaluation of a model that links other models. Each linked model is evaluated in its own unique context. |
| `isVariant(VN)` | True if the currently evaluated variants unique id or name (VDM name, set in model properties) equals `VN`. Example usage in a restriction: 
  ```
isVariant('MyVariant')  ``` |
<p>| <code>getVariantId(MID)</code> | <code>MID</code> is unified with the unique id of the VDM (.vdm) currently being evaluated. |
| <code>getElementModel(EID,MID)</code> | <code>MID</code> is bound to the model id associated with the unique element id <code>EID</code>. If <code>EID</code> is not given, the context element is used as <code>EID</code>. |
| <code>getElementChildren(EID,CEIDS)</code> | <code>CEIDS</code> is unified with the list of children of the element specified with <code>EID</code> or an empty list if no children exist. |
| <code>getElementParents(EID,PARIDS)</code> | <code>PARIDS</code> is unified with the list of parents of the element specified by <code>EID</code> or an empty list if no parents exist. |
| <code>getElementRoot(EID,ROOTID)</code> | <code>ROOTID</code> is the root element for the element specified by <code>EID</code>. For elements with several root elements only one is chosen. |
| <code>getElementName(EID,ENAME)</code> | <code>ENAME</code> is unified with the unique name of the element specified with <code>EID</code>. |</p>
<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>getElementVisibleName(EID, ENAME)</code></td>
<td><code>ENAME</code> is unified with the visible name of the element specified with <code>EID</code>.</td>
</tr>
<tr>
<td><code>getElementClass(EID, ECLASS)</code></td>
<td><code>ECLASS</code> is unified with the type model element class of the element specified with <code>EID</code>. The standard meta model uses the classes <code>ps:feature</code>, <code>ps:component</code>, <code>ps:part</code> and <code>ps:source</code>.</td>
</tr>
<tr>
<td><code>getElementType(EID, ETYPE)</code></td>
<td><code>ETYPE</code> is unified with the type model element type of the element specified with <code>EID</code>.</td>
</tr>
<tr>
<td><code>getMatchingElements(MatchExpr, MEIDS)</code></td>
<td><code>MEIDS</code> is unified with a list of all the elements which comply with the specified match expression <code>MatchExpr</code>. The context of the match expression is the current element context (see <code>getContext</code>) unless <code>CTXID</code> is used to specify a different context.</td>
</tr>
<tr>
<td><code>getMatchingAttributes(MatchExpr, EID, AIDS)</code></td>
<td><code>AIDS</code> is unified with all attributes of the element specified with the unique id <code>EID</code> which match with the pattern in <code>MatchExpr</code>. The match pattern is the same as for <code>getMatchingElements</code>, but it must not contain dot characters.</td>
</tr>
<tr>
<td><code>subnodeCount(ECLASS, ENAME, COUNT)</code></td>
<td>These methods count the number of selected children of a given element. <code>COUNT</code> is bound to the number of selected child elements. Whether the element itself is selected is not checked.</td>
</tr>
<tr>
<td><code>subnodeCount(ECLASS, ETYPE, ENAME, COUNT)</code></td>
<td>Example: A restriction checking whether three children of component X are selected:</td>
</tr>
<tr>
<td><code>subnodeCount(EID, COUNT)</code></td>
<td><code>subnodeCount('ps:component','X',3)</code></td>
</tr>
<tr>
<td><code>subfeatureCount(FNAME, COUNT)</code></td>
<td><code>COUNT</code> is bound to the number of selected child features of feature <code>FNAME</code>. Convenience method for <code>subnodeCount('ps:feature',_,FNAME,COUNT)</code>.</td>
</tr>
<tr>
<td><code>singleSubfeature(FNAME)</code></td>
<td>True if feature <code>FNAME</code> has just a single child. Convenience method for <code>subnodeCount('ps:feature',_,FNAME,1)</code></td>
</tr>
<tr>
<td><code>alternativeChild(FN,FN2)</code></td>
<td>True, if the feature <code>FN</code> has an alternative group and one of the alternative features is in the current feature selection. <code>FN2</code> is unified with the selected alternative feature name.</td>
</tr>
<tr>
<td><code>userMessage(TYPE, STRING, RELATEDEIDS, CONTEXTEID)</code></td>
<td>Issues a problem message to be shown, for example, in the Eclipse problems view. <code>TYPE</code> is one of <code>['error','warning','info']</code>. <code>STRING</code> is the text which describes the problem. <code>RELATEDEIDS</code> is a list of elements with some relation to the problem. <code>CONTEXTEID</code> is the id of the element that caused the problem.</td>
</tr>
<tr>
<td><code>userMessage(TYPE, STRING, RELATEDEIDS)</code></td>
<td>Example:</td>
</tr>
<tr>
<td><code>userMessage('error','Something happened',[REID1,REID2],MYEID)</code></td>
<td></td>
</tr>
<tr>
<td><code>warningMsg(STRING,RELATEDEIDS)</code></td>
<td>Convenience methods for <code>userMessage</code>, sets <code>TYPE</code> automatically.</td>
</tr>
<tr>
<td><code>errorMsg(STRING,RELATEDEIDS)</code></td>
<td></td>
</tr>
<tr>
<td><code>infoMsg(STRING,RELATEDEIDS)</code></td>
<td></td>
</tr>
</tbody>
</table>
### Additional Functions for Variant Evaluation

**Function** | **Description**
--- | ---
`warningMsg(STRING)` | Convenience methods for `userMessage`, `set TYPE` automatically and uses empty `RELATEDEIDS` list.
`errorMsg(STRING)` | Example:
`infoMsg(STRING)` | `errorMsg('An unknown error occurred')`

#### 9.7.4. Additional Functions for Variant Evaluation

**Table 9.15. Additional functions available for variant evaluation**

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>hasElement(EID)</code></td>
<td>True if the element <code>EID</code> is in the variant. Fails silently otherwise.</td>
</tr>
<tr>
<td><code>has(EID)</code></td>
<td>If <code>hasElement</code> is used inside restrictions and constraints inside Feature Models, the element identified by <code>EID</code> has to be contained in models with higher ranks.</td>
</tr>
<tr>
<td></td>
<td>If used in family models the element has to be in Feature Models of the same rank or in any model of higher rank.</td>
</tr>
<tr>
<td><code>hasFeature(FN)</code></td>
<td>True if the feature <code>FN</code> is found in the current set of selected features. Fails silently otherwise.</td>
</tr>
<tr>
<td><code>hasComponent(CN)</code></td>
<td>True if the component/part/source <code>xN</code> is found in the current set of selected components in the current component configuration. Fails silently otherwise.</td>
</tr>
<tr>
<td><code>hasPart(PN)</code></td>
<td>See <code>hasElement</code>. <code>hasPart</code> may also refer to components from the same Family Model. <code>hasSource</code> may also refer to parts from the same model.</td>
</tr>
<tr>
<td><code>hasSource(SN)</code></td>
<td></td>
</tr>
<tr>
<td><code>getAllSelectedChildren(EID,IDL)</code></td>
<td>Binds <code>IDL</code> to contain all selected children and children of children below and not including <code>EID</code>.</td>
</tr>
<tr>
<td></td>
<td><code>EID</code> must be an element of a model with the same or higher rank when this rule is used in attribute calculations. <code>EID</code> must be an element of a model with higher rank when used in restrictions. In Family Model restrictions <code>EID</code> can also be an element of a model with the same rank.</td>
</tr>
<tr>
<td><code>getAllChildren(EID,IDL)</code></td>
<td>Binds <code>IDL</code> to contain all children and children of children below and not including <code>EID</code>.</td>
</tr>
<tr>
<td><code>getMatchingSelectedElements(MatchExpr,MEIDS)</code></td>
<td>Similar to <code>getMatchingElement</code> described above, but the list is unified only with the elements which are in the current configuration.</td>
</tr>
<tr>
<td><code>sumSelectedSubtreeAttributes(EID,AN,Value)</code></td>
<td>Calculates the numerical sum of all attributes with the name <code>AN</code> for all selected elements below element with id <code>EID</code> not including the elements attributes itself.</td>
</tr>
<tr>
<td></td>
<td>See <code>getAllSelectedChildren</code></td>
</tr>
<tr>
<td><code>checkMin(EN,AN,Minimum)</code></td>
<td>Checks if the value of attribute <code>AN</code> of element <code>EN</code> is equal or greater than <code>Minimum</code>. <code>Minimum</code> has to be a number or the name of an attribute of <code>EN</code> with a number as value.</td>
</tr>
<tr>
<td></td>
<td>Examples:</td>
</tr>
<tr>
<td></td>
<td><code>checkMin('Car','Wheels',4)</code></td>
</tr>
</tbody>
</table>
### Match Expression Syntax for getMatchingElements

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>checkMin('Car','Wheels','MinNumWheels')</td>
<td>Checks if the value of attribute AN of element EN is equal or less than Maximum. Maximum has to be a number or the name of an attribute of EN with a number as value.</td>
</tr>
<tr>
<td>checkMax(EN,AN,Maximum)</td>
<td>Checks if the value of attribute AN of element EN is equal or greater than Minimum and equal or less than Maximum. Minimum and Maximum have to be numbers or names of attributes of EN with a number as value.</td>
</tr>
<tr>
<td>checkRange(EN,AN,Minimum,Maximum)</td>
<td>Checks if the value of attribute AN of element EN is equal or greater than Minimum and equal or less than Maximum. Minimum and Maximum have to be numbers or names of attributes of EN with a number as value.</td>
</tr>
</tbody>
</table>

Examples:

- checkMax('Hand','Fingers',10)
- checkMax('Hand','Fingers','MaxNumFingers')
- checkRange('Car','Speed',0,130)
- checkRange('Car','Speed',0,'MaxSpeed')

Additional functions can be specified using the `ps:codelib:prolog` model property (see Section 9.7.8, “User-Defined Prolog Functions”).

### 9.7.5. Match Expression Syntax for getMatchingElements

The `getMatchingElements` rules use simple match expressions to specify the elements. A match expression is a string. Match expressions are evaluated relative to a given context or absolutely (i.e. starting from the root element of the context element) when the expression's first character is a dot `.`.

Each token is matched against all elements at the given tree position. The first token is matched against all children of the context element or all children of the root element in the case of absolute paths. The second token is matched against children of the elements which matched the first token and so on.

Tokens are matched against the unique names of elements. The match pattern for each token is very similar the Unix `csh` pattern matcher but is case insensitive, i.e. the pattern `V*` matches all names starting with small `v` or capital `V`. The following patterns are supported.

- `?` Matches one arbitrary character.
- `*` Matches any number of arbitrary characters.
- `[..]` Matches one of the characters specified between the brackets. `<char1>`- `<char2>` indicates a range.
- `{[...]}` Matches any of the patterns in the comma separated list between the braces.
- `**` If the token is `**`, the remainder of the match expression is applied recursively for all sub hierarchies below.

For example, path expression ‘A?.BAR’ matches all elements named BAR below any element with a two letter name whose first letter is A and which is relative to the current context element. The expression ‘.**.D*’ matches all model elements whose unique name starts with D and that are in the model of the context element.

The context element (or root element in an absolute expression) itself is never included in the matching elements.

### 9.7.6. Accessing Model Attributes

Information stored in model meta attributes can be accessed using the `pvProlog` function `getAttribute`. The table below lists the available attributes and their meaning.
Table 9.16. Meta-Model attributes in pvProlog

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>name</td>
<td>The descriptive name of the model.</td>
</tr>
<tr>
<td>date</td>
<td>The creation date of the model.</td>
</tr>
<tr>
<td>version</td>
<td>An arbitrary user-defined string to identify the version of the model.</td>
</tr>
<tr>
<td>time</td>
<td>The creation time of the model.</td>
</tr>
<tr>
<td>author</td>
<td>The user who created the model.</td>
</tr>
<tr>
<td>file</td>
<td>The file name of the model (without directory path, see path below).</td>
</tr>
<tr>
<td>dir</td>
<td>The absolute path leading to the model directory.</td>
</tr>
</tbody>
</table>

To access a model meta attribute, getAttribute has to be called with the ID of model and the name of the attribute. The attribute value is written in the third argument of getAttribute. For example, to get the name of the currently processed VDM write the following (the name will be stored in variable NAME):

`getVariantId(VID), getAttribute(VID,'name',NAME)`

### 9.7.7. Advanced pvProlog Examples

This section demonstrates the use of some useful Prolog functions for handling strings, numbers and lists.

Check if VAR is bound to nothing, a string, a number, an integer number, or a floating point number.

```
var(VAR)
string(VAR)
number(VAR)
integer(VAR)
float(VAR)
```

Convert string STR to a number. The number is stored in N.

```
atom_number(STR,N)
```

Get the length of string STR and store it in LEN.

```
string_length(STR,LEN)
```

Concatenate two strings STR1 and STR2 and store the result in STR.

```
string_concat(STR1,STR2,STR)
```

Concatenate the strings STR1, STR2, and STR3, separated by a slash. Store the result in STR.

```
concat_atom([STR1,STR2,STR3],'/',STR)
```

Split string STR at every slash in the string. The list of substrings is stored in L.

```
concat_atom(L,'/',STR)
```

Check if string STR contains a slash.

```
sub_string(STR,_,_,_,'/')
```

Check if string STR starts with "abc".

```
sub_string(STR,0,_,_,"abc")
```

Check if string STR ends with "xyz".
User-Defined Prolog Functions

get_attribute('Product','version',VERSION),
get_attribute('Product','date',DATE),
get_attribute('Product','author',AUTHOR),
sformat(STR,'Product version ~w. Created on ~w by ~w.',[VERSION,DATE,AUTHOR])

check if variable L is bound to a list.

is_list(L)

get the length of list L and store it in LEN.

length(L,LEN)

check if item E is member of list L.

member(E,L)

get the third member of list L, beginning at index 0, and store it in E.

nth0(2,L,E)

get the last item of list L and store it in LAST.

last(L,LAST)

append list L2 to list L1 and store the resulting list in L. Append "c" to "a" and "b", resulting in a list containing "a", "b", and "c".

append(L1,L2,L)
append(['a','b'],["c"],ABC)

sort list L and store the sorted list in SORTED. Duplicates are removed.

sort(L,SORTED)

9.7.8. User-Defined Prolog Functions

For complex restrictions and calculations it may be useful to provide additional functions, e.g. to simplify the expressions or to share code. For the expression language pvProlog a code library can be defined for each model.
This is done on the **General Properties** page of a model by adding the property `ps:codelib:prolog` with the code as its value (see Figure 9.1, “Prolog Code Library Model Property”).

**Figure 9.1. Prolog Code Library Model Property**

Each model in a Configuration Space, including variant description models, can define code libraries. Code defined in one model is also available in all other models of the same configuration space. When defining the same function in more than one model, these function has to be marked as "multifile". If for instance the function `sum(N1,N2,Sum)` is defined in several models the corresponding code libraries have to contain the following line:

```
:- multifile sum/3.
```

Means the function `sum` with three arguments is defined in multiple models.

### 9.8. Expression Language pvSCL

The pure::variants expression language **pvSCL** is a simple language to express constraints, restrictions and calculations. It provides logical and relational operators to build simple but also complex boolean expressions. The direct element reference and attribute access syntax makes **pvSCL** expressions more compact than **pvProlog** expressions.

The language is based on an simple object model. An object has an identity, attributes (data) and functions which can be applied to it. Some functions can be used without an explicit object context. Objects represent either simple data items such as numbers, or collections of objects; or in many cases they represent pure::variants model items such as elements or models.

#### 9.8.1. How to read this reference

The reference use the term **context** to denote the object to which an operator is applied to. This term is not to be confused with the keywords `context/CONTEXT`, which deliver a special object references, see details below.

#### 9.8.2. Comments

Expressions can be commented. A comment is started with a slash immediately followed by a star. The comment itself can span multiple lines. It is ended with a star immediately followed by a slash. Comments are ignored when an expression is evaluated.
9.8.3. Boolean Values

Expressions can resolve to a boolean value, i.e. TRUE or FALSE. An expression is said to fail if its boolean value is FALSE, and to succeed otherwise. Boolean values have type `ps:boolean`.

### Syntax

- `TRUE`
- `FALSE`

### Examples

- `NOT(TRUE = FALSE)`

9.8.4. Numbers

Numbers can either be decimal and hexadecimal integers, or floating point numbers. Hexadecimal integers are introduced by 0x or 0X followed by digits and / or characters between a and f. Floating point numbers contain a decimal point and / or positive or negative exponent.

Integers have type `ps:integer`, and floating point numbers have type `ps:float`.

### Examples

- `100`
- `10e2`
- `150e-3`
- `0xFF00`
- `1.5`
- `5.5E+3`

9.8.5. Arithmetics

Numbers can be negated, added up, subtracted, multiplied, and divided. If at least one operand of an arithmetic operation has floating point type, the result also will have floating point type.

Arithmetic operators have a higher precedence than comparison operators and a lower precedence than conditionals. Addition and subtraction have a lower precedence than multiplication and division. That means, 2*3+3*2 is calculated as (2*3)+(3*2)=6 instead of 2*(3+3)*2=24.

### Syntax

- `expr + expr`
- `expr - expr`
- `expr * expr`
- `expr / expr`
- `-expr`

### Examples

- `5 * 5 + 2 * 5 * 6 + 6 * 6`
- `-(8 * 10) + (10 * 8)`
- `-0xFF / 5`

9.8.6. Strings

Strings are sequences of characters and escape sequences enclosed in single quotation marks. The allowed characters are those of the Unicode character set. Strings have type `ps:string`.

Following escape sequences are supported.

<table>
<thead>
<tr>
<th>Escape Sequence</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>\n</td>
<td>New line</td>
</tr>
<tr>
<td>Escape Sequence</td>
<td>Meaning</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------</td>
</tr>
<tr>
<td>\t</td>
<td>Horizontal tabulator</td>
</tr>
<tr>
<td>\b</td>
<td>Backspace</td>
</tr>
<tr>
<td>\r</td>
<td>Carriage return</td>
</tr>
<tr>
<td>\f</td>
<td>Form feed</td>
</tr>
<tr>
<td>'</td>
<td>Single quotation mark</td>
</tr>
<tr>
<td>&quot;</td>
<td>Quotation mark</td>
</tr>
<tr>
<td>\</td>
<td>Backslash</td>
</tr>
<tr>
<td>\0 - \777</td>
<td>Octal character code</td>
</tr>
<tr>
<td>\u0000 - \u00ff</td>
<td>Unicode character code</td>
</tr>
</tbody>
</table>

Strings can be concatenated with other strings and numbers using the plus operator. The result is a new string containing the source strings and numbers in the order they were concatenated.

### Syntax

```
'characters including escape sequences'
```

### Examples

```
'Hello'
'10\44' = '10$'
'10\u20AC' = '10€'
'Line ' + 1 + '\n' + 'Line ' + 2
```

#### 9.8.7. Collections

Collections are lists or sets of values of the same type. Lists may contain one and the same value twice, whereas sets only contain unique values. The type of lists either is `ps:list` or the value type followed by `[]`, e.g. `ps:string[]` for a list of strings. The type of sets either is `ps:set` or the value type followed by `{}`, e.g. `ps:integer{}` for a set of integers.

Collection literals have list type. Their items are constructed from the values of any expressions, particularly nested collections, and must have the same type.

### Syntax

```
{ expr, expr, ... }
```

### Examples

```
{spring', 'summer', 'autumn', 'winter'}
{1, 2, 3}
```

#### 9.8.8. Value Comparison

Expressions can be compared based on their values. For this purpose the expressions are evaluated to their values first, and then the comparison operator is applied to the values resulting in TRUE or FALSE.

Two numbers are compared based on their numeric values, two strings lexically, two collections item by item, two booleans by their boolean values, and model and element references by their ID.

Comparing values of incompatible types will cause the operands to be converted to its string representation and to be compared lexically. Beginning with pure::variants 4.0.2, a warning marker will be created during evaluation to inform the user about that. All combinations of disjoint types are incompatible for comparison, except the combination `ps:integer` and `ps:float`. To compare the string representation of disjoint-typed values without creating a warning, an explicit conversion using the function `pv:ToString()` can be used.

Following comparison operators are supported.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>=</td>
<td>Yields TRUE if both operands have the same value.</td>
</tr>
</tbody>
</table>
### Comparison Operators

<table>
<thead>
<tr>
<th>Operator</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;&gt;</code></td>
<td>Yields TRUE if the operands have different values.</td>
</tr>
<tr>
<td><code>&gt;</code></td>
<td>Yields TRUE if the left operand's value is greater than the right operand's value.</td>
</tr>
<tr>
<td><code>&lt;</code></td>
<td>Yields TRUE if the left operand's value is less than the right operand's value.</td>
</tr>
<tr>
<td><code>&gt;=</code></td>
<td>Yields TRUE if the left operand's value is greater than or equals the right operand's value.</td>
</tr>
<tr>
<td><code>&lt;=</code></td>
<td>Yields TRUE if the left operand's value is less than or equals the right operand's value.</td>
</tr>
</tbody>
</table>

The types `ps:boolean`, `ps:element`, and `ps:model` do not have a natural order. Thus, the operators `<`, `<=`, `>`, and `>=` are evaluated using the lexical order of their string representation. Beginning with pure::variants 4.0.2, a warning marker will be created during evaluation to inform the user about this kind of comparison.

Comparison operators have a lower precedence than arithmetic operators but a higher precedence than logical operators.

**Syntax**

```
expr = expr
expr <> expr
expr > expr
expr < expr
expr >= expr
expr <= expr
```

### 9.8.9. SELF and CONTEXT

The keywords `SELF` and `CONTEXT` are context dependent name references. The type of `SELF` and `CONTEXT` is `ps:model` if a model is referenced, `ps:element` for an element, `ps:relation` for a relation, `ps:attribute` for an attribute, and `ps:constant` for an attribute value.

<table>
<thead>
<tr>
<th>Model Object</th>
<th>SELF</th>
<th>CONTEXT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Constraint</td>
<td>Element containing the constraint</td>
<td>Model containing the constraint</td>
</tr>
<tr>
<td>Restriction on element</td>
<td>Element containing the restriction</td>
<td>Element containing the restriction</td>
</tr>
<tr>
<td>Restriction on relation</td>
<td>Relation containing the restriction</td>
<td>Element containing the relation</td>
</tr>
<tr>
<td>Restriction on attribute</td>
<td>Attribute containing the restriction</td>
<td>Element containing the attribute</td>
</tr>
<tr>
<td>Restriction on attribute value</td>
<td>Attribute value containing the restriction</td>
<td>Element containing the attribute value</td>
</tr>
<tr>
<td>Attribute value calculation</td>
<td>Attribute value being calculated</td>
<td>Element containing the attribute value</td>
</tr>
</tbody>
</table>

**Syntax**

```
SELF
CONTEXT
```

**Examples**

```
SELF AND SELF->value = 5
CONTEXT IMPLIES SELF <> 0
```

### 9.8.10. Name and ID References

Models, elements, and attributes can be referenced by their unique identifiers. Models can also be referenced by their names, and elements by their unique names, optionally prefixed by the name of the model containing the element. For a referenced model the result type is `ps:model`, for an element `ps:element`, and for an attribute `ps:attribute`.
Elements can be referenced across linked variants, i.e. variant collections, instances, and references, by means of a path name. Path names navigate to elements in another variant along the variant elements in a variant hierarchy. Variant elements are elements with type \textit{ps:variant} representing the root element of a linked variant.

<table>
<thead>
<tr>
<th>Path Name Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>\texttt{variant-name:name}</td>
<td>Relative path name</td>
</tr>
<tr>
<td>\texttt{:name}</td>
<td>Absolute path name</td>
</tr>
<tr>
<td>\texttt{parent:name}</td>
<td>Parent variant navigation</td>
</tr>
<tr>
<td>\texttt{variant-collection-or-instance-name[3]:name}</td>
<td>Anonymous variant navigation for variant collections and instances</td>
</tr>
</tbody>
</table>

A name is resolved as follows.

1. If \textit{name} or \textit{model-name} equals "context", "CONTEXT", "self", or "SELF"
   • resolves to the context dependent name reference CONTEXT or SELF
2. If \textit{name} is the name of a visible local variable, iterator or accumulator
   • resolves to the local variable, iterator or accumulator
3. If \textit{name} is the unique name of an element
   • resolves to the element
4. If \textit{element-name} is the unique name of an element in model \textit{model-name}
   • resolves to the element
5. If \textit{name} is the name of a model
   • resolves to the model
6. If it is an absolute \textit{path-name}
   • resolve name without the leading : to an element or model
7. If it is a \textit{path-name} with parent variant navigation
   • resolve name in the context of the parent variant of the current variant to an element
8. If it is a \textit{path-name} with anonymous variant navigation
   • resolve name in the context of the specified variant to an element
9. Otherwise it is a relative name
   • resolve as full qualified name to an element or model

**Syntax**

\begin{verbatim}
@id
name
model-name.element-name
path-name
\end{verbatim}

**Examples**

\begin{verbatim}
@isdkd
Frontdoor
Doors.Backdoor
Residence:Frontdoor:Color->value = 'white'
DoubleLock IMPLIES parent:parent:Manson
House.Doors[1] AND House.Doors[1]:Type->number = '113a'
\end{verbatim}
9.8.11. Element Existence Check

Elements can be referenced independently of their selection, i.e. existence, in the current variant.

To check the existence of an element explicitly, meta-attribute \texttt{pv:Selected} can be called on that element returning \texttt{TRUE} if it is selected and thus exists in the variant.

But there are also contexts in which the existence of elements is checked implicitly. These contexts are:

- Constraint (final value)
- Condition of a conditional
- Operand of operator \texttt{NOT}
- Left and right operand of operator \texttt{XOR}
- Left operand of operators \texttt{AND} and \texttt{OR}
- Right operand of operators \texttt{AND} and \texttt{OR} if left operand resolves to \texttt{FALSE}
- Left and right operand of operator \texttt{EQUALS}
- Left operand of operators \texttt{IMPLIES}, \texttt{REQUIRES}, \texttt{RECOMMENDS}, \texttt{CONFLICTS} and \texttt{DISCOURAGES}
- Right operand of operators \texttt{IMPLIES}, \texttt{REQUIRES}, \texttt{RECOMMENDS}, \texttt{CONFLICTS} and \texttt{DISCOURAGES} if left operand resolves to \texttt{FALSE}

Examples

Black OR White
IF Winter THEN Snow->pv:Selected ELSE Sunshine->pv:Selected ENDIF
Diesel RECOMMENDS ParticleFilter
NOT(High) IMPLIES Low


Attributes and meta-attributes can be accessed using the call operator. The left operand of the call operator is the context of the call, the right operand the attribute or meta-attribute to call. It is an error if there is no attribute or meta-attribute with the given name for the context of a call.

If the context has model or element type, ordinary model and element attributes can be accessed. The result type is \texttt{ps:attribute}.

The value of an attribute is automatically accessed in all contexts a value is required, e.g. operand of a logical, relational, arithmetic, or comparison operator. Meta-attribute \texttt{pv:Get} can be used to access an attribute value explicitly. For an attribute with collection type a specific value can be accessed by specifying the index of the value as argument to the call (function call syntax).

The context types meta-attributes can be called on depend on the implementation of a meta-attribute. Meta-attributes may accept an argument list (function call syntax). The result of calling a meta-attribute also depends on its implementation. A meta-attribute with the same name as an ordinary attribute of a model or element hides that attribute.

Syntax

<table>
<thead>
<tr>
<th>context-expr</th>
<th>attr-name</th>
</tr>
</thead>
<tbody>
<tr>
<td>context-expr</td>
<td>attr-name(index-expr)</td>
</tr>
<tr>
<td>context-expr</td>
<td>meta-attr-name</td>
</tr>
<tr>
<td>context-expr</td>
<td>meta-attr-name(expr, expr, ...)</td>
</tr>
</tbody>
</table>

Examples

product->version > 3
seasons->names = { 'spring', 'summer', 'autumn', 'winter' }
seasons->names(1) = 'summer' AND seasons->names(2) = 'autumn'
seasons->names->pv:Size = 4
9.8.13. Relations

Expressions can be set in relation to each other. For this purpose the expressions are evaluated to their boolean values. It is an error if this conversion is not possible. The relational operator is then applied to the boolean values resulting in TRUE or FALSE.

Following relational operators are supported.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>REQUIRES</td>
<td>Evaluates to TRUE, iff a) both operands evaluate to TRUE or b) the left operand evaluates to FALSE. In the latter case, the right operand will not be evaluated.</td>
</tr>
<tr>
<td>IMPLIES</td>
<td>Same as REQUIRES.</td>
</tr>
<tr>
<td>CONFLICTS</td>
<td>Evaluates to TRUE, iff a) the left operand evaluates to TRUE and the right operand evaluates to FALSE or b) the left operand evaluates to FALSE. In the latter case, the right operand will not be evaluated.</td>
</tr>
<tr>
<td>RECOMMENDS</td>
<td>Like REQUIRES but always yields TRUE.</td>
</tr>
<tr>
<td>DISCOURAGES</td>
<td>Like CONFLICTS but always yields TRUE.</td>
</tr>
<tr>
<td>EQUALS</td>
<td>Evaluates to TRUE, iff either both operands evaluate to TRUE or both operands evaluate to FALSE.</td>
</tr>
</tbody>
</table>

Relational operators have a lower precedence than conditionals, and logical and arithmetic operators.

Syntax

expr IMPLIES expr
expr REQUIRES expr
expr CONFLICTS expr
expr RECOMMENDS expr
expr DISCOURAGES expr
expr EQUALS expr

Examples

car REQUIRES wheels
legs->number = 4 CONFLICTS human

9.8.14. Logical Combinations

Expressions can be logically combined. For this purpose the expressions are evaluated to their boolean values. It is an error if this conversion is not possible. The logical operator is then applied to the boolean values resulting in TRUE or FALSE.

Following logical operators are supported.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>AND</td>
<td>Binary operator that yields TRUE if both operands are TRUE.</td>
</tr>
<tr>
<td>OR</td>
<td>Binary operator that yields TRUE if at least one operand is TRUE. If the first operand is TRUE then the second operand will not be evaluated.</td>
</tr>
<tr>
<td>XOR</td>
<td>Binary operator that yields TRUE if exactly one operand is TRUE.</td>
</tr>
<tr>
<td>NOT</td>
<td>Unary operator that yields TRUE if the operand is FALSE.</td>
</tr>
</tbody>
</table>
Logical operators have a lower precedence than comparison operators but a higher precedence than relational operators.

Syntax

<table>
<thead>
<tr>
<th>expr AND expr</th>
</tr>
</thead>
<tbody>
<tr>
<td>expr OR expr</td>
</tr>
<tr>
<td>expr XOR expr</td>
</tr>
<tr>
<td>NOT(expr)</td>
</tr>
</tbody>
</table>

Examples

<table>
<thead>
<tr>
<th>be OR NOT(be)</th>
</tr>
</thead>
<tbody>
<tr>
<td>cabriolet XOR sunroof</td>
</tr>
</tbody>
</table>

### 9.8.15. Conditionals

Conditionals allow to evaluate alternative expressions depending on the boolean value of a condition. If boolean-condition-expr evaluates to TRUE, expression consequence-expr is evaluated to determine the result of the conditional expression. Otherwise, expression alternative-expr is evaluated. It is an error if boolean-condition-expr can not be evaluated to TRUE or FALSE.

Conditionals can occur everywhere expressions are allowed. This means in particular that conditionals can be nested. Conditionals have a higher precedence than relational, logical, arithmetic and compare operators.

Syntax

| IF condition-expr THEN consequence-expr ELSE alternative-expr ENDIF |

Examples

| IF summer THEN weather->temperature >= 25 ELSE IF winter THEN weather->temperature <= 5 ELSE weather->temperature > 5 AND weather->temperature < 25 ENDIF ENDIF |

### 9.8.16. Variable Declarations

The LET keyword declares at least one variable with name var-name and initializes it with the value of expression init-expr. The variable is visible only in the expression following keyword IN, and in the init-expr of subsequent variable declarators.

Variable declarations can occur everywhere expressions are allowed. To avoid name conflicts it is recommended to use own namespaces for the variable names (e.g. my:var-name instead of var-name).

The result of a variable declaration is the value of the expression following keyword IN.

Syntax

| LET var-name = init-expr, var-name = init-expr, ... IN expr |

Examples

| LET doors = car->frontDoors + car->rearDoors, cabrio = (doors = 2), limousine = (doors = 4) IN cabrio OR limousine |

### 9.8.17. Function Calls

A function call executes the built-in or user-defined function fct-name with the given argument list and returns the value calculated by the function. It is an error if the function does not exist.

Syntax

| fct-name(expr, expr, ...) |
9.8.18. Iterators

Iterators are special functions able to iterate collections. For each collection item expression `expr` is evaluated. The current collection item is accessible in the expression using iterator variable `iter-name`, which is visible there only. The value of an iterator function call depends on the implementation of that function.

Syntax

\[
\text{fct-name(iter-name | expr)}
\]

Examples

```pvscl
accounts->pv:Children() ->
pv:ForAll(account | account->balanced = TRUE)
```

9.8.19. Accumulators

Accumulators are special functions able to iterate collections. For each collection item expression `expr` is evaluated and its value is assigned to the accumulator variable `acc-name`. The initial value of accumulator variable `acc-name` is the value of expression `acc-init-expr`. The current collection item is accessible in the expression using iterator variable `iter-name`. Both variables, `iter-name` and `acc-name`, are visible in expression `expr` only.

The value of an accumulator function call is the final value of the accumulator variable.

Syntax

\[
\text{fct-name(iter-name; acc-name = acc-init-expr | expr)}
\]

Examples

```pvscl
accounts->pv:Children() ->
pv:Iterate(account; sum = 0 | sum + account->deposit) > 0
```

9.8.20. Function Definitions

The DEF keyword defines a function with name `fct-name` and the given parameter list. The parameter names are visible only in expression `fct-body-expr`. The result of calling a so defined function is the value of the `fct-body-expr` calculated for the given argument list.

Function definitions can only occur before any other pvSCL expression and evaluate to TRUE if not followed by an expression. To avoid name conflicts it is recommended to use own namespaces for the function and parameter names (e.g. `my:fct-name` instead of `fct-name`, and `my:param-name` instead of `param-name`).

If not in a pvSCL code library, a so defined function is visible only in the constraint, restriction or calculation containing the function definition.

Syntax

\[
\text{DEF fct-name(param-name,param-name,...) = fct-body-expr ;
...}
expr
\]

Examples

```pvscl
DEF min(x,y) = (IF x <= y THEN x ELSE y ENDIF);
DEF max(x,y) = (IF x >= y THEN x ELSE y ENDIF);
max(spare->x,spare->y) <= min(part->x,part->y)
```

9.8.21. Function Library

`pv:Abs()`

Get the absolute value of the context which must be a number.

Examples

```pvscl
(outside->temp - inside->temp)->pv:Abs() > 10
```
**pv:AllChildren()**

Get all children of the context which must be either a model, element, or attribute. Fails otherwise. All children of a model are the elements of the model, of an element are the elements of the sub-tree with this element as root (excluding this element), and of an attribute its attribute values.

 Examples

```plaintext
self->pv:AllChildren() -
    pv:ForAll(child | NOT(child->pv:Selected) )
```

**pv:Append(expr)**

Append the value of `expr` to the context which must be a collection. It is an error if the type of the value is not compatible to the item type of the collection.

 Examples

```plaintext
{1,2,3}->pv:Append(4) = {1,2,3,4}
```

**pv:AppendAll(collection)**

Append the value of `collection` to the context which must also be a collection. It is an error if the types of both collection don't match.

 Examples

```plaintext
{1,2,3}->pv:AppendAll({4,5,6}) = {1,2,3,4,5,6}
```

**pv:AsList()**

Convert the context to a list. It is an error if the context does not have collection type.

 Examples

```plaintext
{1,1,2,3}->pv:AsList() = {1,1,2,3}
```

**pv:AsSet()**

Convert the context to a set. It is an error if the context does not have collection type. If the context has list type, all duplicate items of the list are removed.

 Examples

```plaintext
{1,1,2,3}->pv:AsSet() = {1,2,3}
```

**pv:Attribute(name)**

Get the attribute with the given name. Fails if the context does neither have model nor element type, or no attribute with the name exists.

 Examples

```plaintext
self->pv:Attribute('speed') = 100
```

**pv:Attributes(), pv:Attributes('type')**

Get all attributes of the context, optionally with the (exact) type. Fails if the context does neither have model nor element type, or if no attribute (with given type) exists.

 Examples

```plaintext
self->pv:Attributes('ps:integer')
```

**pv:Characters()**

Get the characters of the context string as list.

 Examples

```plaintext
'Text'->pv:Characters() = {'T','e','x','t'}
```
**pv:Child(index)**

Get the child of the context with the given index. Fails if the context does neither have model, element, nor attribute type, or the index is invalid. The child of a model is an element, of an element an element, and of an attribute an attribute value.

**Examples**

```
self->pv:Child(0)->pv:Selected
```

**pv:Children()**

Get the direct children of the context which must be either a model, element, or attribute. Fails otherwise. The children of a model is a list containing the root element of the model, of an element its child elements, and of an attribute its attribute values.

**Examples**

```
alternatives->pv:Children()->pv:Size() >
alternatives->ps:SelectedChildren()->pv:Size()
```

**pv:ChildrenByState(state), pv:ChildrenByState(state,selector)**

Get all children of the context element with the given selection state and optionally given selector, as `ps:element[]` . Fails if the context does not have element type.

**Examples**

```
features->pv:ChildrenByState('ps:excluded','ps:user')->
pv:ForAll(element |
pv:Inform('User excluded element ' + element->pv:Name()))
```

**pv:Class()**

Get the class of the context, as `ps:string`, which must be a configuration space, model, element, relation, attribute, or attribute value. Fails otherwise. The class of a configuration space is `ps:configspace`, of a model `ps:model`, of an element the element class, of a relation the relation class, of an attribute `ps:attribute`, and of an attribute value the type of the attribute value.

**Examples**

```
context->pv:Class() = 'ps:model'
IMPLIES self->pv:Class() = 'ps:element'
```

**pv:Collect(iterator)**

Iterate the context collection and evaluate the iterator expression for each element of the collection. Return a new collection with all the evaluation results. The return type is `ps:list`.

**Examples**

```
products->pv:Children()->
pv:Collect(p | IF p->stocked THEN 1 ELSE 0 ENDIF)->
pv:Sum() > 50
```

**pv:Contains(expr)**

Check whether the evaluation result of expression `expr` is contained in the context, which must be a collection.

**Examples**

```
{1,2,3}->pv:Contains(3) = true
```

**pv:ContainsAll(collection)**

Check whether each value of `collection` is contained in the context, which must be a collection.

**Examples**

```
{1,2,3}->pv:ContainsAll({1,2}) = true
```
Function Library

**pv:Element(name-or-id)**

Get the element with the given unique name or identifier. If called on a model only elements in that model are considered. It is an error if the element does not exist or the function is called on anything else than a model.

**Examples**

```
Model->pv:Element('winter')->pv:Selected() = true
```

**pv:DefaultSelected()**

Check if the context element is selected by default. Fails if the context does not have element type.

**Examples**

```
radio->pv:DefaultSelected() AND speakers->number = 2
```

**pv:Fail(message)**

Show an error message. Always returns TRUE. Let the model evaluation fail.

**Examples**

```
doors->number = 2 OR
  doors->number = 4 OR
  pv:Fail('Invalid number of doors [' + doors->number + ']')
```

**pv:Flatten()**

Flatten the context, which has to be a collection.

**Examples**

```
LET
  list1 = {1,2,3,4},
  list2 = {{0},list1,(5)}
IN
list2->pv:Flatten()->pv:ToString()
```

**pv:Floor()**

Get the largest (closest to positive infinity) integer value that is less than or equal to the context floating point number and is equal to a mathematical integer. Fails if the context does not have floating point number type. The return type is `ps:integer`.

**Examples**

```
3.5->pv:Floor = 3
```

**pv:ForAll(iterator)**

Iterate the context collection and evaluate the iterator expression for all items. Return FALSE if at least for one item the expression evaluates to FALSE.

**Examples**

```
bugs->pv:Children()->
  pv:ForAll(bug | bug->state = 'fixed')
```

**pv:Get(), pv:Get(index)**

Get the value of an attribute if the context is an attribute or attribute value, or return the input value. If an index is given and the context is an attribute, return the attribute value at that index, or fail if the index is invalid.

**Examples**

```
seasons->order->pv:Get(2) = 'autumn'
```

**pv:HasAttribute(name)**

Return TRUE if the attribute with the given name exists on the context model or element, FALSE otherwise. Fails if the context does not have model or element type.
### pv:HasElement(name-or-id)

Return TRUE if the element with the given name or identifier exists, FALSE otherwise. If called on a model only elements in that model are considered. It is an error if the function is called on anything else than a model.

**Examples**

```
Model->pv:HasElement('seasons') = true
```

### pv:HasModel(name-or-id)

Return TRUE if the model with the given name or identifier exists, FALSE otherwise.

**Examples**

```
pv:HasModel('Weather') = true
```

### pv:ID()

Get the unique identifier of the context, as *ps:string*, which must be a model, element, attribute, constant, or relation, or fail otherwise.

**Examples**

```
context->pv:ID() <> ''
```

### pv:IndexOf(sub-string)

Return the index (starting at 0) of the first occurrence of the given sub-string, or sub-collection within the context, or -1 if the given item was not found. It is an error if the context does not have string or collection type. The resulting index has type *ps:integer*.

**Examples**

```
'Hello World'->pv:IndexOf('World') = 6
```

### pv:Inform(message)

Show an informational message. Always returns TRUE.

**Examples**

```
sportedition AND NOT(rearspoiler) RECOMMENDS
pv:Inform('Rear spoiler recommended for sport edition')
```

### pv:IsContainer()

Return TRUE if the context is a container, i.e. a collection like list or set.

**Examples**

```
self->pv:IsContainer() RECOMMENDS self->pv:Size() > 1
```

### pv:IsFixed()

Return TRUE if the context attribute has a fixed value. Fails if the context does not have attribute type.

**Examples**

```
self->pv:IsFixed() = TRUE
```

### pv:IsInheritable()

Return TRUE if the context attribute is inheritable. Fails if the context does not have attribute type.

**Examples**

```
self->pv:IsInheritable() = FALSE
```

### pv:IsKindOf(type)


Return TRUE if the type of the context object is the same as the type given as argument, or a type derived from it.

Examples

```
seasons->pv:IsKindOf('ps:feature') = TRUE
```

**pv:Item(index)**

Get the item with the given index (starting at 0) of the context collection or the character with the given index of a string. Fail if the context does not have collection or string type, or the index is invalid.

Examples

```
seasons->pv:Children()->
pv:Item(0)->pv:Name() = 'spring'
```

**pv:Iterate(accumulator)**

Iterate the context collection and return the value accumulated by evaluating the iterator expression for each element of the collection. The return type is that of the accumulated value.

Examples

```
pv:Inform('Current price is ' +
  products->pv:SelectedChildren()->
  pv:Iterate(product; price = 0 | price + product->price) + '$')
```

**pv:Max()**

Return the maximal number of the context collection of numbers, or fail if the context is not a number collection. The return type is `ps:integer` or `ps:float` depending on the type of the collection. The maximal value of an empty collection is 0.

Examples

```
{1,2,3,4}->pv:Max() = 4
```

**pv:Min()**

Return the minimal number of the context collection of numbers, or fail if the context is not a number collection. The return type is `ps:integer` or `ps:float` depending on the type of the collection. The minimal value of an empty collection is 0.

Examples

```
{1,2,3,4}->pv:Min() = 1
```

**pv:Model(), pv:Model(name-or-id)**

Get the model, as `ps:model`, containing the context element, or the model with the given name or identifier if not called on an element. It is an error if the function is called on anything else than an element or configuration space.

Examples

```
NOT(context->pv:Model()->pv:RootElement())
IMPLIES pv:Fail('Root element of model ' +
  context->pv:Model()->pv:Name() + ' must be selected')
```

**pv:Models(), pv:Models(type)**

Get all models of a configuration space as `ps:model[]` collection. Optionally accepts a model type as argument to get only the models of a specific type. The parameter type is of `ps:string` type. See Table 5.1, “Mapping between input and Variant Result Model types” for the list of applicable type names. If applied on an object, call fails if the object is not of configuration space type (`ps:configspace`).

Examples

```
pv:Models('ps:fm')->pv:Size() > 1
/* applicable everywhere, number of feature models more than 1 */
context->pv:Parent()->pv:Models()->pv:Size() > 1
/* this form only in constraints*/
```
/* context of constraint is a model, parent is config space */

**pv:Name()**

Get the name of the context, as \textit{ps:string} , which must be a model, element, or attribute, or fail otherwise.

**Examples**

```
self->pv:SelectionState() = 'ps:nonselectable' IMPLIES
pv:Warn('Feature ' + self->pv:Name() + ' is now non-selectable!')
```

**pv:Parent()**

Get the parent of the context, or fail if the context is not a model, element, relation, attribute, or attribute value. The parent of a model is the corresponding configuration space, of an element its parent element, or the corresponding model if it is the root element, of a relation the element on which the relation is defined, of an attribute the element on which the attribute is defined, and of an attribute value the attribute containing the value.

**Examples**

```
summer->pv:Parent()->pv:Name() = 'seasons'
```

**pv:Prepend(expr)**

Prepend the value of \textit{expr} to the context which must be a collection. It is an error if the type of the value is not compatible to the item type of the collection.

**Examples**

```
(1,2,3)->pv:Prepend(4) = {4,1,2,3}
```

**pv:PrependAll(collection)**

Prepend the values of \textit{collection} to the context, which must be a collection. It is an error if the types of collections are not compatible.

**Examples**

```
(1,2,3)->pv:PrependAll({4,5,6}) = {4,5,6,1,2,3}
```

**pv:PVVersion()**

Get the current version of pure::variants as \textit{ps:version}. The result contains the complete version string, e.g. ‘4.0.7.685’. To check against specific versions, comparison operators can be used.

**Examples**

```
pv:PVVersion() >= '4.0.7.*' /* at least version 4.0.7 */
pv:PVVersion() = '4.0.*' /* any service release of the 4.0 branch */
pv:PVVersion() < '4.*' /* any release before version 4.x */
```

**pv:Relations(), pv:Relations(type)**

Get the relations of class \textit{ps:dependencies} defined on the context element, as \textit{ps:relation[]}. Optionally accepts the relation type as argument to get only relations of the given type. Fails if the context does not have element type.

**Examples**

```
specialedition->pv:Relations('my:extras')->
pv:ForAll(r | re->pv:Targets()->pv:Size() <> 0)
```

**pv:Remove(item)**

If the context, which must be a collection, contains the given element, this element is removed from the context.

**Examples**

```
(1,2,3,2,1)->pv:Remove(2) = {1,3,1}
```

**pv:RemoveAll(collection)**
If the context, which must be a collection, contains an element from the given collection, this element is removed from the context.

**Examples**

\[
\{1,2,3,2,1\} \rightarrow \text{pv:RemoveAll}\{1,3\} = \{2,2\}
\]

**pv:RetainAll(collection)**

If an element of the given collection is not contained in the context, which has to be a collection, it will be removed from the context.

**Examples**

\[
\{1,2,3,2,1\} \rightarrow \text{pv:RetainAll}\{2,3\} = \{2,3,2\}
\]

**pv:Reverse()**

Reverses the context, which has to be a collection.

**Examples**

\[
\{1,2,3,4,5\} \rightarrow \text{pv:Reverse}() = \{5,4,3,2,1\}
\]

**pv:RootElement()**

Get the root element of the context model, as \(ps:element\). Fails if the context does not have model type.

**Examples**

\[
\text{context} \rightarrow \text{pv:RootElement()} \rightarrow \text{pv:Selected()} = \text{TRUE}
\]

**pv:Round()**

Return the closest integer of the context floating point number, or fail if the context does not have floating point number type. The context number is rounded to an integer by adding 0.5 and taking the floor of the result. The return type is \(ps:integer\).

**Examples**

\[
3.5 \rightarrow \text{pv:Round}() = 4
\]

**pv:Select(iterator)**

Iterate the context collection and add all the collection items to the result list for which the iterator expression evaluates to TRUE. The return type is the type of the context collection.

**Examples**

\[
\text{customers} \rightarrow \text{pv:Select(cust} \rightarrow \text{mer->balanced = FALSE)} \rightarrow \\
\text{pv:ForAll(cust} \rightarrow \text{omer)} \\
\text{pv:Inform('Send customer ' + cust} \rightarrow \text{omer->id + ' a reminder'})
\]

**pv:Selected()**

Return TRUE if the context element or attribute exists in the variant, FALSE otherwise. Fails if the context does not have element or attribute type.

**Examples**

\[
\text{self} \text{EQUALS self->pv:Selected()}
\]

**pv:SelectedChildren(), pv:SelectedChildren(type)**

Get all children in the sub-tree of the context element that exist in the variant, as \(ps:element/\). Optionally accepts an element type as argument to get only child elements with the given type. Fails if the context does not have element type.

**Examples**

\[
\text{parts} \rightarrow \text{pv:SelectedChildren('my:engine')}
\]
**Function Library**

### pv:Size()

Get the number of attribute values for attribute types, collection items for collection types, or characters for string types as `ps:integer`. For any other context type, 1 is returned.

**Examples**

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>seasons-&gt;pv:Children()-&gt;pv:Size() = 4</code> AND <code>seasons-&gt;pv:SelectedChildren()-&gt;pv:Size() = 1</code></td>
<td></td>
</tr>
</tbody>
</table>

### pv:SelectionState()

Get the selection state of the context element, as `ps:string`. Fails if the context does not have element type. The selection state is one of `ps:selected`, `ps:excluded`, `ps:unselected`, or `ps:nonselectable`.

**Examples**

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>airbags-&gt;pv:SelectionState() = 'ps:excluded'</code></td>
<td></td>
</tr>
<tr>
<td><code>REQUIRES speed-&gt;max &lt; 30</code></td>
<td></td>
</tr>
</tbody>
</table>

### pv:Selector()

Get the selector of the context element, as `ps:string`. Fails if the context does not have element type. The selector is `ps:user` for user selections, `ps:auto` for selections caused by the auto resolver, `ps:mapped` for selections caused by mapped features, `ps:implicit` for implicitly selected elements, `ps:inherited` for inherited selections, or `none` for elements that neither are explicitly or implicitly selected nor excluded.

**Examples**

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>self IMPLIES self-&gt;pv:Selector() = 'ps:user'</code></td>
<td></td>
</tr>
<tr>
<td>OR <code>pv:Inform('Feature ' + self-&gt;pv:Name() + ' was added automatically')</code></td>
<td></td>
</tr>
</tbody>
</table>

### pv:Size()

### pv:SubString(begin), pv:SubString(begin,end)

Return a new string, as `ps:string`, that is a sub-string of the context string. The sub-string begins at the specified `begin` index and extends to the `end-1` index or end of the context string. It is an error if the context does not have string type.

**Examples**

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>'Hello World'-&gt;pv:SubString(6) = 'World'</code></td>
<td></td>
</tr>
<tr>
<td><code>'smiles'-&gt;pv:SubString(1,5) = 'mile'</code></td>
<td></td>
</tr>
</tbody>
</table>

### pv:Sum()

Return the sum of all numbers in the context collection, or fail if the context is not a number collection. The return type is `ps:integer` or `ps:float` depending on the type of the collection. The sum of an empty collection is 0.

**Examples**

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>{1,2,3,4}-&gt;pv:Sum() = 10</code></td>
<td></td>
</tr>
</tbody>
</table>

### pv:Target(index)

Get the relation target with the given index of the context relation, as `ps:element`. Fails if the context does not have relation type.

**Examples**

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>self-&gt;pv:Target(0) XOR self-&gt;pv:Target(1)</code></td>
<td></td>
</tr>
</tbody>
</table>

### pv:Targets()

Get the relation targets of the context relation, as `ps:element[]`. Fails if the context does not have relation type.

**Examples**

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>`self-&gt;pv:Type() = 'ps:discourages' AND self-&gt;pv:Targets()-&gt;pv:ForAll(element</td>
<td></td>
</tr>
</tbody>
</table>
pv:parseFloat()

Convert the context number to a floating point number. Fails if the context does not have number type. The return type is ps:float.

Examples

<table>
<thead>
<tr>
<th>Context</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1.0</td>
</tr>
</tbody>
</table>

pv:toLowerCase()

Convert all characters of the context string to lower case. Fails if the context does not have string type. The return type is ps:string.

Examples

<table>
<thead>
<tr>
<th>Context</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>'Hello'</td>
<td>'hello'</td>
</tr>
</tbody>
</table>

pv:toString()

Return a string representation of the context object. The return type is ps:string.

Examples

<table>
<thead>
<tr>
<th>Context</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>'6'</td>
</tr>
</tbody>
</table>

pv:toUpperCase()

Convert all characters of the context string to upper case. Fails if the context does not have string type. The return type is ps:string.

Examples

<table>
<thead>
<tr>
<th>Context</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>'Hello'</td>
<td>'HELLO'</td>
</tr>
</tbody>
</table>

pv:type()

Get the type of the context as ps:string.

Examples

<table>
<thead>
<tr>
<th>Context</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>summer</td>
<td>'my:season'</td>
</tr>
</tbody>
</table>

pv:variationType()

Get the variation type of the context element or attribute, as ps:string. Fails if the context does not have element or attribute type. The variation type of attributes always is ps:mandatory, and of elements ps:mandatory, ps:optional, ps:or, or ps:alternative.

Examples

<table>
<thead>
<tr>
<th>Context</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>summer</td>
<td>'ps:alternative'</td>
</tr>
</tbody>
</table>

pv:vname(), pv:vname(language)

Get the visible name of the context, as ps:string, which must be an element, or fail otherwise. Optionally the language can be specified.

If no language is give the visible name with no specified language will be returned. If no such visible name exists any other visible name will be returned. If no visible name is defined for the element an empty string is returned. If a language is specified the visible name in the given language will be returned if available. If no such visible name exists the function falls back to the version without given language.

Examples

<table>
<thead>
<tr>
<th>Context</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>self</td>
<td>'ps:nonselectable'</td>
</tr>
</tbody>
</table>

pv:Warn(message)

Function Library
Show a warning message. Always returns TRUE.

Examples

\[
\text{car->wheels} > 4 \text{ IMPLIES pv:Warn('Too many wheels ('} + \text{car->wheels} + ') configured')
\]

### 9.8.22. User-Defined pvSCL Functions

For complex restrictions and calculations it may be useful to provide additional functions, e.g. to simplify the expressions or to share code. For the expression language pvSCL a code library can be defined in each model. This is done by entering the code into the pvSCL Code Library properties page of a model (see Figure 9.2, “pvSCL Code Library Model Property Page”).

![Figure 9.2. pvSCL Code Library Model Property Page](image)

Each feature or family model in a Configuration Space can define code libraries. Code defined in one model is also available in all other models of the same configuration space. Defining the same function in more than one model, will redefine the function. Since there is no explicit model loading order the used version of the function may differ.

### 9.9. XSLT Extension Functions

Several extension functions are available when using the XSLT processor integrated in the pure::variants XML Transformation System for model transformations and model exports. These extension functions are defined in own namespaces. Before they can be used in an XSLT script, the corresponding namespaces have to be included using the “xmlns” stylesheet attribute:

```xml
<?xml version="1.0" encoding="UTF-8"?>
<xsl:stylesheet version="1.0"

xmlns:xsl="http://www.w3.org/1999/XSL/Transform"
xmlns:pv="http://www.pure-systems.com/purevariants"
extension-element-prefixes="pv">

...any script content...
</xsl:stylesheet>
```

After including the namespace, the extension functions can be used in XPath expressions using the defined namespace prefix, e.g. `pv:hasFeature('F')`. 

186
The following extension functions are defined in the namespace "http://www.pure-systems.com/purevariants" and provide access to the pure::variants model information.

### Table 9.17. Extension functions providing model information

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>nodeset models()</td>
<td>Get all input models known to the transformer, i.e. the opened variant description model, and all Feature and Family Models of the Configuration Space without any modifications. See Section 5.9.2, “Variant Result Models” for more information about the transformation input. <strong>Note:</strong> In the pure::variants Server Edition this function returns an empty set. Access to the input models of the transformation is not supported in the pure::variants Server Edition.</td>
</tr>
<tr>
<td>nodeset model-by-id(string)</td>
<td>Get all variant Result Models known to the transformer having the given id. The Result Models are derived from the models of the Configuration Space describing a single concrete solution drawn from the solution family. See Section 5.9.2, “Variant Result Models” for more information about the transformation input.</td>
</tr>
<tr>
<td>nodeset model-by-name(string)</td>
<td>Get all Variant Result Models known to the transformer having the given name. The Variant Result Models are derived from the models of the Configuration Space describing a single concrete solution drawn from the solution family. See Section 5.9.2, “Variant Result Models” for more information about the transformation input.</td>
</tr>
<tr>
<td>nodeset model-by-type(string)</td>
<td>Get all Variant Result Models known to the transformer having the given type. The Variant Result Models are derived from the models of the Configuration Space describing a single concrete solution drawn from the solution family. Valid types are ps:vdm, ps:cfm, and ps:ccm. See Section 5.9.2, “Variant Result Models” for more information about the transformation input.</td>
</tr>
<tr>
<td>boolean hasFeature(string)</td>
<td>Return true if the feature, given by its unique name or id, is in the variant.</td>
</tr>
<tr>
<td>boolean hasComponent(string)</td>
<td>Return true if the component, given by its unique name or id, is in the variant.</td>
</tr>
<tr>
<td>boolean hasPart(string)</td>
<td>Return true if the part, given by its unique name or id, is in the variant.</td>
</tr>
<tr>
<td>boolean hasSource(string)</td>
<td>Return true if the source, given by its unique name or id, is in the variant.</td>
</tr>
<tr>
<td>boolean hasElement(string id)</td>
<td>Return true if the element, given by its unique id, is in the variant.</td>
</tr>
<tr>
<td>boolean hasElement(string name,string class,string type?)</td>
<td>Return true if the element, given by its unique name, class, and (optionally) type, is in the variant.</td>
</tr>
<tr>
<td>nodeset getElement(string id)</td>
<td>Return the element given by its unique id.</td>
</tr>
<tr>
<td>nodeset getElement(string name,string class,string type?)</td>
<td>Return the element given by its unique name, class, and (optionally) type.</td>
</tr>
<tr>
<td>nodeset getChildrenTargets(string id)</td>
<td>Return the full qualified ids of the children elements of the element with the given id.</td>
</tr>
<tr>
<td>nodeset getChildrenTargets(nodeset element)</td>
<td>Return the full qualified ids of the children elements of the given element.</td>
</tr>
<tr>
<td>nodeset getChildrenTargets(string ename,string eclass,string etype?)</td>
<td>Return the full qualified ids of the children elements of the element given by its unique name, class, and (optionally) type.</td>
</tr>
<tr>
<td>boolean hasAttribute(string id)</td>
<td>Return true if the attribute, given by its unique id, is in the variant.</td>
</tr>
<tr>
<td>boolean hasAttribute(nodeset element,string name)</td>
<td>Return true if the attribute, given by its name and the element it belongs to, is in the variant.</td>
</tr>
</tbody>
</table>
### XSLT Extension Functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>boolean hasAttribute(string eid, string name)</td>
<td>Return true if the attribute, given by its name and the id of the element it belongs to, is in the variant.</td>
</tr>
<tr>
<td>boolean hasAttribute(string ename, string eclass, string etype?, string name)</td>
<td>Return true if the attribute, given by its name and the unique name, class, and (optionally) type of the element it belongs to, is in the variant.</td>
</tr>
<tr>
<td>nodeset getAttribute(string id)</td>
<td>Return the attribute given by its unique id.</td>
</tr>
<tr>
<td>nodeset getAttribute(nodeset element, string name)</td>
<td>Return the attribute given by its name and the element it belongs to.</td>
</tr>
<tr>
<td>nodeset getAttribute(string eid, string name)</td>
<td>Return the attribute given by its name and the id of the element it belongs to.</td>
</tr>
<tr>
<td>nodeset getAttribute(string ename, string eclass, string etype?, string name)</td>
<td>Return the attribute given by its name and the unique name, class, and (optionally) type of the element it belongs to.</td>
</tr>
<tr>
<td>boolean hasAttributeValue(nodeset attribute)</td>
<td>Return true if the given attribute has a value.</td>
</tr>
<tr>
<td>boolean hasAttributeValue(string id)</td>
<td>Return true if the attribute given by its unique id has a value.</td>
</tr>
<tr>
<td>boolean hasAttributeValue(nodeset element, string name)</td>
<td>Return true if the attribute, given by its name and the element it belongs to, has a value.</td>
</tr>
<tr>
<td>boolean hasAttributeValue(string eid, string name)</td>
<td>Return true if the attribute, given by its name and the id of the element it belongs to, has a value.</td>
</tr>
<tr>
<td>boolean hasAttributeValue(string ename, string eclass, string etype?, string name)</td>
<td>Return true if the attribute, given by its name and the unique name, class, and (optionally) type of the element it belongs to, has a value.</td>
</tr>
<tr>
<td>nodeset getAttributeValue(nodeset attribute)</td>
<td>Return the values of the given attribute.</td>
</tr>
<tr>
<td>nodeset getAttributeValue(string id)</td>
<td>Return the values of the attribute given by its unique id.</td>
</tr>
<tr>
<td>nodeset getAttributeValue(nodeset element, string name)</td>
<td>Return the values of the attribute given by its name and the element it belongs to.</td>
</tr>
<tr>
<td>nodeset getAttributeValue(string eid, string name)</td>
<td>Return the values of the attribute given by its name and the id of the element it belongs to.</td>
</tr>
<tr>
<td>nodeset getAttributeValue(string ename, string eclass, string etype?, string name)</td>
<td>Return the values of the attribute given by its name and the unique name, class, and (optionally) type of the element it belongs to.</td>
</tr>
</tbody>
</table>

The following extension functions are defined in the namespace "http://www.pure-systems.com/xmlts" and provide basic information about the current transformation.

**Table 9.18. Extension functions providing transformation information**

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>string os()</td>
<td>Get the target system type. This is either the string &quot;win32&quot;, &quot;macosx&quot;, or &quot;linux&quot; (default).</td>
</tr>
<tr>
<td>string version()</td>
<td>Get the transformation system version.</td>
</tr>
<tr>
<td>string input-path()</td>
<td>Get the transformation input path.</td>
</tr>
<tr>
<td>string output-path()</td>
<td>Get the transformation output path.</td>
</tr>
<tr>
<td>string generate-id()</td>
<td>Generate an unique identifier.</td>
</tr>
<tr>
<td>nodeset current()</td>
<td>Get the node currently being transformed.</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>nodeset entry-points()</td>
<td>Get the transformation entry point list, i.e. a list of full qualified element IDs. Transformation modules can use this list to identify sub-trees of the input models that are to be transformed.</td>
</tr>
<tr>
<td>boolean below-entry-point(string id)</td>
<td>Return true if the given full qualified element ID denotes an element below a transformation entry point. Transformation modules can use this function to identify sub-trees of the input models that are to be transformed.</td>
</tr>
<tr>
<td>nodeset exit-points()</td>
<td>Get the transformation exit point list, i.e. a list of full qualified element IDs. Transformation modules can use this list to identify sub-trees of the input models that are to be ignored.</td>
</tr>
<tr>
<td>boolean above-exit-point(string id)</td>
<td>Return true if the given full qualified element ID denotes an element above a transformation exit point. Transformation modules can use this function to identify sub-trees of the input models that are to be ignored.</td>
</tr>
<tr>
<td>nodeset results-for(nodeset nodes?)</td>
<td>Get the transformation module results for the given nodes. If no argument is given, then the results for the context node are returned.</td>
</tr>
<tr>
<td>nodeset log(string message,number level?)</td>
<td>Add a logging message that is shown in the Console View. The first parameter is the message and the second the logging level (0-9). It is recommend to use a logging level between 4 (default) and 8 (detailed tracing). Returns the empty nodeset.</td>
</tr>
<tr>
<td>nodeset info(string message,string id?,nodeset related?)</td>
<td>Add an info message that is shown in the Problems View resp. as marker on a model element. The first parameter is the message. All other parameters are optional. The second is the ID of the context element of the info (used to place the marker), and the third is a set of IDs of related model elements. Returns the empty nodeset.</td>
</tr>
<tr>
<td>nodeset warning(string message,string id?,nodeset related?)</td>
<td>Add a warning message that is shown in the Problems View resp. as marker on a model element. The first parameter is the message. All other parameters are optional. The second is the ID of the context element of the info (used to place the marker), and the third is a set of IDs of related model elements. Returns the empty nodeset.</td>
</tr>
<tr>
<td>nodeset error(string message,string id?,nodeset related?)</td>
<td>Add an error message that is shown in the Problems View resp. as marker on a model element. The first parameter is the message. All other parameters are optional. The second is the ID of the context element of the info (used to place the marker), and the third is a set of IDs of related model elements. Returns the empty nodeset.</td>
</tr>
</tbody>
</table>

**Note**

Error messages may abort the XSLT script execution and the whole transformation.

**Table 9.19. Extension elements for logging and user messages**

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;log level=&quot;0-9&quot;&gt;message&lt;/log&gt;</code></td>
<td>Add a logging message that is shown in the Console View. The optional attribute &quot;level&quot; specifies the logging level (0-9). It is recommend to use a logging level between 4 (default) and 8 (detailed tracing).</td>
</tr>
<tr>
<td><code>&lt;info context=&quot;element id=&quot; related=&quot;nodeset&quot;&gt;message&lt;/info&gt;</code></td>
<td>Add an info message that is shown in the Problems View resp. as marker on a model element. The optional attribute &quot;context&quot; specifies the ID of the context element of the info (used to place the marker). The optional attribute &quot;related&quot; specifies a set of IDs of related model elements.</td>
</tr>
</tbody>
</table>
### Element Description

- `<warning context="element id" related="nodeset">message</warning>`
  - Add a warning message that is shown in the Problems View resp. as marker on a model element. The optional attribute "context" specifies the ID of the context element of the info (used to place the marker). The optional attribute "related" specifies a set of IDs of related model elements.

- `<error context="element id" related="nodeset">message</error>`
  - Add an error message that is shown in the Problems View resp. as marker on a model element. The optional attribute "context" specifies the ID of the context element of the info (used to place the marker). The optional attribute "related" specifies a set of IDs of related model elements.

#### Note

Error messages may abort the XSLT script execution and the whole transformation.

The following extension functions are defined in the namespace "http://www.pure-systems.com/path" and provide additional file operations.

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>string normalize(string path)</td>
<td>Normalized the given path for the current target platform.</td>
</tr>
<tr>
<td>string dirname(string path)</td>
<td>Get the directory part of the given path.</td>
</tr>
<tr>
<td>string filename(string path)</td>
<td>Get the file part of the given path.</td>
</tr>
<tr>
<td>string basename(string path)</td>
<td>Strip the file extension from the given path.</td>
</tr>
<tr>
<td>string extension(string path)</td>
<td>Get the file extension from the given path.</td>
</tr>
<tr>
<td>string absolute(string path)</td>
<td>Make the given path absolute (i.e. full path).</td>
</tr>
<tr>
<td>string add-part(string path,string part)</td>
<td>Add the given part to the path using the platform specific path delimiter.</td>
</tr>
<tr>
<td>number size(string file)</td>
<td>Get the size (in bytes) of the given file.</td>
</tr>
<tr>
<td>number mtime(string path)</td>
<td>Get the modification time of the given file or directory.</td>
</tr>
<tr>
<td>string cwd()</td>
<td>Get the current working directory.</td>
</tr>
<tr>
<td>string tempdir()</td>
<td>Get the directory for temporary files.</td>
</tr>
<tr>
<td>string delimiter()</td>
<td>Get the path delimiter of the target platform.</td>
</tr>
<tr>
<td>boolean exists(string path)</td>
<td>Return true if the given file or directory exists.</td>
</tr>
<tr>
<td>boolean is-dir(string path)</td>
<td>Return true if the given path points to a directory.</td>
</tr>
<tr>
<td>boolean is-file(string path)</td>
<td>Return true if the given path points to a file.</td>
</tr>
<tr>
<td>boolean is-absolute(string path)</td>
<td>Return true if the given path is absolute (i.e. full path).</td>
</tr>
<tr>
<td>string to-uri(string path)</td>
<td>Get the file URI build from the given path (i.e. file:///...).</td>
</tr>
<tr>
<td>string read-file(string uri)</td>
<td>Read a file from a given URI and return its content as string.</td>
</tr>
</tbody>
</table>

The following extension functions are defined in the namespace "http://www.pure-systems.com/string" and provide additional string operations.
Table 9.21. Extension functions providing string operations

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>nodeset parse(string xml)</code></td>
<td>Parse the given string as XML and return the resulting node set.</td>
</tr>
<tr>
<td><code>boolean matches(string str,string pattern)</code></td>
<td>Match the regular expression pattern against the given string. Return <code>true</code> if the pattern matches.</td>
</tr>
<tr>
<td><code>nodeset match(string str,string pattern)</code></td>
<td>Match the regular expression pattern against the given string and return the set of sub-matches.</td>
</tr>
<tr>
<td><code>string submatch(string str,string pattern,number n)</code></td>
<td>Match the regular expression pattern against the given string and return the n-th sub-match.</td>
</tr>
<tr>
<td><code>string replace(string str,string pattern,string replacement,number n?)</code></td>
<td>Replace the matches in the given string with the replacement string using the regular expression match pattern. The optional fourth parameter specifies the maximal number of replacements. 0 means all, 1 means to replace only the first, 2 means to replace the first 2 matches etc. Returns the resulting string.</td>
</tr>
<tr>
<td><code>string expand(string str)</code></td>
<td>Expand variables in the given string and return the expanded string. Variables are recognized by the following pattern: $(VARIABLENAME)$. See Section 9.10, &quot;Predefined Variables&quot; for the list of supported variables.</td>
</tr>
</tbody>
</table>

Further information about XSLT extension functions is available in the external document *XML Transformation System*.

### 9.10. Predefined Variables

There are several places in pure::variants where variables are supported. That are for instance the transformation input and output paths as well as in the parameters of transformation modules. The following pattern is used for accessing variables: $(VARIABLENAME)$.

Table 9.22. Supported Variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>INPUT</td>
<td>Transformation input directory.</td>
</tr>
<tr>
<td>OUTPUT</td>
<td>Transformation output directory.</td>
</tr>
<tr>
<td>CONFIGSPACE</td>
<td>Path to the Configuration Space folder.</td>
</tr>
<tr>
<td>PROJECT</td>
<td>Path the folder of the current project.</td>
</tr>
<tr>
<td>PROJECT:name</td>
<td>Path to the folder of the project with the given name.</td>
</tr>
<tr>
<td>WORKSPACE</td>
<td>Path the workspace folder.</td>
</tr>
<tr>
<td>MODULEBASE</td>
<td>Path the transformation module base folder.</td>
</tr>
<tr>
<td>VARIANT</td>
<td>Name of the current variant, i.e. the name of the VDM currently being evaluated resp. transformed.</td>
</tr>
<tr>
<td>VARIANTSPATH</td>
<td>Name of the currently being evaluated resp. transformed VDM prefixed by the names of the parent VDMs. The names are separated by a slash. If a VDM is not linked, then the value of VARIANTSPATH is identical to the value of VARIANT.</td>
</tr>
<tr>
<td>TRANSFORMLOG</td>
<td>Path of the transformation log file.</td>
</tr>
</tbody>
</table>

### 9.11. Regular Expressions

Regular expressions are used to match patterns against strings.
9.11.1. Characters

Within a pattern, all characters except ., [ ), ], {, +, \, ^, $, *, and ? match themselves. If you want to match one of these special characters literally, precede it with a backslash.

Patterns for matching single characters:

- \(x\) Matches the character \(x\).
- \(\\) Matches nothing, but quotes the following character.
- \(\\) Matches the backslash character.
- \(\\0n\) Matches the character with octal value \(0n\) (0 <= \(n\) <= 7).
- \(\\0nn\) Matches the character with octal value \(0nn\) (0 <= \(n\) <= 7).
- \(\\0mnn\) Matches the character with octal value \(0mnn\) (0 <= \(m\) <= 3, 0 <= \(n\) <= 7).
- \(\\times hh\) Matches the character with hexadecimal value 0xhh.
- \(\\uhhhh\) Matches the character with hexadecimal value 0xhhhh.
- \(\t\) Matches the tab character (\u0009).
- \(\n\) Matches the newline (line feed) character (\u000A).
- \(\r\) Matches the carriage-return character (\u000D).
- \(\f\) Matches the form-feed character (\u000C).
- \(\a\) Matches the alert (bell) character (\u0007).
- \(\e\) Matches the escape character (\u001B).
- \(\cx\) Matches the control character corresponding to \(x\).

To match a character from a set of characters the following character classes are supported. A character class is a set of characters between brackets. The significance of the special regular expression characters ., [ ), ], {, +, ^, $, *, and ? is turned off inside the brackets. However, normal string substitution still occurs, so (for example) \(\\b\) represents a backspace character and \(\n\) a newline. To include the literal characters | and - within a character class, they must appear at the start.

- \([abc]\) Matches the characters a, b, or c.
- \([^{abc}\) Matches any character except a, b, or c (negation).
- \([a-zA-Z]\) Matches the characters a through z or A through Z, inclusive (range).
- \([a-d][m-p]\) Matches the characters a through d, or m through p: \([a-dm-p]\) (union).
- \([a-z&][def]\) Matches the characters d, e, or f (intersection).
- \([a-z&[^bc]\) Matches the characters a through z, except for b and c: \([ad-z]\) (subtraction).
- \([a-z&[^m-p]\) Matches the characters a through z, and not m through p: \([a-lq-z]\) (subtraction).

Predefined character classes:

- \(\d\) Matches a digit: [0-9].
\D Matches a non-digit: [^0-9].
\s Matches a whitespace character: [ \t\n\x0B\f\r].
\S Matches a non-whitespace character: [^\s].
\w Matches a word character: [a-zA-Z_0-9].
\W Matches a non-word character: [^\w].

POSIX character classes (US-ASCII):

\p{Lower} Matches a lower-case alphabetic character: [a-z].
\p{Upper} Matches an upper-case alphabetic character: [A-Z].
\p{ASCII} Matches all ASCII characters: [\x00-\x7F].
\p{Alpha} Matches an alphabetic character: [\p{Lower}\p{Upper}].
\p{Digit} Matches a decimal digit: [0-9].
\p{Alnum} Matches an alphanumeric character: [\p{Alpha}\p{Digit}].
\p{Punct} Matches a punctuation character: one of !"#$%&'()*+,-./:;<=>?@[^\^\_]~\]^\_\{\}[\].
\p{Graph} Matches a visible character: [\p{Alnum}\p{Punct}].
\p{Print} Matches a printable character: [\p{Graph}].
\p{Print} Matches a space or a tab: [ \t].
\p{Cntrl} Matches a control character: [\x00-\x1F\x7F].
\p{XDigit} Matches a hexadecimal digit: [0-9a-fA-F].
\p{Space} Matches a whitespace character: [ \t\n\x0B\f\r].

Classes for Unicode blocks and categories:

\p{InGreek} Matches a character in the Greek block (simple block).
\p{Lu} Matches an uppercase letter (simple category).
\p{Sc} Matches a currency symbol.
\P{InGreek} Matches any character except one in the Greek block (negation).
[\p{L}&&[^\p{Lu}]] Matches any letter except an uppercase letter (subtraction).

9.11.2. Character Sequences

Character sequences are matched by string the characters together.

XY Matches X followed by Y.

The following constructs are used to easily match character sequences containing special characters.

\Q Quotes all characters until \E.
\E Ends quoting started by \Q.
9.11.3. Repetition

Repetition modifiers allow to match multiple occurrences of a pattern.

X? Matches X once or not at all.
X* Matches X zero or more times.
X+ Matches X one or more times.
X{n} Matches X exactly n times.
X{n,} Matches X at least n times.
X{n,m} Matches X at least n but not more than m times.

These patterns are greedy, i.e. they will match as much of a string as they can. This behavior can be altered to let them match the minimum by adding a question mark suffix to the repetition modifier.

9.11.4. Alternation

An unescaped vertical bar "\|" matches either the regular expression that precedes it or the regular expression that follows it.

X|Y Matches either X or Y.

9.11.5. Grouping

Parentheses are used to group terms within a regular expression. Everything within the group is treated as a single regular expression.

(X) Matches X.

9.11.6. Boundaries

The following boundaries can be specified.

^ Matches the beginning of a line.
$ Matches the end of a line.
\b Matches a word boundary.
\B Matches a non-word boundary.
\A Matches the beginning of the string.
\G Matches the end of the previous match.
\Z Matches the end of the string but for the final terminator (e.g. newline), if any.
\z Matches the end of the string.

9.11.7. Back References

Back references allow to use part of the current match later in that match, i.e. to look for various forms of repetition.

\n Whatever the n-th group matched.

9.12. Keyboard Shortcuts

Some of the following keyboard shortcuts may not be supported on all operating systems.
## Keyboard Shortcuts

### Table 9.23. Common Keyboard Shortcuts

<table>
<thead>
<tr>
<th>Key</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTRL+Z</td>
<td>Undo</td>
</tr>
<tr>
<td>CTRL+Y</td>
<td>Redo</td>
</tr>
<tr>
<td>CTRL+C</td>
<td>Copy into clipboard</td>
</tr>
<tr>
<td>CTRL+X</td>
<td>Cut into clipboard</td>
</tr>
<tr>
<td>CTRL+V</td>
<td>Paste from clipboard</td>
</tr>
</tbody>
</table>

### Table 9.24. Model Editor Keyboard Shortcuts

<table>
<thead>
<tr>
<th>Key</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>ENTER</td>
<td>Show properties dialog</td>
</tr>
<tr>
<td>DEL / ENTF</td>
<td>Delete selected elements</td>
</tr>
<tr>
<td>Up/Down cursor keys</td>
<td>Navigate tree</td>
</tr>
<tr>
<td>Left/Right cursor keys</td>
<td>Collapse or expand subtree</td>
</tr>
<tr>
<td>CTRL+O</td>
<td>Open Quick-Outline</td>
</tr>
</tbody>
</table>

### Table 9.25. Graph Editor Keyboard Shortcuts

<table>
<thead>
<tr>
<th>Key</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTRL+P</td>
<td>Print graph</td>
</tr>
<tr>
<td>CTRL+=</td>
<td>Zoom in</td>
</tr>
<tr>
<td>CTRL+-</td>
<td>Zoom out</td>
</tr>
<tr>
<td>CTRL+ALT+A</td>
<td>Show relation arrows in graph</td>
</tr>
<tr>
<td>CTRL+ALT+X</td>
<td>Expand complete subtrees of selected elements</td>
</tr>
<tr>
<td>ALT+X</td>
<td>Expand one level of selected elements</td>
</tr>
<tr>
<td>ALT+C</td>
<td>Collapse selected elements</td>
</tr>
<tr>
<td>ALT+H</td>
<td>Layout graph horizontal</td>
</tr>
<tr>
<td>ALT+V</td>
<td>Layout graph vertical</td>
</tr>
<tr>
<td>ALT+DEL</td>
<td>Hide selected elements</td>
</tr>
</tbody>
</table>
Chapter 10. Appendices

10.1. Software Configuration

pure::variants may be configured from the configuration page (located in Window->Preferences->Variant Management). The available configuration options allow the license status to be checked, the plug-in logging options to be specified and the configuration of some aspects of the internal operations of the plug-in to be specified. pure-systems support staff may ask you to configure the software with specific logging options in order to help identify any problems you may experience.

Figure 10.1. The configuration dialog of pure::variants

10.2. User Interface Advanced Concepts

10.2.1. Console View

This view is used to alter the information that is logged during program operation. The amount of information to be logged is controlled via a preferences menu and this can be changed at any time by selecting the log level icon in the view’s toolbar. The changed logging level is active only for the current session.

Note

If the preferences menu is used instead to change the logging level then this applies to this session and every subsequent session.

10.3. Glossary

Configuration Space The Configuration Space describes the set of Input Models for creating product variants. It also defines the transformation of variants.
Context Menu
A menu, which is customized according to the user interface item the user is currently pointing at (with the mouse). On Windows, Linux and MacOS X (with two or more mouse buttons), the right mouse button is usually configured to open the context menu. Under MacOS X (with single button mouse) the command key and then the mouse button have to be pressed (while still holding the command key) to open the context menu.

CSV
Comma Separated Value list. A simple text format often used to exchange spreadsheet data. Each line represents a table row, columns are separated with a comma character or other special characters (e.g. if the comma in the user's locale is used in floating point numbers like in Germany).

DOT
The name of a tool and its input format for automatic graph layouting. The tool is part of the GraphViz package available as open source from www.graphviz.org.

EBNF
Extended Backus-Naur Form. A common way to describe programming language grammars. The Backus-Naur Form (BNF) is a convenient means for writing down the grammar of a context-free language. The Extended Backus-Naur Form (EBNF) adds the regular expression syntax of regular languages to the BNF notation, in order to allow very compact specifications. The ISO 14977 standard defines a common uniform precise EBNF syntax.

Family Model
This model type is used to describe how the products in a product line will be assembled or generated from pre-specified components. Each component in a Family Model represents one or more functional elements of the products in the product line, for example software (in the form of classes, objects, functions or variables) or documentation. Family models are described in more detail in Section 5.4, “Family Models”.

Family Model Editor
The editor for Family Models. See Section 7.3.3, “Family Model Editor” for a detailed description.

Matrix Editor
The editor for Configuration Spaces. See Section 7.3.7, “Matrix Editor” for a detailed description.

Feature Model
This model type is used to describe the products of a product line in terms of the features that are common to those products and the features that vary between those products. Each feature in a Feature Model represents a property of a product that will be visible to the user of that product. These models also specify relationships between features, for example, choices between alternative features. Feature Models are described in more detail in Section 5.3, “Feature Models”.

Feature Model Editor
The editor for Feature Models. See Section 7.3.2, “Feature Model Editor” for a detailed description.

HTML
Hyper Text Markup Language.

Input Model
Input Models are the Feature and Family Models of a Configuration Space. They are added to a Configuration Space using the Configuration Space properties dialog. See Figure 6.11, “Configuration Space properties: Model Selection” for more information.

Link Element
Elements in models that represent links to VDMs or Configuration Spaces to create a variant hierarchy. See Section 6.2.1, “Hierarchical Variant Composition” for a detailed description.

Model Rank
The model rank is a positive integer that is used to control the order in which the models of a Configuration Space are evaluated. Models are evaluated
from higher to lower ranks, i.e. models with rank 1 (highest) are evaluated before models with rank 2 or lower. The rank of a model is specific to a Configuration Space and can be set in the Configuration Space properties. The default rank is 1.

**OCL**

**Prolog**
PROgramming in LOGic. A programming language based on predicate logic.

**pvSCL**
pure::variants Simple Constraint Language. A simple language to express constraints, restrictions and calculations.

**UML**

**URL**
Uniform Resource Locator. A standardized format for expressing the type and location of a resource (i.e. a file or service access point). Most commonly used for referring to HTML pages on an HTTP web server (e.g. http://my.server.org/index.html)

**Variant Description Model**
This model type is used to describe the set of features of a single product in the product line. Taking the Input Models of a Configuration Space and making choices where there is variability in the Input Models creates these models. VDMs are described in more detail in Section 5.5, “Variant Description Models”.

**Variant Result Model**
This model is the result of evaluating the input models of a Configuration Space according to a given element selection (VDM). It represents a specific variant of the input models and is used as the input for the transformation. See Section 5.9.2, “Variant Result Models” for a detailed description.

**VDM**
Abbreviation of Variant Description Model.

**VDM Editor**
The editor for the pure::variants Variant Description Model. See Section 7.3.4, “Variant Description Model Editor” for detailed information about it.

**VRM Editor**
The editor for Variant Result Models. See Section 7.3.5, “Variant Result Model Editor” for a detailed description.

**XML**
eXtensible Markup Language. A simple standardized language for representing structured information. See http://www.w3.org.

**XML Namespace**
To provide support for independent development of XML markup elements (DTD/XML Schema) without name clashes, XML has a concept to provide several independent namespaces in a single XML document. See http://www.w3.org.

**XMLTS**
XML Transformation System. The name for the pure::variants transformation system for generating variants from XML based models.

**XPath**
XPath is part of the XML standard family and is used to describe locations in XML documents but also contains additional functions e.g. for string manipulation. XPath is heavily used in XSLT.

**XSLT**
Index

A
Analysis
Model, 75
Attribute
Calculation, 26, 26
Element, 24
Feature, 28
Hide, 105
List Attribute, 25, 25
Set Attribute, 25, 25
Value, 26
Value Types, 25, 145
ps:boolean, 145
ps:class, 145
ps:datetime, 145
ps:directory, 145
ps:element, 145
ps:feature, 145
ps:filetype, 145
ps:float, 145
ps:html, 145
ps:insertionmode, 145
ps:integer, 145
ps:path, 145
ps:string, 145
ps:url, 145
ps:version, 145
Attribute Overriding
Variant Description Model, 122
Attributes
Editor, 111
View, 127
Auto Resolver
Variant Description Model, 41

C
Calculations
Editor, 114
pvProlog, 158
Compare
Model, 69
Models, 125
Configuration Space Transformation, 49
Constraints
Editor, 114
Editor Pages, 105
Model, 24

D
Default Selected
Element Properties, 41, 111
Dialog
Element Selection, 117

E
Editor
Analysis, 75
Attributes, 111
Calculations, 114
Common Pages, 104
Configuration Space, 49
Constraints, 114
Family Model, 121
Feature Model, 118
Filter, 83
Metrics, 84
Quick Overview, 74
Relations, 111
Restrictions, 114
Variant Description Model, 122
Variant Result Model, 124
Editor Pages
Constraints, 105
Graph, 106
Table, 105
Tree, 104
Element
Attribute, 24
Calculation, 26, 26
Constraints, 24
Default Selection State, 41
Restrictions, 24
Selection Dialog, 117
Variation Types, 147
Element Properties
Attributes Page, 111
Constraints Page, 113
Dialog, 109
General Page, 109
Relations Page, 111
Restrictions Page, 113
Element Selection
Variant Description Model, 122
Element Selection Cluster, 79
Element Variation Types
Alternative, 148
Mandatory, 147
Optional, 147
Or, 148
Evaluation, 39
Prolog Code Library, 167
pvSCL Code Library, 186
Variant Description Model, 33
Export
Model, 87
Expression Editor, 114

F
Family Model, 28
Editor, 121
Element Variation Types, 147
Part Element Types, 157
  ps:class, 158
  ps:clasalias, 157
  ps:feature, 158
  ps:flag, 158
  ps:variable, 158
Restrictions, 30
Source Element Types, 148
  ps:clasaliasfile, 156
  ps:condtext, 152
  ps:condxml, 150
  ps:dir, 149
  ps:file, 149
  ps:flagfile, 155
  ps:fragment, 150
  ps:makefile, 155
  ps:pvscltext, 154
  ps:pvsclxml, 153
  ps:symlink, 156
  ps:transform, 150
Feature
  Attributes, 28
  Constraints, 24
  Relations, 24
  Restrictions, 24
Feature Model, 27
  Editor, 118
  Element Variation Types, 147
Features
  Matrix Editor, 125
File Update, 37
Filter
  Model, 83

G
Graph Visualization
  Editor Pages, 106

H
Hierarchical Variant Composition, 32, 43

I
Impact View
  Views, 135
Import
  Model, 94

K
Keyboard Shortcuts, 194

L
Language Support, 86
  List Attribute, 25, 25

M
Metrics
  Model, 84
  Analysis, 75
  Common Properties, 139
  Compare, 69, 125
  Constraints, 24
  Export, 87
  Family, 28
  Feature, 27
  Filter, 83
  General Properties, 140
  Import, 94
  Meta Attributes, 165
  Metrics, 84
  Prolog Code Library, 167
  Properties, 139
  pvSCL Code Library, 186
  Search, 72
  Validation, 64
  Variant Description, 32
  Variant Result, 35
Model Meta Attributes
  author, 166
  date, 166
  dir, 166
  file, 166
  name, 166
  time, 166
  version, 166
Multiple
  Transformation, 62

O
Outline
  View, 130
Outline View
  Variant Description Model, 123

P
Problems
  View, 130
Projects
  View, 138
Properties
  View, 130
pvProlog
  advanced examples, 166
  Calculations, 158
  Code Library, 167
  element references, 159
  parent, 160
  Restrictions, 158
pvProlog Functions, 160
  alternativeChild, 163
  checkMax, 165
  checkMin, 164
  checkRange, 165
errorMsg, 163
false, 161
getAllChildren, 164
getAllSelectedChildren, 164
getAttribute, 161
getAttributeId, 162
getAttributeName, 161
getAttributeType, 162
getContext, 162
defaultElementChildren, 162
defaultElementClass, 163
defaultElementModel, 162
defaultElementName, 162
defaultElementParents, 162
defaultElementRoot, 162
defaultElementType, 163
defaultElementVisibleName, 163
getMatchingAttributes, 163
getMatchingElements, 163
getMatchingSelectedElements, 164
getModelList, 162
getSelf, 162
defaultVariantContext, 162
defaultVariantContextId, 162
defaultVariantContextName, 162
defaultVariantId, 162
has, 164
hasAttribute, 161
hasComponent, 164
hasElement, 164
hasFeature, 164
hasPart, 164
hasSource, 164
infoMsg, 163
isElement, 161
isFalse, 162
isFamilyModelElement, 161
isFeatureModelElement, 161
isTrue, 162
isVariant, 162
not, 161
singleSubfeature, 163
subfeatureCount, 163
sumNodeCount, 163
sumSelectedSubtreeAttributes, 164
true, 161
userMessage, 163
warningMsg, 163
pv:AllChildren, 177
pv:Append(expr), 177
pv:AppendAll(collection), 177
pv:AsList, 177
pv:AsSet, 177
pv:Attribute(name), 177
pv:Attributes(), pv:Attributes('type'), 177
pv:Characters(), 177
pv:Child(index), 178
pv:Children, 178
pv:ChildrenByState(state), 178
pv:Class, 178
pv:Collect(iterator), 178
pv:Contains, 178
pv:ContainsAll, 178
pv:DefaultSelected, 179
pv:Element(name-or-id), 179
pv:Fail(message), 179
pv:Flatten, 179
pv:Floor, 179
pv:ForAll(iterator), 179
pv:Get, pv:Get(index), 179
pv:HasAttribute(name), 179
pv:HasElement(name-or-id), 180
pv:HasModel(name-or-id), 180
pv:ID, 180
pv:IndexOf(sub-string), 180
pv:Inform(message), 180
pv:IsContainer, 180
pv:IsFixed, 180
pv:IsInheritable, 180
pv:IsKindOf(type), 180
pv:Item(index), 181
pv:Iterate(accumulator), 181
pv:Max, 181
pv:Min, 181
pv:Model, pv:Model(name-or-id), 181
pv:Models, pv:Models(type), 181
pv:Name, 182
pv:Parent, 182
pv:Prepend(expr), 182
pv:PrependAll(collection), 182
pv:PVVersion(), 182
pv:Relations, pv:Relations(type), 182
pv:Remove(item), 182
pv:RemoveAll(collection), 182
pv:RetainAll(collection), 183
pv:Reverse(), 183
pv:RootElement, 183
pv:Round, 183
pv:Select(iterator), 183
pv:Selected, 183
pv:SelectedChildren, pv:SelectedChildren(type), 183
pv:SelectionState, 184
pv:Selector, 184
pv:Size, 184

pvSCL
Code Library, 186
pvSCL Functions
pv:Abs, 176
R
Refactoring, 68
Regular Expressions, 191
Relation Types
  ps:conditionalRequires, 146
  ps:conflicts, 146
  ps:conflictsAny, 146
  ps:defaultProvider, 147
  ps:discourages, 146
  ps:discouragesAny, 146
  ps:equalsAll, 146
  ps:equalsAny, 146
  ps:exclusiveProvider, 147
  ps:expansionProvider, 147
  ps:influences, 146
  ps:provides, 146
  ps:recommendedFor, 146
  ps:recommendedForAll, 146
  ps:recommends, 146
  ps:recommendsAll, 146
  ps:requestsProvider, 147
  ps:requiredFor, 146
  ps:requiredForAll, 146
  ps:requires, 146
  ps:requiresAll, 146
  ps:sharedProvider, 147
  ps:supports, 147
Relations
  Editor, 111
  Feature, 24
  View, 132
Restrictions
  Editor, 114
  Element, 24
  Family Model, 30
  pvProlog, 158
Result
  Delta Mode, 134
  View, 133
S
Same Variants, 78
Search, 72
  Model, 72
Quick Overview, 74
View, 129
Selection State Cluster, 81
Set Attribute, 25, 25
Similar Variants, 75
T
Tasks
  View, 130
Transformation, 48
  JavaScript, 57
  Regular Expression, 55
  Standard Transformation, 53
  Variant Description Model, 34
  Variant Result Model, 35
  XSLT Extension Functions, 186
  XSLT Transformation, 59
Type Model, 85
U
Update, 36
V
Validation
  Models, 64
Variables, 191
  CONFIGSPACE, 191
  INPUT, 191
  MODULEBASE, 191
  OUTPUT, 191
  PROJECT, 191
  TRANSFORMLOG, 191
  VARIANT, 191
  VARIANTSPATH, 191
  WORKSPACE, 191
Variant
  Matrix Editor, 125
  Variant Description Model, 32
  Auto Resolver, 41
  Editor, 122
  Evaluation, 33
  Inheritance, 32, 141
  Load Selection, 47
  Outline, 123
  Rename Reused Variant Description Model, 47
Selection Types, 148
  Auto, 148
  Auto Excluded, 148
  Excluded, 148
  Implicit, 148
  Mapped, 148
  Non-Selectable, 148
  User, 148
  Transformation, 34
Variant Projects
  View, 138
  Variant Result Model
Transformation, 35

Views
- Attributes, 127
- Impact View, 135
- Matrix Editor, 125
- Outline, 130
- Problems, 130
- Properties, 130
- Relations, 132
- Result, 133
- Search, 129
- Tasks, 130
- Variant Projects, 138

Visualization
- View, 128

X

XSLT Elements
- error, 190
- info, 189
- log, 189
- warning, 190

XSLT Extension Functions, 186

XSLT Functions
- above-exit-point, 189
- absolute, 190
- add-part, 190
- basename, 190
- below-entry-point, 189
- current, 188
- cwd, 190
- delimiter, 190
- dirname, 190
- entry-points, 189
- error, 189
- exists, 190
- exit-points, 189
- expand, 191
- extension, 190
- filename, 190
- generate-id, 188
- getAttribute, 188
- getAttributeValue, 188
- getChildrenTargets, 187
- getElement, 187
- hasAttribute, 187
- hasAttributeValue, 188
- hasComponent, 187
- hasElement, 187
- hasFeature, 187
- hasPart, 187
- hasSource, 187
- info, 189
- input-path, 188
- is-absolute, 190
- is-dir, 190
- is-file, 190
- log, 189
- match, 191
- matches, 191
- model-by-id, 187
- model-by-name, 187
- model-by-type, 187
- models, 187
- mtime, 190
- normalize, 190
- os, 188
- output-path, 188
- parse, 191
- read-file, 190
- replace, 191
- results-for, 189
- size, 190
- submatch, 191
- tempdir, 190
- to-uri, 190
- version, 188
- warning, 189